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1 Introduction SchedulePro SchedulePro Installation

Introduction

SchedulePro Basics

Introduction to SchedulePro

SchedulePro is a software finite capacity scheduling tool for manufacturing processes. Some typical applications for SchedulePro
include:

¢ Production scheduling

* Production Tracking and Reporting
« Capacity analysis

* Plant de-bottlenecking

SchedulePro meets the needs of both the occasional planner or designer, who cares about feasibility and capacity with no concern
about actual execution, as well as of the production manager who is responsible for developing and maintaining a feasible schedule
under the uncertainties of everyday operation.

SchedulePro uses an intuitive recipe-oriented representation of a manufacturing process. SchedulePro handles resources such as
equipment, staff, work areas, labor, materials, utilities and inventory capacity. SchedulePro allows for interruptions in the availability
of resources to account for shift schedules, holidays, and planned maintenance.

For the quickest start, skim chapter 3 for the basic concepts. Go over tutorial 1 (Chapter 4). This provides the basic concepts for
SchedulePro.

You may select additional tutorials to fit your needs.

Satellite Applications

SchedulePro supports updating and publication of schedules with two optional applications.
SchedulePro Web Viewer is a web server based application that allows users to view schedules through a browser.

SchedulePro Tracker is s workstation application that allows authorized users to make updates to scheduled activities.

Both applications work with the SQLServer database features ( see page 342) in SchedulePro.
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SchedulePro Installation

System Requirements

Intelligen recommends that SchedulePro be run with the specifications listed below.

Operating Systems MS Windows 10, MS Windows 8, MS Windows 7, Windows Vista, Note:
Installation on Windows 2000 and Windows XP is no longer supported

System Memory (RAM) 1 GB or more

Free Disk space 100 MB or more

Microsoft Data Access Components (MDAC) Version 2.6 or higher (Same as SuperPro Designer)
Required for use with SuperPro Designer or MS

Project®

SuperPro Designer (optional) Version 9.0 or higher

Historical Database (optional) SQL Server or SQL Server Express 2012 or later
Report Viewer MS Report Viewer (Installed with application)

Installation from CD

Be sure the logged user has administrator privileges. Remove the key (single-user version). Insert the CD. If the installation does
not begin. Open the CD contents and run "setup.exe." Follow the installation instructions.

Attach the key (single-user version) and wait for the key driver to load.

Launch SchedulePro.

Installation by Download

If you have chosen to install SchedulePro from a download site, you will receive separate instructions with the download site
location and any necessary passwords.

2
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Click on the download link to run the file. You may wish to create a directory in which to save the installation files in order to have a
backup. Otherwise the installation files will be created in a temporary directory. The installation program will run automatically.
Follow the directions to complete the installation.

Database Setup

See the Data Import/Export ( see page 323) chapter.

MDAC Installation

(Pre-Windows 7 Operating Systems)

SchedulePro uses Microsoft Data Access Components (MDAC) to upload data from SuperPro Designer and to export data to
Microsoft Project®. If you are running on an older system or you are not using a recent version of Microsoft Office®, you may need
to install MDAC 2.6 or later.

If you have installed or plan to install SuperPro Designer there is nothing more you need to do. MDAC is installed with SuperPro, if
necessary.

If you do not have SuperPro Designer and you are using an older system, and you receive a warning about MDAC missing, you
may need to install MDAC. MDAC is not distributed in the download version of SuperPro. You may obtain it from the Microsoft
download site (www.microsoft.com/downloads/ ).

Hardware Key Renewal

If you have an annual key it will expire after your license term is completed. If you renew you license you will receive a key renewal
code. You may run the key renewal utility application from the start menu to enter the code and refresh your key.

If you have questions about your key, email the key renewal information to us.

Microsoft .NET Framework

The Microsoft .NET frame work is required . This will be installed if it is not already present.


http://www.microsoft.com/downloads
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Technical Support

E-Mail (preferred):

techSupport@intelligen.com

www.intelligen.com

Telephone

+1 603 715-9176 (from 9:00 am to 5:00 pm US Eastern Time EST)
+1 908 654-0088 (from 9:00 am to 5:00 pm US Eastern Time EST)

Sentinel Driver (Hardware Protected Version
Only)

The Single-user (key-protected) version of SchedulePro requires installation of the drivers for the hardware security key. The
drivers are installed automatically at the end of the installation procedure. If the driver installation fails, you may receive an error
message upon launching SchedulePro. The installation file will be located in the Sentinel folder of the SchedulePro application
directory. The Sentinel driver may alternatively found at http://www.safenet-inc.com/support-downloads/sentinel-drivers/.

SQL Server and Report Viewer

The schedule history tracking features require access to a SQL Server relational database. The database does not need to be
installed on the same computer that is used for SchedulePro, however it may be convenient to install Microsoft SQLServer Express
along with the management studio. This is available from Microsoft (www.microsoft.com/express/Database/).

Microsoft Report Viewer must be installed in order to use the schedule history features. Report Viewer may be installed optionally,
but is not automatically installed with the application.

Hardware Protected Version Only

The Single-user (key-protected) version of SchedulePro requires installation of the drivers for the hardware security key.
< If you are installing for the first time, install the software first then attach the key.
« The drivers will install automatically after SchedulePro is installed. Be sure to attach the key before launching SchedulePro.

« SchedulePro will check for up to two attached keys. If you have a separate key for SuperPro Designer, you may leave it
attached. It is not recommended that you use SchedulePro with three or more keys attached.


http://www.intelligen.com
http://www.microsoft.com/express/Database
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Database Locations

SchedulePro uses two Microsoft Access databases. Normally these databases are located in the “Databases” subdirectory of your
public documents directory, e.g. C:\Users\Public\Documents\Intelligen\SchedulePro\v7.2\Databases

The following table outlines the important features of each database:

Database Purpose ODBC Data Source Name Password

SP RecipeDBv6.mdb | Importing recipes from SchedulePro Recipe DB(SchedulePro Recipe “changeme”
SuperPro Designer DB v1 is maintained for SuperPro compatibility.)

SPOutput.mdb Custom Reports ScheduleProOutput NONE

SQL Server DB Archive/Reports Not used Set by user

If you move or change the data source name (DSN) of any of these databases, you may need to update the new information in
SchedulePro.

Select “Connectivity/Recipe Data/Edit Location...” from the main menu.
For each database you may edit the following:
Password

This is the access database password. Note that the password entered is the one that SchedulePro stores for use with the
corresponding database. The actual database password may be changed through Access.

Location

This is the path for the Access file.
Status (Read only)

Any problems are displayed here.
Report Database

The reporting output database, SPoutput.mdb is also initially located in the databases subdirectory. To edit the location of this
database, select “Connectivity/MDB Repore/Register Report Database” from the main menu.

Creating a Login ID

The database login ID is a personal ID that may be used to identify who has made changes to the database. This ID is not related
to database access.

If the database is not shared, then there is no need to create an ID.

To create an ID or to login with a previously created ID, select “Connectivity /Login New User...” from the main menu. Enter the ID
along with the password and confirmation.
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Getting Started

How to get up and running right away.

Understanding SchedulePro

Basic concepts behind the SchedulePro algorithms.

About SchedulePro

SchedulePro is a finite capacity scheduling tool especially designed to handle batch-oriented manufacturing processes. This is
distinct from project scheduling in two important ways:

Batch ( see page 287) manufacturing is repetitive. A production campaign may require many batches, so the manufacturing
process is repeated over and over.

The duration of many batch manufacturing tasks is independent of the number of resources available. A batch chemical reaction,
for example, will take the same amount of time whether there are two operators or four.

Scheduling in SchedulePro is a user-driven activity. Users control the pace at which the schedule gets generated, what constraints
to consider and how to resolve conflicts resulting from constraint violations. Scheduling or updating can be performed in a
fully-automated or completely manual mode.

SchedulePro is a document style application. The data are normally saved in a binary file with the Extension "SCP." Data may
optionally be saved in a SQL Server database. This database works with SchedulePro and also with two satellite applications:
SchedulePro Web Viewer and SchedulePro Tracker.

The following sections provide a general understanding of how SchedulePro works.

Recipes

Recipe Organization

SchedulePro addresses the need to represent repetitive batch manufacturing by providing the concept of a recipe . A recipe is a
template or description of how to make one batch of something.
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Recipes are organized into branches and sections. Recipe branches are supported in SchedulePro to maintain compatibility with
SuperPro Designer. Branches do not have any function in SchedulePro.

Recipe sections are intended to represent a distinct portion of a process. For example, a recipe may have a bulk mixing section
and a filling and packaging section. Sections may optionally be assigned to a suite or a set of equipment that must be used together.

Sections contain unit procedures . A unit procedure—procedure for short—is a distinct manufacturing step that utilizes at least one
primary piece of equipment for its entire duration. For example, a mixing procedure might utilize a blending tank.

Unit procedures are further divided into operations . Operations describe distinct sub-steps in a unit procedure. Operations may
require other resources such as labor, materials, utilities, auxiliary equipment and staff.

The relative timing of the various operations is determined by the operation’s duration and by scheduling relationships among
operations. An operation may have the following duration specifications:

¢ Fixed duration (default): The operations duration is set by the user.

« Rate based duration: The duration is based on a rate and is therefore dependent on the amount. For example the duration of a
filling operation may be dependent on the filling rate.

« Dependent duration: The duration is equal to that of another operation or series of operations.

« Inventory-dependent duration: The duration of the operation is related to the time it takes for a storage unit inventory to reach a
specified level (in other words, the operation ‘holds’ until that specified level is reached)

» Changeover dependent duration: The duration of an operation depends on the change from or to a different product type.
An operation may have the following scheduling relative timing relationships:

« Start of batch: The operation starts relative to the start of the batch.

« Start of another operation: The operation starts relative to the beginning of another operation.

« End of another operation: The operation starts relative to the end of another operation.

« Start to finish: The operation finishes relative to the start of another operation.

« Finish to finish: The operation ends relative to the end of another operation.

In addition to the above specifications, an operation may have a fixed or flexible shift time. A fixed shift is a delay (or advance) that
is always applied. A flexible shift is only applied if the operation needs to wait for a resource to become available. An operation can
also be declared as ‘interruptible’ meaning that it can stop and resume operation when the resources it needs become again
available. The maximum number of breaks and the total break duration are user-defined.

Further, operations may be condition on how much or how often the equipment has been used.

All resources other than primary equipment or work areas are specified at the operation level. Operations may require resources
including:

8



2 Getting Started SchedulePro Understanding SchedulePro

¢ Auxiliary equipment

e Materials (input or output)

« Utilities (heating/cooling)

e Power or Duty

e Labor (pooled labor resource)

« Staff (for scheduling individuals)

Recipe Resources

Resources in SchedulePro represent the physical items that are necessary to execute a recipe, i.e. create a batch. Scheduled
entities (operations, procedures, batches) might need to delay their execution until the resources they need become available.

For organization, all resources (except materials) are organized into facilities. Facilities and their resources are equipped with
calendars where their outages, downtimes etc can be declared.

Resources act as constraints that the scheduler tries to satisfy, otherwise they generate conflicts. SchedulePro attempts to
schedule in a way that does not exceed the supply of resources.

Equipment

Equipment is intended to represent the manufacturing equipment needed to carry out a specific process step, for example a tank, a
reactor or a filling machine. From a scheduling point of view, an equipment item is a non-consumable reusable resource.

Every unit-procedure requires an equipment resource. Each operation may optionally require an auxiliary equipment resource. Any
equipment may be assigned as either main equipment or auxiliary equipment.

Main equipment and auxiliary equipment are assigned in pools. For example if a mixing step may be carried out in Tank-1 or
Tank-2 both tanks may be listed in the pool. SchedulePro will pick the first available tank for a given batch.

Tip: If multiple equipment units are used in a step you may either (1) create separate procedures in the recipe or (2) create an
equipment unit that represents the combined equipment.

Equipment in SchedulePro is a simple resource, however, equipment may (optionally) have a size and a rate. SchedulePro uses
the size to determine whether the equipment is appropriate for a given procedure or operation. The rate may be used to calculate
the duration of rate-dependent operations.

Equipment can optionally be declared able to accommodate multiple simultaneous procedures with user-defined limitations.
Besides facilities, equipment may be further organized into suites. A suite is a set of equipment that must be used together.
Work Areas

Work areas represent rooms or places where procedures are carried out. Like equipment, work areas can accommodate multiple
simultaneous procedures with user-defined limitations.

Materials

Materials in SchedulePro are a non-reusable resource. They may be bulk (measured in mass or volume) or discrete (measured in
number of individual entities).

Materials are assigned to streams, when they either enter or leave an operation. Streams may be assigned to storage units to aid in
tracking or limiting certain material flows. Storage units may be used to place a limit on the rate at which a material may be used.
Storage units may also track the inventory of the materials that they handle.

Labor
The labor resource in SchedulePro is a pool of a specific type of labor. The total size of the pool may be set by the user.
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Staff resources are individuals that may be assigned to an operation. Both the number of individuals required and the allowable
individuals may be specified.

Utilities

Utilities in SchedulePro are non-reusable resources which cannot be stored or inventoried. Utilities may include electrical power,
heating agents such as steam, or cooling utilities like cooling water.

Utilities are assigned to operations and may have user-defined limits. They may also be associated with materials in which case the
materials consumed for the generation of a utility and the waste generated by the use of that utility can be accounted for.

Work Areas

Work areas are assigned at the equipment level. They differ from equipment in that multiple activities may take place in a work
area, but there may be constraints on these activities.

Getting Started Scheduling

While a recipe describes a process in general, a schedule is a specific plan that specifies which recipes are executed when and
with what resources.

The relationship between recipes and the schedule is shown below:

Campaigns

A campaign is a series of batches of a particular recipe. In SchedulePro a campaign may be planned or scheduled. A planned
campaign does not have any scheduled batches but contains the information for scheduling them, e.g. number of batches, start
time, due date etc. A campaign is scheduled when all its batches are created.

Campaigns have a release date representing their earliest start time and several scheduling options including due date, start
relative to the start or end of some other campaign.

Campaigns contain options on how to size and schedule their batches. A scale factor or target batch size may be specified for all
batches of campaign. Cycle time for campaign (i.e. time interval between the start of two consecutive batches) can either be fixed
by the user or can be set to (an estimated) minimum value plus some user-defined slack.

Campaigns may also contain optional preproduction and postproduction steps to represent time spent setting up or cleaning out the
equipment. These non-production steps are treated as regular operations that may consume materials and resources.

Batches

A batch represents the execution of a single recipe at specific time and with specific resources. Procedures and operations in a
recipe have corresponding entries in each batch. A batch has specific start and end times. Batch ( see page 287) procedure
entries are assigned a specific main equipment unit. Batch ( see page 287) operation entries define the utilization of other
resources.
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Scheduler

Most users begin a scheduling exercise by defining the recipes, planning the campaigns, and allowing SchedulePro to generate a
preliminary schedule. When generating a schedule, SchedulePro handles each campaign in the order listed. It then proceeds
batch-by-batch calculating timing, assigning resources on a first-available basis and resolving conflicts.

There are modes that control the behavior of the scheduler in all its actions. These modes are presented in section 2.2.1.

After the initial schedule is laid out, the user may edit the schedule by adjusting durations, shifts or start times for particular batches.
These adjustments may be made by “dragging and dropping” in the interactive occupancy charts or by precisely specifying a start
time. After a manual edit, SchedulePro readjusts the batch to conform to the master recipe (e.g. resets the start time of operations
whose start time depends on the edited one) and recalculates conflicts. SchedulePro will not attempt to resolve any resulting
conflicts unless invoked by the user.

SchedulePro offers options to reschedule unschedule or resolve conflicts on a batch, a campaign or a portion of the entire schedule
starting or ending at a specific batch or campaign. With these options the user has full control on the pace at which the entire
schedule is generated and corrected.

Note: Because campaigns are handled in order, their order determines their priority for getting resources. Campaigns that appear
later in the list are more likely to have to wait for resources.

Current Time

SchedulePro supports the concept of current time to separate past from future activities. Batches or campaigns ending before the
current time are labeled as completed while those starting before the current time but finishing later are labeled as started.

These assignments get modified as the user resets the current time. Completed batches and campaigns can be deleted from the
schedule; in this way, the schedule gets updated and the actual plant production process is simulated more realistically.

Batches can also be labeled as locked implying that their timing and resources are fixed and should not be modified. Non-locked
batches should try to resolve own conflicts with locked batches even if they have higher priority according to the campaign definition
sequence. Batch (  see page 287) locking is essentially a way to assign highest priority to a scheduled batch.

SchedulePro Features

Overview ( see page 336) of general SchedulePro features.

Scheduling Timing Options

SchedulePro provides a number of options for generating a schedule. Options relate to batch timing, the identification of conflicts
and the conflict resolution mechanisms.

The following options are available for calculating the start time of batches within a campaign:

Cycle-time based: use the campaign cycle time (set by the user or calculated based on the estimated minimum cycle time).
Scheduler is free to move the batch start later if needed to avoid conflicts.

Locked : for unscheduled batches, their start is locked at their cycle-time-based start time. For scheduled batches, their start is
locked at its current value. In both cases, scheduler cannot move their start.

As Soon As Possible (ASAP): each batch gets the earliest possible start after the campaign release time ignoring cycle-time
settings.

11
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¢ SchedulePro considers the following scheduling conflicts:

e outage violations

« resource use overlaps (for equipment, work areas and staff)
< resource limit violations (for labor, utilities)

< material supply limit and inventory violations

There are options for all these conflict types so that users can select the scheduling constraints they care about. Outage violations
and resource use overlaps are considered hard-constraints meaning that they are always identified and reported. Even these,
however, can be ignored in scheduling and will not get resolved.

Finally, SchedulePro offers selections for the conflict resolution mechanism to use when constraints get violated. There are three
resolution mechanisms available:

« use of alternative resource (for reusable pooled resources)
« use of operation timing flexibilities (flexible shifts and breaks)
* move of the batch start

There are options to turn on or off each of these mechanisms or turn off the entire conflict resolution algorithm. In the latter case,
batches are scheduled according to their default timing and resource allocation settings and no attempt is made to resolve any
resulting conflicts in the schedule.

Scheduling Modes

For convenience, scheduling options are grouped into scheduling modes. A mode contains options for timing the batches,
identifying and resolving conflicts. A mode and its options do not belong to any particular campaign or batch; they apply to any
scheduling activity invoked by the user. While scheduling or updating, users can move back and forth between different modes.

There are three pre-defined scheduling modes in SchedulePro that mainly differ in the batch timing option they implement:

Automatic : this is the default mode. It uses cycle-time-based batch timing, it considers outage violations and resource use overlaps
constraints and uses all available mechanisms for conflict resolution.

Layout : it uses locked batch timing and, therefore, does not use moving the batch start as a resolution mechanism
ASAP: it uses ASAP batch timing.

User can modify the options behind these pre-defined modes (except for their batch timing option) but can also introduce their own
modes.

Visualizing and Reporting Results

SchedulePro displays schedules in a variety of formats:

As an explorer tree view (similar to recipes and resources).

As an interactive oriented Gantt chart.

As an interactive reusable-resource occupancy chart — this view shows the blocking of equipment, work areas and staff over time.
Functionality to generate, edit or update a schedule exists in all these three views.

SchedulePro generates the following charts:
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« Resources (material, labor or utilities demand, or waste generation) as a function of time.
< Material inventories as a function of time.
« Resource utilization statistics.

SchedulePro also provides the following reports in HTML format:

e Full Schedule Report.

« Equipment Occupancy

« Staff Occupancy

» Materials Consumption

« Daily Activity

« Economics

« Utilization Tables

« Material Orders and Receipts
¢ HTML Gantt and Equipment Occupancy Charts.
* Recipe report

* Transfer Panel Report

See Chapter 8 for more details about charts and reports.
Interaction with Other Programs

SchedulePro has import or export routines for the following programs: SuperPro Designer (import only), Microsoft Project (export
only). In addition, the scheduler may be driven from an input file. SchedulePro can export and import data from a SQL Server
database. See Chapter 8 for more details about charts and reports.

Interation with Other Programs

SuperPro Designer

SchedulePro has import or export routines for the following programs: SuperPro Designer (import only), Microsoft Project (export
only). In addition, the scheduler may be driven from an input file. See chapter 5 for details.

ERP/MRP Systems

SchedulePro’s Connectivity feature provides two ways to connect production order information to external ERP/MRP systems.
SchedulePro currently supports configurable text file and MS Access interfaces. See chapter 8 for details.

External Database (SQL Server)

An entire schedule or individual campaigns may be stored in a SQL Server database. SchedulePro provides basic reporting
capabilities. See Chapter 10 for more information. The SQLServer database is also used by the SchedulePro satellite applications:
SchedulePro Web Viewer and Tracker.

Launching SchedulePro
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SchedulePro may be launched from the Start menu. By default it is located in the SchedulePro menu in the Programs menu.

The initial screen will appear as shown below.

If you have had an earlier version of SchedulePro, the program will ask if you wish to use settings from the previous version. These
settings include the recently opened file list, and any user-selected options in the Edit/Preferences menu.

If you receive a warning concerning databases you may need to manually set the location of the database files. After the program
starts, select Databanks/Locations from the menu. Ensure that the database files exist and that you have read/write permission.

General Options

Select “Edit/Preferences...” from the main menu.

The following general options may be set:

Show Recipe Branches in Tree

Recipe branches are displayed in the navigation tree. This option is saved with the project file.

Show Recipe Sections in Tree

Recipe sections are displayed in the navigation tree. This option is saved with the project file.

Show Campaign Projects

A project is a group of campaigns. This option must be selected to enable the use of campaign projects.

Show Default Equipment for Procedures

The top-priority equipment is shown for recipe procedures in the navigation tree. This option is saved with the project file.

Display Calendar/Relative Time
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This sets the default format in which time is displayed in SchedulePro’s tables and charts. This option is saved with the project file.
Report Viewer

This option sets whether reports are viewed with the system web browser or with SchedulePro’s built-in report view. This option is
saved with the application settings.

Autosave Settings

SchedulePro can automatically save the currently open document. The saved file will reside in the same directory as the working
file, and the saved files will have the extension, “SAV.” The default save interval is 15 minutes. When you use the autosave feature,
you should have write access to your SchedulePro files.

Physical Units Defaults

Select “Edit/Physical Units Defaults” to set the default display units for typical measurements.

Create Your First Schedule

This section describes the process of creating an extremely simple schedule. Please see the tutorial for a more complete set of
instructions.

Create a Facility and Add Equipment

All schedules in SchedulePro must have some equipment resources.

Click on Facilities in the navigation tree on the left.

In the right-hand window, click the magic wand ( ) button to create a new facility. Select OK from the dialog.
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Expand the new facility in the navigation tree by clicking the (+) just left of the facility’s name.

Select Equipment and click the magic wand button to create a new equipment resource. Click Ok.

Create a Simple Recipe

Click on Recipes in the navigation tree.
In the right-hand window, click the magic wand to create a new recipe. Enter a name for the new recipe, e.g. “My Process”. Click Ok.

Click on the new recipe in the navigation tree.

Click the add procedure button ( ) to add a new procedure. Click Ok. The new procedure has one default operation, which has
a duration of 1 hour.

Select “P-1" from the procedure table and click the edit procedure button ( ) to view the procedure’s properties.
Select the Main Equipment Pool tab.

Select “New Equipment” from the Available Equipment list and click the add button () to assign the equipment to the procedure.
Click Ok.

Schedule the Recipe

Select Production Schedule in the navigation tree.

In the right-hand window, select the Add New Campaign ( ) button just above the Campaign Sequence grid. Click Ok.
Click the Schedule Campaigns button () to schedule the campaign.

Congratulations! You have just created and scheduled a simple one-step process. Select “View/Gantt Chart....,” or the ( )
button form the toolbar to see the Gantt chart.
Use “File/Properties” from the main menu to add a title and description for your project.

Use “File/Save As” to save your work as a SchedulePro (.scp) file
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User Interface

Getting around in SchedulePro

Interface Concepts

SchedulePro is a Windows-based application that makes use of standard Windows components.

The SchedulePro Document

A SchedulePro project begins with an empty SchedulePro document. SchedulePro creates a new empty document when it
launches. You may also create a document by selecting “File/New” from the main menu. SchedulePro saves all the information for
the project in a SchedulePro file. SchedulePro files have the extension SCP. SchedulePro allows you to work on multiple
documents at once.

You may open a SchedulePro document by:

¢ Using the File/Open menu in SchedulePro
* Double-clicking on the document
« Dragging and dropping the document to the SchedulePro window

* Using the “Recently Opened” feature in the Windows Start Menu (Windows 7+)

Navigation

Working with SchedulePro entails adding, deleting and modifying various elements or objects including recipes, procedures,
operations, equipment etc. Because it would be impractical to display all of a single project’s elements, SchedulePro displays only a
few at a time but provides a convenient means of navigating to the desired item. The navigation tree, described in 3.2, displays a
structure that reflects the organization of the SchedulePro project.

As a rule, all elements that contain sub-elements, for example unit procedures contain operations, are displayed in the navigation
tree. Elements that do not contain sub-elements are listed in a window on the right-hand side. For example, unit procedures are
displayed in the tree. Selecting a unit-procedure will cause the right-hand window to display a list of the operations in the procedure.
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Context (Right-Click) Menus

Context menus are pop-up menus that appear when the user right-clicks on an element in the interface. The choices in the menu
depend on the element that was selected. Most additions, deletions and editing may be done through context menus.

Toolbar Buttons

Toolbar Buttons

Main Toolbar

The main SchedulePro Toolbar has the following buttons:

Create a new SchedulePro project.

Create a new SchedulePro document.
Open an existing SchedulePro document.
Save the current SchedulePro document.
Close an open SchedulePro document.
Cut the selected object to the clipboard.

Copy the selected object to the clipboard.
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Paste an object from the clipboard.
Print. There is not general print. Printing should be done from charts or reports.
Schedule all unscheduled campaigns.

Unschedule all scheduled campaigns (delete all batches).

Resolve all conflicts.

View all conflicts.
Display the Equipment Occupancy chart.
Display the Schedule Gantt chart.

Display the evaluation information for the scheduled activities.

Edit the schedule start and current time settings.
Select the scheduling mode.

Edit the selected scheduling mode.

View and manage schedule data in the SQL Server database. (SQL Server feature must be enabled.)

Launch the help facility.

Many of SchedulePro’s windows and dialogs have a toolbar. Some of the most common buttons are listed below:

Edit the properties of the selected object.

Create a new item. This tool appears when order is not important.

Select all the item in the list.

Create a new item and add it at the end of the list.

Create a new item and insert it in the list above the currently selected item.
Move the selected item one place nearer to the top of the list.

Move the selected item one place nearer to the bottom of the list.

Move the selected item to the top of the list.

Move the selected item to the bottom of the list.

Delete the selected item(s).

Interface Concepts
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Deselect all items from the list

Most buttons and controls will display a tooltip or short description, if you move the mouse over them.

SchedulePro Navigation Tree

SchedulePro uses an “Explorer” style navigation to view recipes, resources and schedules. In general, when an object is selected in
the tree, the right-hand pane(s) will show the basic properties of the selected object along with a list of its sub-objects.

There are two main “window panes”. The pane on the left contains the explorer. This is a map of all the items in the project. The
large window on the right hand side displays details of the item selected in the tree at the left. Each item in the tree has a “context”
or “right-click” menu.

If an item in the tree is preceded by a plus (+) sign, then the item may be expanded by clicking on the plus sign. If an item is
preceded by a minus (-) sign, then the item may be rolled-up, so that all its sub-items are hidden.

Selecting either the top-level item or the Production Schedule item will display the main scheduling screen.
Selecting an item on the Navigation ( see page 17) Tree brings up the appropriate SchedulePro Window.

Note: Certain tree levels may be optionally displayed or hidden. Use the “Edit/Preferences...” option from the main menu to select
whether recipe branches or sections are to be shown.
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SchedulePro Windows

The right pane in SchedulePro is automatically updated based on the selection made on the left pane (Navigation ( see page 17)
Tree).

Many of the right-side windows are grid views in which the contents are displayed in tabular form. The column widths may be
adjusted by dragging and dropping the headers. The widths are saved with the document.

Campaign Window

The Campaign Window is displayed when the SchedulePro Project node or the Production Schedule node is selected on the
Navigation.

The Campaign Window displays Scheduler Settings and a Campaign Sequence list. The Campaign Sequence list can be modified
from the Campaign Sequence Toolbar, or via the Campaign Sequence Context (right-click) Menu.

If campaign projects are shown, there will also be a “Project” column.

Scheduler Settings

The following information is present on the Scheduler pane of the Campaign Window.
Start Date and Time

The scheduling start date and time ( see page 220). This is the earliest time that SchedulePro can represent. All activities should
be scheduled after this time. The value may be changed after activities have been scheduled. Any

Scheduling Horizon

The scheduling horizon ( see page 220) duration and time units. The value should be long enough to cover the entire schedule. It
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may be changed at any time. The scheduling horizon is used as a default maximum time for entering repeated events, e.g.
weekends.

Schedule Start

The start date ( see page 220) and time for the scheduling project.

Schedule End

The end date ( see page 220) and time of the latest scheduled batch.

Current Time

The SchedulePro current time ( see page 220) set by the user.

Display Calendar Times

Check to display absolute (calendar) times.

Display Relative Times

Check to display relative times in the selected units.

Edit Schedule Timing

This brings up the “Scheduler Timing ( see page 220)” dialog containing 3 tabs. From the Scheduling Horizon tab the Start Date
and Time and the Scheduling Horizon can be modified. From the Current Time tab the current time can be set. By clicking on the
Set to Computer Clock button the SchedulePro current time can be set to the system time. The default release date for new
campaigns may be set from the Default Release Time tab.

Show Row Numbers

Displays or hides row numbers in the campaign sequence.

Search

The search feature allows lookup of campaigns with names that match specific text.
Filter

For projects with large numbers of campaigns, apply one of the following filters

* Recipe Folder

e Campaign Project

« Based on Clipping Options ( see page 270)
* No filter

Campaign Sequence Toolbar

The Campaign Sequence displays a list of all scheduled or unscheduled campaigns in the active SchedulePro project, and a
summary of their most important properties.

The Campaign Sequence can be modified from the Campaign Sequence Toolbar. The following operations on campaigns are
available.

Edit Campaign

Edit the properties ( see page 222) of the selected campaign.

Add New Campaign
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Add a new campaign at the bottom of the list.

Insert New Campaign

Insert a new campaign before the selected one.

Promote Campaign

Move the selected campaign one position up on the list. This gives the campaign a higher priority for claiming resources.

Demote Campaign

Move the selected campaign one position down on the list. This gives the campaign a lower priority for claiming resources.

Move to Top

Move the selected campaign to the top of the list. This gives the campaign maximum priority for claiming resources.

Move to End

Move the selected campaign to the bottom of the list. This gives the campaign minimum priority for claiming resources.

Select All

Select all the campaigns

Deselect all

Cancel all selections

Delete Campaign

Delete the selected campaign.

Schedule Campaign

Schedule the selected campaign.

Unschedule Campaign

This unschedules the selected campaign by deleting all its batches.

View Conflicts

Display a list of all the conflicts for the selected campaign.

Resolve Conflicts in Campaign

Resolve conflicts in the selected campaign.

Campaign Lock

Lock the batches in the selected campaign(s).

Campaign Unlock

Unlock all the batches in the selected campaign(s).
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Campaign Copy
Copy the campaign.

Campaign Paste

Paste a campaign from the clipboard.

Bill of Materials Balance.

Show bill of materials (BOM) ( see page 256) for the entire schedule.

Define Campaign Projects (  see page 249)

Define one or more campaign projects. A project is a set of related campaigns.

Reorder Unscheduled Campaigns

Reset the scheduling priority of the selected campaigns.
Export Campaign to the SQL Server database ( see page 342)

Campaign History

View the SQL History ( see page 342) of the selected campaigns.

Campaign Database Details

View the campaign information from the SQL Server database ( see page 342)

Campaign Sequence Context Menu

The Campaign Sequence can also be modified from a context menu. The following operations on campaigns are available.
Properties...

Edit the properties of the selected campaign. Note: Some campaign properties may only be modified before the campaign is
scheduled.

Lock

Lock all batches owned by the selected campaign. Locked batches may not be changed by the user or by the scheduling algorithm.
Schedule

Schedule the selected campaign.

Unschedule

Unschedule the selected campaign.

Reschedule

Reschedule the selected campaign (unschedule and then schedule again)

Insert Campaign Before...

Create a new campaign and insert it before the selected campaign.
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Insert Campaign After...

Create a new campaign and insert it after the selected campaign.
Promote

Move the selected campaign one position up in the list.

Demote

Move the selected campaign one position down in the list.

Delete

Delete the selected campaign.

Export to Database

Exports the selected campaign to the SQL Server database.

Table Contents

SchedulePro Windows

The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting

the whole table. The copy option copies only the text in the table.
Export to SQL Server

Export the campaign to the SQL Server Database

Batch Window

The Batch ( see page 287) Window or Batch ( see page 287) List is displayed below the Campaign Window when the
SchedulePro Project node or Production Schedule node is selected on the Navigation ( see page 17) Tree. The Batch ( see
page 287) Window displays the Batch ( see page 287) Sequence. The Batch ( see page 287) Sequence can be modified from

the Batch ( see page 287) Sequence Toolbar or the Batch (  see page 287) Sequence Context Menu.

The Batch ( see page 287) Sequence displays a list of all scheduled batches in the active SchedulePro project, and summarizes

their key properties.
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Batch Sequence Toolbar

The Batch ( see page 287) Sequence can be modified from the Batch ( see page 287) Sequence Toolbar. The following
operations on batches are available.
Edit Batch ( see page 287)

Edit the properties ( see page 241) of the selected batch.

Add New Batch ( see page 287)

Add a new batch at the bottom of the list.

Insert New Batch ( see page 287)

Insert a new batch before the selected one.

Delete Batch ( see page 287)

Delete the selected batch.

View Conflicts

Display a list of all the conflicts for the selected batch.

Resolve Conflicts

Resolve all conflicts in the selected batch.

Batch (  see page 287) Color Option

Change how the batch color is displayed in the table.

Batch Sequence Context Menu

The Batch ( see page 287) Sequence can also be modified from a context menu. The following operations on batches are
available.

Properties...

Edit the properties of the selected batch.

Lock

Lock the selected batch. Locked batches may not be changed by the user or by the scheduling algorithm.
Recalculate Conflicts

Recalculate conflicts for the selected batch.

Conflict View...

Show conflicts with other batches.
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Resolve Conflicts

Resolve conflicts for the selected batch.

Reschedule

Reschedule the selected batch.

Insert Batch ( see page 287) Before

Insert a new batch of the same campaign before the selected one.

Insert Batch ( see page 287) After

Insert a new batch of the same campaign after the selected one.

Delete

Delete the selected batch.

Copy Timing

Copy the timing and resource assignments of the selected batch. Includes user edits.
Paste Timing

Transfer the relative timing previously copied and the resource assignments to the selected batch.
Copy Timing to Recipe

Copy user-defined timing changes in the batch back to the recipe.

Table Contents

The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting
the whole table.

Recipe List Window

The Recipe List Window is displayed when the SchedulePro Recipes node is selected on the Navigation ( see page 17) Tree.

The Recipes list can be modified from the Recipes Toolbar, or via the Recipes Context Menu.
Recipes List

The recipes list summarizes all available recipes in the active SchedulePro project and their basic properties.
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Recipes Toolbar

The Recipes list can be modified from the Recipes Toolbar. The following operations on recipes are available.

Import Recipe from DB
Import a recipe from the Recipes Database and add it to the list.
Create New Recipe

Delete Recipe

Delete the selected recipe.

Edit Recipe

Edit the properties of the selected recipe.

Show Recipe Gantt chart

Display the Gantt chart for the selected recipe.

Promote Recipe

Move the selected recipe one position up in the list. This affects only the display of the recipe.

Demote Recipe

Move the selected recipe one position down in the list. This affects only the display of the recipe.

Move to Top

Move the selected recipe to the top.

Move to Bottom

Move the selected recipe to the bottom.

Cut Recipe

Cut the selected recipe.

Copy Recipe

Copy the selected recipe.

Paste Recipe

Paste the selected recipe to the bottom of the list.

Find Recipe

Scrolls to and selects the desired recipe
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Sort Ascending

Put the recipes in alphabetical order.

Sort Descending

Put the recipes in reverse alphabetical order.

Sort Ascending in Folders

Sort ascending within assigned folders. Available only if folders are used.

Sort Descending in Folders

Sort descending within assigned folders. Available only if folders are used.

Recipe Context Menu

The Recipe list can also be modified from a context menu. The following operations on recipes are available:
Properties...

Edit the properties of the selected recipe.

Add Section...

Add a section to the recipe

Recipe Gantt Chart...

View a Gantt chart of the selected recipe.

Recipe Flow Chart...

View a flow chart of the selected recipe.

Set Flex-shifts (breaks)...

Set flexible time shifts for the selected recipe.

Edit Auxiliary Equipment Requirements...

Edit the auxiliary equipment for all operations.

Edit Labor Requirements...

Set/modify labor requirements for the selected recipe.

Scale Recipe...

Modify the batch size of the selected recipe.

Assign Operation ( see page 287) Types...

Set the operation type for all the operations in the selected recipe. Operation ( see page 287) types must be previously defined.
Procedures Overview ( see page 336) ...

Display a tabular overview of the selected recipe’s procedures

Edit Operation ( see page 287) Report Text...
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Edit the text that appears on the operation report.

Update Cycle Time Estimate

Update a cycle time estimate of the selected recipe.

Check Recipe...

Check the selected recipe for incomplete data, missing specifications, etc.
Cut

Cut the selected recipe and place it on the clipboard.

Copy

Delete the selected recipe to the clipboard.

Paste

Paste the selected utility (appears only when a recipe has been copied or cut).
Delete

Delete the selected recipe.

Table Contents

Cut/Copy/Paste the text in the table.

Write Back to Recipe DB

Write the selected recipe to the Recipe DB.

Write Recipe to Text File

Export the recipe to a tab-delimited file format.

Export to SQL DB

Export selected recipe to the SQL Database.

Recipe Window

The Recipe window is displayed when a SchedulePro individual recipe node is selected on the Navigation ( see page 17) Tree.
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The Recipe window displays basic recipe properties, scheduling information, and a list of procedures in the recipe. The Procedures
list can be modified from the Procedures Toolbar, or via the Procedures Context Menu.

Basic scheduling information is shown on the Recipe window.

Estimated Batch ( see page 287) Time

View an estimate of the recipe duration (one batch) in the selected time units.
Estimated Cycle Time

View an estimate of the recipe cycle time in the selected time units.
Bottleneck

View the current bottleneck procedure. This is an estimated bottleneck that is determined by longest, most equipment-limited
procedure.

Incomplete Recipe

If a recipe cannot be scheduled, the “Incomplete Recipe” button is displayed. Normally this is not visible for a completed recipe.
Click on the button to display a description of the problem.

Recipe Properties

A number of basic recipe properties can be viewed or modified from the Recipe window.

Name

View the recipe name. Use “Edit Recipe Data” to modify.

Description

View the recipe description. The description is optional and may be left empty. Use “Edit Recipe Data” to modify.

Batch ( see page 287) Size
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View the recipe batch size in the selected units. Use “Scale Recipe” to modify.
Edit Recipe Data

Modify the recipe name, description, and batch size properties.

Gantt Chart

View the recipe Gantt chart.

Recipe Flow Chart
View the recipe flow chart.
Edit labor requirements for the recipe.
Edit the staff requirements for the recipe.
Edit auxiliary equipment and transfer panel requirements for the recipe.
Set the operation type for all the operations in the recipe. Operation ( see page 287) types must be previously defined.
Display a tabular overview of the recipe’s procedures.
Scale Recipe -- Modify the recipe batch size.
Edit all the streams in the recipe.

Assign the recipe to an SKU.

View conflicts for the recipe.

Edit the variability information for the recipe.

Chart Color View/modify the current recipe color on the equipment occupancy chart.

Procedures Toolbar

The Procedures list can be modified from the Procedures Toolbar. The following operations on procedures are available.

Add New Procedure ( see page 287)

Add a new procedure to the bottom of the list.

Insert New Procedure ( see page 287)

Insert a new procedure before the currently selected procedure.

Delete Procedure ( see page 287)
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Delete the selected procedure.

Edit Procedure ( see page 287)

Edit the properties ( see page 142) of the selected procedure.

Promote Procedure ( see page 287)

Move the selected procedure one position up in the list.

Demote Procedure ( see page 287)

Move the selected procedure one position down in the list.

Move to Top

Move the selected procedure to the top.

Move to Bottom

Move the selected procedure to the bottom.

Cut Procedure ( see page 287)

Cut the selected procedure.

Copy Procedure (  see page 287)

Copy the selected procedure.

Paste Procedure ( see page 287)

Paste the selected procedure to the bottom of the list.

Procedures Context Menu

SchedulePro Windows

The Procedures List can also be modified from a context menu. The following operations on procedures are available.

Properties...

Edit the properties of the selected procedure.
Delete

Delete the selected procedure.

Cut

Cut the selected procedure.

Copy

Delete the selected procedure.

Paste

Paste the selected utility (available only if a procedure has been cut or copied).
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Table Contents

The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting
the whole table.

Section Window

The Section Window is shown when a SchedulePro section node is selected on the Navigation ( see page 17) Tree and the option
to show sections on the Navigation ( see page 17) Tree is selected (to set this option, select item Edit/Preferences... on the main
SchedulePro menu).

The Section Window displays basic section properties and a Procedures list for the recipe. The Procedures list can be modified
from the Procedures Toolbar, or via the Procedures Context Menu. Use the edit () button to edit the section properties.

The Procedure ( see page 287) list uses the procedure toolbar described in the Recipe Window section.

The properties window edits the section properties.
The Must Use Suite checkbox

If checked, the main equipment for procedures must belong to a single suite ( see page 141).

Procedure Window

The Procedure ( see page 287) Window is displayed when a SchedulePro procedure node is selected on the Navigation ( see
page 17) Tree.
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Operation ( see page 287) Table:

The operations can also be modified from a context menu. The following actions on operations are available:
Properties...

Edit the properties of the selected operation.

Scheduling Info...

Set/modify scheduling information for the selected operation.
Resources...

View/modify resource details for the selected operation.
Delete

Delete the selected operation.

Cut

Cut the selected operation.

Copy

Copy the selected operation.

Paste

Paste the selected utility.

Table Contents

The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting
the whole table.

Links
Display a tree diagram of the operations that depend on the selected operation.

The Procedure ( see page 287) Window displays basic procedure information and the procedure’s Operation ( see page 287)
Sequence. The Operation ( see page 287) Sequence can be modified from the Operation ( see page 287) Sequence Toolbar, or
via the Operation ( see page 287) Sequence Context Menu. Use the edit () button to edit the procedure properties.
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Materials List Window

The Materials List Window is displayed when SchedulePro Materials node is selected on the Navigation ( see page 17) Tree.

The Materials List Window displays the list of materials in the active SchedulePro project. The Materials list can be modified from
the Materials Toolbar, or via the Materials Context Menu.

The Materials list displays all SchedulePro materials (in alphabetical order) and summarizes some of their important properties. The
list can be customized to display Bulk or Discrete materials only.

Materials Toolbar

The Materials list can be modified from the Materials Toolbar. The following operations on materials are available.

Create New Material

Create and add a new material.

Delete Material Button

Delete the selected material.

Edit Material

Edit the properties of the selected material.

Used By

Display the “Used By” dialog that shows the usages of the selected material.

Copy Material

Copy the selected material.

Paste Material

Paste the selected material to the list.

The Materials list can also be modified from a context menu. The following operations on materials are available.
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Properties...
Edit the properties of the selected material.

Used by...

View a list of streams making use of the selected material.

Delete

Delete the selected material.
Cut

Cut the selected material.
Copy

Copy the selected material.
Paste

Paste the selected utility.

Table Contents

SchedulePro

SchedulePro Windows

The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting

the whole table.

SKU List Window

The SKU ( see page 251) is displayed when the SKUs node
the upper section that enable the display of Raw Materials, Intermediates, and Products.

is selected in the navigation tree. There are three checkboxes on

The bill of materials layout ( ) button displays a chart with all the bills of materials for all the SKUs in the file. The order template

button ( ) displays a list of SKU order templates.
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SKU Toolbar

The SKU list has the following buttons:

Create a new SKU ( see page 251)

Delete the selected SKU

Edit the selected SKU

Display the bill of materials (BOM) for the selected SKU

Move the SKU up or down in the list

Edit the SKU recipe assignment information

Show the Recipe block diagram with SKU BOM information.
Show the Recipe Gantt chart for the SKU.
Export the selected SKU to

Show where the SKU is used in other SKU BOMs, campaigns, and storage units
Copy the selected SKU.

Paste the copied SKU

Order the list by SKU name
The SKU right-click menu has the following items:
Properties... Edit the SKU

Cut/Copy/Paste Cut, copy or paste the selected SKU.

Facilities List Window

The Facilities ( see page 181) List window is shown when SchedulePro Facilities node is selected on the Navigation Tree.

The Facilities List window displays a list of facilities in the active SchedulePro project. The Facilities list can be modified from the
Facilities Toolbar, or via the Facilities Context Menu.

38



3 User Interface SchedulePro SchedulePro Windows

Facilities List

The Facilities ( see page 181) list displays all facilities (in alphabetical order) and the following key information:
Has outages : Whether there is any scheduled downtime for the facility.

Has suites : Whether there are any suites defined for the facility.

Location : Optional information about the facility location.

Description : Optional description.

Facilities Toolbar

The Facilities ( see page 181) list can be modified from the Facilities Toolbar. The following operations on facilities are available.

Create New Facility
Add a new facility to the list.
Delete the selected facility.
Edit the properties of the selected facility.
Edit facility downtimes for the selected facility.
Edit the facility’s suite information.
Promote Facility / Move the selected facility one position up in the list. This affects display only.
Demote Facility / Move the selected facility one position down in the list. This affects display only.
Cut the selected facility.
Copy the selected facility.

Paste the copied facility to the list.

The Facilities list can also be modified from a context menu. The following operations on facilities are available.
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Properties...

Edit the properties of the selected facility.
Outages ( see page 158)...

View/modify downtimes for the selected facility.
Suites ( see page 141) ...

View/modify suite information for the facility.
Delete

Delete the selected facility.

Write to Database

Update the Recipe DB with the modified facility.
Cut

Cut the selected facility.

Copy

Copy the selected facility.

Delete

Delete the selected facility.

Paste

Paste the selected utility.

Table Contents

3 User Interface

The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting

the whole table. Text only is copied.

Labor Window

The Labor ( see page 185) Window is displayed when the SchedulePro Labor node is selected on the Navigation (  see page 17)

Tree.

The Labor Window displays a list of labor items in the active SchedulePro project. The list can be modified from the Labor Toolbar,

or via the Labor Context Menu.

The Labor list can be modified from the Labor Toolbar. The following operations on labor are available:
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Create New Labor
Add a new labor item to the list.
Delete the selected labor item.
Edit the properties of the selected labor item.
Display the operations that use the labor item.
Display the labor demand as a function of time for the selected labor resource.
Edit labor item downtimes for the selected labor item.
Cut the selected labor item.
Copy the selected labor item.

Paste the selected labor item to the list.

The Labor list can also be modified from a context menu. The following operations on labor items are available
Properties...

Edit the properties of the selected labor item.

Used By...

View a list of operations/procedures making use of the selected labor item.
Show Profile

Display the labor demand as a function of time for the selected labor resource.
Cut

Cut the selected labor item.

Paste

Paste the selected utility.

Delete

Delete the selected labor item.

Table Contents

The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting

the whole table.

Labor List

The Labor list displays all labor items (in alphabetical order) and a summary of their properties.
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Labor Toolbar

The Labor list can be modified from the Labor Toolbar. The following operations on labor are available:

Create New Labor

Add a new labor item to the list.

Delete Labor

Delete the selected labor item.

Edit Labor

Edit the properties of the selected labor item.

Used By

Display the operations that use the labor item.

View Labor Profile

Display the labor demand as a function of time for the selected labor resource.

Labor Outages ( see page 158)

Edit labor item downtimes for the selected labor item.

Cut Labor

Cut the selected labor item.

Copy Labor

Copy the selected labor item.

Paste Labor

Paste the selected labor item to the list.

Labor Context Menu

The Labor list can also be modified from a context menu. The following operations on labor items are available
Properties...

Edit the properties of the selected labor item.

Used By...

View a list of operations/procedures making use of the selected labor item.
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Show Profile

Display the labor demand as a function of time for the selected labor resource.
Apply Outage Calendar to All

Pastes the outages of the last-copied resource to all the resources in the list
Cut

Cut the selected labor item.

Copy

Delete the selected labor item.

Paste

Paste the selected utility.

Paste Outage Calendar Only

Paste the Outages ( see page 158) from the last copied resource to the selected resource
Delete

Delete the selected labor item.

Table Contents

The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting
the whole table.

Staff Window

The staff ( see page 187) resources window displays the staff list.

Add a new staff item to the list.
Delete the selected staff item.
Edit the properties of the selected staff item.

Display the operations that use the staff item.
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Edit labor item downtimes for the selectedstaff item.
Cut the selectedstaff item.
Copy the selected staff item.

Paste the selected staff item to the list.

Staff entries have the following context menu:

Properties...

Edit the properties of the selected staff resource item.

Used By...

Display the operations that use the staff resource item.

Apply Outage Calendar to All

Pastes the outages of the last-copied resource to all the resources in the list
Move To...

Move the staff resource to a different facilty.

Delete

Delete the selected staff resource item.

Cut

Cut the selected staff resource item to the clip board.

Copy

Copy the selected staff resource item.

Paste

Paste the selected utility.

Paste Outage Calendar Only

Paste the Outages ( see page 158) from the last copied resource to the selected resource
Table Contents

The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting
the whole table.

Utilities Window

The Utilities (  see page 188) window is shown when the SchedulePro Utilities node is selected on the Navigation Tree.

The Utilities Window displays a list of utilities under a particular facility in the active SchedulePro project. The list can be modified
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from the Utilities Toolbar, or via the Utilities Context Menu.

The Utilities list can be modified from the Utilities Toolbar. The following operations on utilities are available.
Add a new utility to the list.
Delete the selected utility.
Edit the properties of the selected utility.
Display the operations that use the selected utility.
Display the utility demand as a function of time for the selected labor resource.
Cut the selected utility.
Copy the selected utility.

Paste the selected utility to the list.

The Utilities list can also be modified from a context menu. The following operations on utilities are available.

Properties...

Edit the properties of the selected utility.
Used By...

View a list of operations/procedures making use of the selected utility.
Delete

Delete the selected utility.

Cut

Cut the selected utility.

Copy

Delete the selected utility.

Paste

Paste the selected utility.

Table Contents

SchedulePro Windows
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The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting
the whole table.

Equipment (Work Area / Transfer Panel) Window

The Equipment ( see page 190) window is shown when the SchedulePro Equipment node is selected on the Navigation ( see
page 17) Tree. The Work Area and Transfer Panel windows have the same features although the columns differ for each resource.

The Equipment Window displays a list of equipment items under a facility in the active SchedulePro project. The list can be
modified from the Equipment Toolbar, or via the Equipment Context Menu.

The display is similar for Work Areas ( see page 196) and Transfer Panels ( see page 198).

Toolbar

The Equipment list can be modified from the Equipment Toolbar. The following operations on equipment items are available.
Add a new equipment item to the list.
Insert a new equipment item above the current selection.
Delete the selected equipment item.
Edit the properties of the selected equipment item.
Move item up in the list
Move itemn down in the list
Display the procedures and operations that use the selected equipment item.

Edit equipment item downtimes for the selected equipment item.
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Cut the selected equipment item.

Copy the selected equipment item.

Paste the selected equipment item to the list.

Put the equipment in alphabetical order.

Put the equipment in reverse alphabetical order.

SchedulePro Windows

The Equipment list can also be modified from a context menu . The following operations on equipment items are available.

Properties...

Edit the properties of the selected equipment item.

Used By...

View a list of procedures making use of the selected equipment item.
Apply Outage Calendar to All

Pastes the outages of the last-copied resource to all the resources in the list
Cut

Cut the selected equipment item.

Copy

Delete the selected equipment item.

Delete

Delete the selected equipment item.

Paste

Paste the selected equipment item. This item only appears when equipment has been cut or pasted on to the clipboard.

Paste Outage Calendar Only

Paste the Outages ( see page 158) from the last copied resource to the selected resource

Table Contents

The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting

the whole table.

Storage Unit / Material Supply System Windows

The Storage Unit ( see page 201) window is displayed when the SchedulePro Storage node is selected on the Navigation ( see

page 17) Tree.

Material supply systems are special storage units that handle specific materials. The interface is the same for both.
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The Storage Unit Window displays a list of storage units under a facility in the active SchedulePro project. The list can be modified
from the Storage Unit Toolbar, or via the Storage Unit Context Menu.

Toolbar

The Storage Unit list can be modified from the Storage Unit Toolbar. The following operations on storage units are available:
Add a new storage unit to the list.
Delete the selected storage unit.
Edit the properties of the selected storage unit.

View a list of streams making use of the selected storage unit.

View the inventory profile of the storage unit if available.
Edit scheduled receipts and draws for the storage unit.
Show a list of all the scheduled receipts and withdrawals.
Update the material holding events for equipment-associated storage units.
Cut the selected storage unit.
Copy the selected storage unit.
Paste the selected storage unit to the list.
Sort by name ascending.

Sort by name descending.

Contents Menu

The Storage Unit list can also be modified from a context menu. The following operations on storage units are available.
Properties...

Edit the properties of the selected storage unit.

Used By...

View a list of streams making use of the selected storage unit.
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Show Profile...

View the inventory profile of the storage unit if available.
Delete

Delete the selected storage unit.

Cut

Cut the selected storage unit.

Copy

Delete the selected storage unit.

Paste

Paste the selected storage unit. Displays only when a storage unit has been copied or cut.
Table Contents

The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting
the whole table.

Campaign Entry Window

The Campaign Entry Window is displayed when a scheduled campaign node is selected on the SchedulePro Navigation ( see
page 17) Tree under Production Schedule.

The Campaign ( see page 222) Entry Window displays basic properties of a scheduled campaign and the list of Scheduled
Batches for the campaign. The list can be modified from the Scheduled Batches Toolbar ( see page 26), or via the Scheduled
Batches Context Menu.

The following campaign properties are shown on the Campaign Entry Window:
Recipe -- the recipe name

Start/End -- the absolute start and end times of the campaign
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Campaign Size -- the recipe batch size for the campaign
Scale Factor -- the recipe scale factor corresponding to the batch size

Number of Batches -- the number of batches

Edit Campaign Properties button.

Scheduled Batches List

The Scheduled Batches ( see page 241) list displays all scheduled batches for the selected campaign and a summary of their
properties.

The scheduled batch list has the following colums:

e Batch ( see page 287) -- the batch ID

« Duration -- the total duration of the batch

« Nominal Start -- the start time for activities scheduled with the Batch ( see page 287) - Start scheduling
« Absolute Start -- the start of the earliest operation in the batch.

¢ End -- the end of the last operation.

e Status -- If the current time is defined, the batch is "completed" if the end is before the current time, the batch is "in progress" if
the start is earlier than the current time and the end is after the current time. The status is "scheduled" otherwise.

¢ Conflicts, indicates whether there are any resource conflicts.

The batch toolbar has the following items:
Edit the batch properties
Schedule an additional batch
Insert an additional batch
Delete the selected batch
View any conflicts

Resolve conflicts for selected batch

The Scheduled Batches list can also be modified from a context menu. The following operations on batches are available.
Properties...

Edit the properties of the selected batch.

Lock

Lock the selected batch.

Recalculate Conflicts Recalculate conflicts for the selected batch.

Conflict View... View a list of conflicts with other batches in the campaign.
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Resolve Conflicts Resolve conflicts for the selected batch.

Reschedule Unschedule and again schedule the selected batch.

Insert Batch ( see page 287) Before Insert a new batch in the campaign before the selected one.
Insert Batch ( see page 287) After Insert a new batch in the campaign after the selected one.
Delete Delete the selected batch from the campaign.

Copy Timing Copy the user-defined timing modifications.

Paste Timing Paste timing changes from one campaign to another (recipes must be the same).
Copy Timing to Recipe Translate user-added shifts to fixed shifts in the recipe.

Table Contents The Table Contents submenu contains items that allow for copying the selected table region, copying the whole
table and selecting the whole table.

Batch Entry Window

A number of important batch properties are shown on the Batch Entry ( see page 241) Window. These include the batch,
campaign, and recipe names, the batch size in selected units, the start and end time of batch execution, etc.

The batch properties are:

Batch ( see page 287) ID

Campaign ID

Recipe ID

Batch ( see page 287) Nominal Start

Batch ( see page 287) End

Use the edit button ( ) to view or modify properties of the scheduled batch.

Scheduled Procedures Toolbar

A Scheduled Procedure ( see page 244) can be modified from the Scheduled Procedures Toolbar. The following operations on
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procedures are available.

Edit Procedure ( see page 287)

View/edit the properties of the selected procedure.

View Conflicts

Display a list of all the conflicts for the selected procedure.

The procedure context menu includes;
Properties... Edit the procedure

View Conflicts... Display any conflicts
Resolve Conflicts Resolve conflicts

Delete batch Onwards Delete subsequent procedures

Scheduled Procedure Entry Window

3 User Interface

The Procedure Entry ( see page 244) Window is displayed when a scheduled procedure node is selected on the SchedulePro

Navigation ( see page 17) Tree under Production Schedule.

The Procedure (  see page 287) Entry Window displays the following procedure properties:

e Procedure ( see page 287) Name
« Description

e Batch ( see page 287) Name

e Campaign Name

* Main Equipment

e Start/End

« Excluded Hidden Operations. If checked, do not show operations with a duration less than 1 second.

The operation sequence toolbar has the following items:
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Edit the operation

View conflicts

The procedure context menu includes;
Properties... Edit the operation

View Conflicts... Display any conflicts
Resolve Conflicts Resolve conflicts

Delete batch Onwards Delete subsequent operations

Operation Sequence

SchedulePro Windows

The Operation Sequence ( see page 246) displays a list of all operations in the procedure, and summarizes their important

properties.
The columns include
e Operation ( see page 287) - The name of the operation
* Cycle # - The cycle of number if there are multiple cycles
* Aux. Equipment - The auxiliary equipment assigned to the operation
« Duration - The duration of the operation
» Start/End - The start and end times

« Status (The status of the operation with respect to the current time.)

» Scheduled: The operation start is after the current time or the current time is not set

» Started: The operation start is before the current time

» Completed: The operation end is before the current time

Operation Sequence Context Menu

The Operation ( see page 287) Sequence can also be modified from a context menu. The following actions on operations are

available:

Properties...

Edit the properties of the selected operation.

Scheduling Info...

Set/modify scheduling information for the selected operation.
Properties...

Edit the operation

View Conflicts
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View the conflicts associated with the operation
Resolve Conflicts

Resolve conflicts associated with the operation
Delete Batch ( see page 287) Onwards

The the remainder of the batch beginning with the selected operation

Table Contents

The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting
the whole table.

Operation Sequence Toolbar

Edit Operation ( see page 287)

Edit the properties of the selected operation.

View Conflicts

View a list of conflicts affecting the operation.

SchedulePro Main Menu
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Main File Menu

The main File menu has the following options:

New Create a new SchedulePro Document ( see page 17)
Open Open an existing SchedulePro Document

Close Close the current document

Save Save the current document

Save As... Save the current document to a specified name and location.

Save As Protected... Save a password-protected (but not encrypted) version of the file.

Save As UnProtected... Unprotect a previously protected file.

Print Setup Set up the local printer properties

Send... Email the current document to someone

Properties... View version and descriptive information about the current document
Recent Documents See and open recently opened documents.

Exit Exit SchedulePro

Edit Menu Item

The Edit menu item provides entries for copying the chart.

SchedulePro Main Menu
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Cut -- Copy the selected item to the clipboard and delete it.

Copy -- Copy the selected item to the clipboard.

Paste -- Paste the appropriate clipboard item from the clipboard.
Paste Special -- Reserved for future use, no current functions.
Delete -- Delete the selected item.

Find... -- Display the find dialog to search for objects in SchedulePro.
Physical Units Defaults... -- Display the default units dialog.

Preferences... -- Display the dialog to set various file display preferences.

Recipe Menu Item

The Recipe ( see page 131) menu item contains entries for creating and importing SchedulePro recipes. It provides the following
entries:

Create New Recipe

Start a new recipe in the current SchedulePro project.

Import from Database

Import a recipe from the Recipes DB. Recipes created with SuperPro can be imported to a SchedulePro project.
Find

Find a recipe and select it in the tree.

Sort Recipe Folders

Sort the recipe folders (if any)

Import From File

Import or update a recipe from a tab delimited text file
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Export to Text File

Export a recipe to a tab-delimited text file.

Resources Menu ltem

SchedulePro

SchedulePro Main Menu

The Resources ( see page 177) menu item contains entries for manipulating SchedulePro resources (materials, facilities,
equipment, labor, etc.). It provides quick links for adding resources to the SchedulePro project. Some functionality may not be
available depending upon the type of the selected SchedulePro object.

The Resources menu item contains the following entries:

Add Material

Add a new material resource to the SchedulePro project.

Add Facility
Add a new facility to the SchedulePro project.

Delete Facility

Delete the selected facility from the SchedulePro project.

Add Labor

Add a new labor type under the selected facility.
Add Staff

Add a new staff resource to the selected facility.
Add Utility

Add a new utility item to the selected facility.
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Add Equipment

Add a new equipment item to the selected facility.

Add Work Area

Add a new work area to the selected facility.

Add Transfer Panel

Add a new transfer panel resource to the selected facility.
Add Storage Unit

Add a new storage unit to the selected facility.

Add Material Supply System

Add a new material supply system to the selected facility.
Material Import/Export

Import or Export Materials via a tab-delimited text file.
Equipment Import/Export

Import or Export equipment via a tab-delimited text file.
Labor Import/Export

Import or Export labor via a tab-delimited text file.

Staff Import/Export

Import or Export staff via a tab-delimited text file.

Load Outages ( see page 158) from File

Import resource outages via a tab-delimited text file.

SKU Import/Export

Import or Export SKU data via a tab-delimited text file.
Load SKU Equip Rates...

Import SKU related equipment rates via a tab-delimited text file.

Inventories Import/Export

Import or Export storage unit opening inventories via a tab-delimited text file.

Options Menu Item

This item has general options for scheduling.
Operation ( see page 287) Types
Define operation types ( see page 132) for charting and reporting.

Recipe/SKU Types
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Define recipe types ( see page 131) for use with the change-over matrix.
Operation ( see page 287) Report Text

Set or modify the Daily Activity Report template text (  see page 132).
Attention Codes

Define reporting attention codes (  see page 221) for operations.

Set Weekend Hours...

Set off hours ( see page 221) to display on the Equipment Occupancy Chart.
Set Currency...

Set the base and display currencies ( see page 178).

Plan Menu Item

Plan a Campaign

Plan a new campaign ( see page 222).

SKU Order Templates...

Create standard orders for scheduling ( see page 258).
Campaign Projects

Define projects for campaign grouping ( see page 233). Check “Show Campaign Projects” in the Edit/Preferences dialog.

Note: The "Load Campaigns from File..." feature is no longer supported in V8. The functionality is available in the MDB Link ( see
page 336) features.

Schedule Menu Item

The Schedule menu item contains entries for manipulating SchedulePro schedules. It provides quick links for planning campaigns
and batches. It provides the following entries:

Schedule All Campaigns

Schedule all planned campaigns ( see page 237). This action does not reschedule currently scheduled campaigns.
Reset Schedule

Delete all scheduled batches ( see page 237).

View all Conflicts

Display all the conflicts ( see page 238).

Resolve All Conflicts
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Resolve all conflicts ( see page 239) for the entire schedule.
Scheduler Timing

Set the scheduling horizon (  see page 220) and the current time.
Scheduling Options

Edit the options of the currently selected scheduling mode ( see page 215).
Scheduling Dependencies and Order

Manage campaign priorities and dependencies.

Edit Scheduling Modes

Manage the scheduling modes.

Schedule Evaluation...

Display information and statistics .

Economics...

View the overall economic information for the schedule.

View Menu Item

The View menu item contains entries for viewing scheduling results in various chart types. It provides the following entries:
Gantt Chart

Display a Gantt chart of the schedule.

Equipment Occupancy Chart

Equipment Occupancy Prdfile...

Display an equipment-oriented Gantt chart for the schedule.

Edit Equipment Chart Style...

Modify the display options before the chart is displayed.

Easy Print Charts

Gantt Chart (Printable)

Display the Gantt chart with limited interactivity and enhanced print options.

Equipment Occupancy Chart (Printable)

Display the Equipment Occupancy Chart (EOC) with limited interactivity and enhanced print options.
Equipment Time Utilization

Display an equipment time utilization bar chart for the schedule.

Resource Profiles

Display the following material consumption/production charts (rate as a function of time) for the schedule:
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Raw Materials

Products

Waste

Labor

Heating/Cooling Utilities

Power/Duty

Mobile Equipment Area

Inventory Profiles

Display inventory profiles for storage/equipment items.

Storage Inventory

Display the inventory of storage units with inventory tracking
Material Supply Inventory

Display the inventory of material supply systems with inventory tracking
Equipment Capacity ( Procedure ( see page 287) Based)
Display the utilization of multitasking equipment with sizing information.
Equipment Capacity (Material Based)

Display the inventory of equipment associated with storage units.
Toolbar

Toggle toolbar display.

Status bar

Toggle status bar display.

Refresh

Update the SchedulePro Navigation ( see page 17) View. The ctrl-r key has the same effect.

Reports Menu ltem

SchedulePro Main Menu

The Reports menu item contains entries for creating and viewing various SchedulePro report types. It provides the following entries:

Schedule Report

Create and view the detailed schedule report (operations included).
Equipment Occupancy Report

Create and view the equipment occupancy data.

Staff Occupancy Report

Create and view the staff data.
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Equipment Utilization Report

Create and view the equipment utilization report.
Materials Report

Create and view the materials report.

Daily Activity Report

Create and view the daily activity report.
Economic Report

Create and view the economic report.

Materials Orders and Receipts

Create and view the report for reordering materials for supply systems and/or input storage units. See chapter 6.

Inventory Report

Show periodic inventories for selected storage units.
Labor Report

Show Labor Usage

Gantt Graph

Create and view an HTML version of the Gantt Chart.
Equipment Occupancy Graph

Create and view the equipment occupancy graph.
Recipe Report

Create and view the recipe report.

Transfer Panels

Display the layout of transfer panels.

Export to VCalendar (Outlook...)

Export as an ICS file and optionally email to recipients
Report Options

Specify common and report-specific options.

Clipping Options

Limit chart or report data by time, campaign or batch.

Contents and Ordering

Select and order resources for reports and charts that display multiple resources, e.g. equipment.

Saved Options

Save the current clipping and reporting options in a named set.
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SQL Server Menu ltem

The SQL Sever menu has the following items:

Database Browser

Display SQL Server Database contents
Campaigns...

Display and manage stored campaigns
Facilities...

Display and manage stored facilities

SKUs...

Display and manage stored SKUs

Projects

Display and mange stored Projects

Timing Updates

Manage schedule updates from the database
Stream Updates

Manage material updates from the databse
Receipt Updates

Manage material receipts in the database
Apply All Updates

Apply all updates in the database

Export Schedule

Export all scheduled activities (campaigns, batches, etc.) to the database
Export Material Transactions

Export receipts and withdrawals in storage units
Export Document

Export all document data

Settings...

Set the SQL Server connection information

SchedulePro Main Menu
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Connectivity Menu Item

The Databanks menu item contains entries for manipulating the Recipes DB. It provides the following entries:
Recipe Data

Edit Location

Enter the location of the database and any other login information.
DB Search

Search the recipe database.

Export to MS Project XML file

Export to the MS Project XML format. Use with later versions of MS Project.
ERP Link

Configure Import/Export...

Configure the file interface.

Import...

Import campaign data from a text file.

Export...

Export campaign data to a text file.

MDB Link

Configure Import/Export...

Configure the Access interface.

Import Campaign Defaults

Set defaults for imported campaigns.

Import...

Import campaign data from a database file.

Export...

Export campaign data to a database file.

MDB Report

Register Database

Register the access database for reporting

Export Schedule to Report MDB...

Export the Schedule to MS Access for custom reporting
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Window Menu ltem

The Window menu item contains a list of all open SchedulePro windows. By clicking on an entry the corresponding window is
brought on top. A check mark appears in front of the currently active window.

Help Menu ltem

The Help menu item provides the following standard entries:
Help Topics

Launch SchedulePro online help facility.

About SchedulePro

View SchedulePro version information.

Interface Options

Physical Units Defaults

Use the “Edit?Physical Units Defaults...” item to set the default display units for various measurements. These defaults may be
overridden for specific items.
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For existing files, use the checkboxes to apply the new defaults to existing SchedulePro objects.

General Preferences

Use the “Edit?Preferences...” item in the main menu to set the following interface and display options for the project:
Show Recipe Branches in Tree - if selected, display recipe branch nodes.

Show Recipe Sections in Tree — if selected, display recipe section nodes.

Show Default Equipment - if selected, display default equipment with the procedure names in the tree.

Show Campaign Projects - if selected, the project level of campaign organization becomes available.

Default Time Display — Select calendar (absolute) time or relative time or both.

Report Viewer — Select the web browser used to view reports.

Autosave Settings — Set the auto backup and save settings.

Temporary Directory — A read/write location for temporary files. No user-readable data is saved here.

Default Schedule Start Hour — The default hour for the schedule start for new files. The default day is the day after the the current
date.

ScheduePro Units

SchedulePro Units

SchedulePro allows the following units

Unit Type Units Description
Time s second
min minute
h hour
day day
wk week
mo month
yr year
Mass mg milligram
g gram
kg kilogram
MT metric ton
oz (avdp) ounce (avoir du poids/standard)
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Volume

Density/Concentration

Discrete count

Power

Duty (heat transfer in
addition to power units)

Mass flow

Volume flow

SchedulePro

0z (troy)
Ib

ton
mm3
mL

cm3

L

m3

gal

ft3

kgal
bbl-beer
bbl-api
Mgal
yd3
g/cm3
g/L
Ib/ft3
Ib/in3
oz/gal
Ib/gal
mg/L
entities
Wattt
kw

MW
btu/h btu/s

kcalls kcal/h
HP
(kg,MT, Ib, ton)/(s, min, h)

troy ounce

pound

ton

cubic millimeter
milliliter

milliliter

liter

cubic meter

gallon

cubic foot

1000 gallons

brewers barrel
petroleum barrel
million gallons

cubic yard

grams per cubic centimeter
grams per liter

pound per cubic foot
pounds per cubic inch
standard ounces per gallon
pounds per gallon
milligrams per liter
count

watts

kilowatt

megawatt

BTU per time

kilocalories per time
horsepower

mass per time

(cm3,L,m3,gal,ft3)/(s,min,h) ' volume per time

Interface Options
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Tutorial

Learn by doing.

Tutorial Introduction

This document will guide you through the steps of creating a production schedule with SchedulePro. We will start with simple
concepts and incrementally introduce more advanced features and capabilities of the tool.

Through a step-by-step process that you can follow as you move along, you will learn how to:

« Declare a facility and its resources.

« Define a recipe with procedures and operations.

« Declare and schedule a campaign.

* Retrieve the scheduling results in the form of Gantt, equipment and resource utilization charts.

 Include facility and equipment downtimes and operation flexible time shifts, and investigate their effect on scheduling.
« Declare usage and generation of materials, and track their profiles and inventories.

« Identify and eliminate bottlenecks.

« Scale recipes and investigate their impact on equipment selection and duration of operations.

The tutorial will make use of a simplified version of a batch recipe for the production of a saline solution (for medical applications).
The recipe (process) as modeled in SuperPro Designer™ is shown below. The SuperPro case file (Saline-Solution-Recipe.spf) is
included in the tutorial directory.

The simplified recipe includes three procedures (processing steps): (a) preparing the solution in a mixing tank, (b) storing the
solution in a storage tank and (c) putting the solution in plastic bags using a filling machine.

The following table lists the operations that are included in each of the three procedures along with their duration and information on
their relative ordering. The saline solution is prepared from three basic ingredients: water-for-injection (WFI), Sodium Chloride, and
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SchedulePro

API-A (an Active Pharmaceutical Ingredient).

4 Tutorial

The recipe will be executed in a facility called “Medical Solutions Plant”. The facility is equipped with a mixing tank (MT-1), a storage
tank (ST-101) and a bag filler (Filler-1). Also, a clean-in-place skid (CIP-Skid-1) is available for cleaning the equipment.

Procedure (
see page 141)

P-1

Prepare
Solution

P-2

Store

70

Equipment (
see page 190)

MT-1

ST-101

Operation ( see page
145)

Charge Water

Charge Sodium Chloride

Charge API

Mix Thoroughly

Transfer to Storage Tank

30 min

Clean Tank

Receive from Mixing
Tank

Feed Filler

Clean Tank

Start Time Relation ( see page 152)

Batch ( see page 287) start

At the end of its previous operation

At the end of its previous operation

At the end of its previous operation

At the end of its previous operation

At the end of its previous operation

When “Transfer to Storage ..."” in P-1
starts

10 min after start of its previous operation

At the end of its previous operation

Duration ( see
page 148)

30 min

15 min

15 min

60 min

90 min

Equal to “Transfer to
Storage” in P-1

Equal to “Fill Bags”
in P-3

90 min
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Fill

SchedulePro Tutorial Structure
Filler-1 Fill Bags When “Feed Filler” in P-2 starts 320 min
Clean Filler At the end of its previous operation 90 min

Tutorial Structure

The tutorial is based on the following incremental structure. Each section is accompanied by a SchedulePro case file that you can
open and explore at any time (the names of the SchedulePro files are identical to the tutorial case names). You may also create the
same files on your own to solidify your understanding of the tool.

Tutorial-1a

Tutorial-1b

Tutorial-1c

Tutorial-2a

Tutorial-2b

Tutorial-3a

Tutorial-3b

Tutorial-4a

Creating and Scheduling a Simple Recipe

Demonstrates most basic features of SchedulePro. Provides a quick start guide for beginner users who wish to
schedule their first case and view scheduling results.

Considering the Impact of Equipment Pools
Demonstrates the impact of equipment pools on cycle time and plant throughput.

Scheduling with Flexible Shift Times
Demonstrates the use of flexible shift times and their impact on equipment utilization and make-span reduction.

Multiple Recipes and Equipment Routing
Explains how to clone recipes and deal with equipment routings.

Considering Changeover Times
Demonstrates the specification and usage of equipment changeovers.

Drag & Drop Manual Schedule Adjustments

Demonstrates how to manually adjust and improve schedules through the Equipment Occupancy chart by dragging
and dropping batches, procedures, and operations.

Representing Process Delays
Explains how to represent process delays and specify the state of the scheduled activities.

Resource Tracking

Demonstrates how to declare and track resource demand as a function of time. Resources include materials,
heating/cooling utilities, electrical power, and labor. It also explains how to use material tracking charts for sizing
supply units and storage tanks.
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Tutorial-4b | Inventory Tracking
Explains the role of storage units and the extra information required for tracking inventories of materials.

Tutorial-5 | Debottlenecking Production Lines ( see page 299)
Provides information on debottlenecking strategies that involve Flexible Shift times and Equipment Pools.

Tutorial-6 | Scheduling with Facility Downtimes

Provides information on how to specify facility and equipment downtimes and their impact on production
scheduling. It also explains how to make use of interruptible operations and flexible shift times for accommodating
facility outages.

Tutorial-7 | Scaling Batches

Explains how batches are scaled and the impact of batch size on equipment selection and calculation of operation
durations.

Tutorial-8 | Creating and Using SKUs

Describes the creation of Stock Keeping Units (SKUs) which may be used to represent different inputs,
intermediates, and products. This tutorial also explains how to assign Bills of Materials to an SKU, how to assign
SKUs to a recipe, and how to specify variable durations for a given operation based on which SKU it produces.

The Tutorials

Tutorial-1a: Creating and Scheduling a Simple Recipe

The introduction of a recipe in SchedulePro can be done in one of the following two ways:

1. If SuperPro Designer v7.0 or later is available, you can model the recipe in SuperPro, export it to the SchedulePro database,
and import it within a SchedulePro project.

2. Alternatively, you can create the recipe directly in SchedulePro.

Chapter 5 of this manual (Creating Recipes) describes in detail how to import a recipe into SchedulePro that was created in
SuperPro Designer. Please note that you may export the simple SuperPro recipe provided with this tutorial even if you do not own a
full license of SuperPro. To do so, simply visit our website (www.intelligen.com) to download the Evaluation version of SuperPro
and use that to open and export the simple recipe.

In this tutorial, however, we will use the second approach and describe in detail the steps that should be followed to create the
recipe directly in SchedulePro. To begin, open SchedulePro and use the main menu to open a new scheduling project (select “File
-> New..."). You are now ready to follow the steps described in this tutorial.
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Adding the Facility and its Resources

Recipes created in SchedulePro make use of facilities and their resources. Recipes, facilities and resources should all be part of the
same scheduling project. From a practical point of view, it is more convenient to declare the facility information first before the
declaration of the recipes, especially if both are to be entered directly in SchedulePro. This is because recipes make use of
resources declared in the facility.

The key data in SchedulePro are mapped to corresponding nodes in the project tree, which is displayed on the left side of the main
window. You can navigate the tree to find all the information you have entered in the project. The tree consists of four major data
categories: Recipes, Materials, Facilities and the Production Schedule.

Select the Facilities branch of the tree and click on the Add New Facility button ( ) in the facilities pane on the right side of the
window (see figure below). In the New Facility dialog that pops up enter the name of the facility (“Medical Solutions Plant”) and
optionally some descriptive information. Click OK.

Using the tree explorer on the left, navigate to the node representing the newly generated facility, select it and expand it to reveal its
contents. There are eight different categories of resources that every facility has (see figure below): Labor, Staff, Utilities,
Equipment, Work Areas, Transfer Panels, Storage units and Material Supply Systems. With the exception of Equipment, the
declaration of all other facility resources is optional.
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To declare the mixing tank (MT-1) in the facility, select the Equipment node in the tree (see figure below) and click on the Add New

Equipment button ( ) in the Equipment pane on the right side of the window. In the dialog that pops up provide the equipment
name (“MT-1") and optionally overwrite the Type by typing “Blending Tank” and provide descriptive information about the equipment
unit. Then click OK.

Repeat the above step three times to declare the storage tank ST-101 (type: “Receiver Tank”), the filler Filler-1 (type: “Filler”), and
the CIP skid CIP-Skid-1 (type: “CIP Skid"). If, after creation, you wish to view or edit the properties of the declared equipment, select
the Equipment node on the tree, select the specific equipment item in the equipment table (right side of the window) and click the

Edit Equipment button ( ) on the toolbar of the pane.

Creating the Recipe

Next, select the Recipes branch of the tree. To add a recipe, right-click on the Recipes node and select “Create New Recipe...” from

the pop-up menu, or simply click the Recipes node and then click on the Create New Recipe button ( ) in the Recipes panel on
the right-hand side of the window. In the dialog that pops-up, enter the name of the new recipe (“1L-Bag-Recipe”) and optionally
add a description for the recipe.
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Move to the Size tab of the dialog to specify the reference material (usually the main product of the recipe) and corresponding
batch-size (see figure below). SchedulePro utilizes this optional information for recipe scaling, equipment selection based on batch
size, and size-based operation duration calculations. Specify “Saline Solution” for reference material, Volume as the basis for
defining batch size and, finally, 10,000 L for batch size. With the above specifications, a nominal batch of this recipe is set to
produce 10,000 L of “Saline Solution”. It is not necessary to have a predefined material for the Reference Material, although if there
are materials defined, they will appear in the list.

Click OK to close the dialog. The new recipe will appear in the Recipes panel on the right hand side as shown in the figure below.
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The new recipe will also appear in the tree under the Recipes node. Select the node of the recipe on the tree to bring up the Recipe

View (see figure below). If further editing of the newly created recipe is needed, click on the Edit Recipe button ( ) at the top of
the panel. Other buttons in the same area of the dialog, allow the editing of the display color for the recipe, viewing of the recipe
Gantt chart etc. We will visit these options later.

Towards the bottom of the panel, there is a table where the recipe procedures (processing steps) are declared. Click the Add New

Procedure ( see page 287) button ( ) above the table to add a procedure to the recipe. Accept the default name (P-1)
generated for the procedure. The new procedure P-1 will appear in the procedures table and also in the left-hand side tree under
the “1-L-Bag-Recipe” node, as shown in the figure below. Note that a “Main Section” node may appear between the recipe and the
procedure node. In SchedulePro, sections correspond to a hierarchical level below the “recipe” level but above the “procedure”
level. They allow you to group procedures that serve a common processing objective (e.g., purification) or share a common
resource (e.g., a suite). In this simple tutorial example, there is no need to define sections. Therefore in the displays shown here,
we have chosen to hide the section information (you can do the same by clicking “Edit -> Preferences...” from the main menu, and
un-checking the “Show Recipe Sections in Tree” option within the Display Preferences dialog).

Next, select the P-1 procedure node in the tree on the left to bring up its view on the right (see figure below). By default, each new
procedure is assigned a single operation named op-1, with a cycle time of 60 minutes. These settings will be modified later.
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With the recipe sections turned off, click on the 1-L-Bag-Recipe node again in order to return to the procedure view. Then select

procedure P-1 in the pane on the right and click the Edit Procedure ( see page 287) Procedure ( see page 287) Data ( )
button. The procedure properties dialog will appear; enter “Prepare Solution” as the description of that step. Select the Main
Equipment Pool tab to declare the equipment used to execute this procedure (see figure below). Select MT-1 in “Medical Solutions
Plant” and click on the Add ( ) button to bring MT-1 into the “Equipment in Pool” list on the right (see figure below). Click OK.
Notice that MT-1 is now associated with the Prepare Solution procedure in the tree on the left.

We will now concentrate on the bottom half of the procedure view where the contained operations are displayed. Select the name of

the default “op-1" operation and click on the Edit Operation ( see page 287) button ( ). That brings up the dialog that is shown
below. Change the default name to “Charge Water” to represent the first operation of the solution preparation procedure.
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Next visit the Duration tab to set the duration to 30 min. Visit the Scheduling tab and notice that this tab already displays the correct
start time reference (i.e., the start time of this operation coincides with the batch start). Click OK to exit the operation dialog.

At this point, we will ignore consumption of materials and labor associated with the execution of operations. Instead we will
concentrate on scheduling-related issues, i.e. the duration of operations and the sequencing of their start times. Later, we will see
how resource-related information can be entered through the other tabs of the operation properties dialog.

Two values define the timing of operations in SchedulePro: the start time and the duration. The start-time may be relative to the
batch-start or to the start or end of another operation. The duration may be either fixed, calculated based on batch size and
processing rate, or, set equal to the duration of another operation or sequence of operations (other advanced options not
considered in the Tutorial, include the association of an operation’s duration with the level of some material inventory or its
calculation based on a changeover matrix.)

Due to the inter-dependent nature of operation scheduling, it is usually easier to first declare all procedures and operations in the
recipe and then visit each operation’s properties dialog to declare the scheduling details.

In P-1 we need to add five more operations: “Charge Sodium Chloride”, "Charge API”, "Mix Thoroughly”, "Transfer to Storage”, and

“Clean Tank”. To add a new operation, click on the Add New Operation ( see page 287) button ( ) on the toolbar above the
Operation ( see page 287) Sequence table (right side pane of procedure view). Then provide a name for the new operation and
click OK. The new operation will appear in the list of operations belonging to the edited procedure. Select the second operation
(“Charge Sodium Chloride”) in P-1 and, as before, visit its properties dialog to enter its duration and start time option. Its duration
will be fixed at 15 min and its start time will be set, by default, at the end of the previous operation (“Charge Water”). The default
start option is also the desired specification in this case, so there is no need to make any change on the Scheduling tab.

Follow the same steps for generating two more procedures and their operations. At the end, the recipe skeleton should contain the
following information:
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Procedure | Description
( see

page 287)

P-1 Prepare
Solution

P-2 Store

P-3 Fill

Equipment

MT-1

ST-101

Filler-1

SchedulePro

Operation ( see page 287) (duration)

Charge Water (30 min)

Charge Sodium Chloride (15 min)
Charge API (15 min)

Mix Thoroughly (60 min)

Transfer to Storage (30 min)
Clean Tank (90 min)

Receive from Mix Tank (set by Transfer to Storage)
Feed Filler (set by Fill Bags)
Clean Tank (90 min)

Fill Bags (320 min)
Clean Filler (90 min)

The Tutorials

For most operations, the duration should be explicitly set to the values shown in the table above. The only exceptions are the
“P-2/Receive from Mix Tank” and “P-2/Feed Filler” operations whose duration needs to be set equal to “P-1/Transfer to Storage”

and “P-3/Fill Bags”, respectively.

The figure below explains how this is done through the Duration tab of an operation’s dialog. In this case, the duration of “Receive
from Mixing Tank” in P-2 is set equal to the duration of “Transfer to Storage” in P-1. This is equivalent to the “master-slave
relationship” in SuperPro Designer: the operation “Receive from Mix Tank” in P-2 becomes a “slave” of the operation “Transfer to
Storage” in P-1 as far as its duration is concerned.

The duration of an operation can also be ‘slave’ to the duration of a sequence of operations (instead of a single one), tied to the
inventory level of some material storage unit (operation ends when some material inventory is above or below a certain level) or
determined through a predefined changeover matrix based on the operation that precedes or follows the edited operation. The use
of these advanced duration options is demonstrated in the case studies installed in the Examples folder in the SchedulePro

installation path.
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With respect to scheduling of operations, the first operation in every procedure is by default scheduled to start at the batch start and
every subsequent operation is scheduled to start at the end of its previous operation in the procedure sequence. The Scheduling
tab offers additional options that allow us to relate the start or end of an operation with the start or end of other operations in the
same or other procedures.

In our example, the following changes need to be made in the default scheduling:

The “Receive from Mix Tank” operation in P-2 should start at the same time as the “Transfer to Storage” operation in P-1 (see figure
below). Similarly, the “Fill Bags” operation in P-3 should start at the beginning of the “Feed Filler” operation in P-2. The “Clean Filler”
operation in P-3 should also be set to begin at the same time as the “Clean Tank” operation in P-2 since these units are always
cleaned together.

80



4 Tutorial SchedulePro The Tutorials

Operations can also claim auxiliary equipment for their execution. Main equipment is assigned to procedures and auxiliary
equipment is assigned to operations. For instance, a CIP-skid utilized for vessel cleaning is auxiliary equipment associated with the
cleaning operation. Auxiliary equipment is assigned to operations through the Auxiliary Equipment tab.

The figure below shows the assignment of CIP-Skid-1 to “Clean Tank” in P-1. If several CIP skids are assigned to an operation,
then, the scheduling algorithm will select the first one that is available (searching from top to bottom). Next, assign the same CIP
skid to “Clean Tank” in P-2. Do not assign a CIP skid to “Clean Filler". We assume that Filler-1 will be cleaned at the same time as
ST-101 utilizing the same skid.
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Note that declaring auxiliary equipment and other operation resources is optional. The only mandatory operation information that
SchedulePro needs is the operation duration and start time specification.

Once a recipe has been defined, it can be visualized with a Gantt chart that can be brought up by right-clicking on the recipe node
in the left-hand-side tree and selecting the menu option “Recipe Gantt Chart...” or by clicking on the View Recipe Gantt Chart
button () on the right-hand side recipe panel displayed when the relevant recipe is selected. The figure below corresponds to the
“1L-Bag-Recipe” that we created. Note that, in accordance with the above specifications, “Transfer to Storage” in P-1 and “Receive
from Mix Tank” in P-2 operate in parallel and have the same duration. The same is true for “Feed Filler” in P-2 and “Fill Bags” in P-3.

A recipe Gantt chart cannot be displayed unless the recipe is declared in a complete and self-consistent way. If this is not the case,
a Recipe Incomplete button will appear in the recipe view; by clicking on that button a message with more detailed information on
the recipe status will appear. Make sure that all recipes are fully declared before scheduling production campaigns based on those
recipes.
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The recipe may also be displayed as a block diagram (see below) by clicking the View Recipe Block Diagram button

. Each
block represents a procedure. Material streams (if any) are shown in black, and scheduling links are shown in blue.

Planning and Scheduling Campaigns

After declaring recipes and facilities, we are ready to declare campaigns which represent a series of batches of a given recipe. In
SchedulePro, each scheduled batch represents the realization of a recipe at a given time and with the use of specific equipment
and resources. Unless otherwise stated by the user, the only constraint that SchedulePro takes into account in generating a
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schedule is the availability of equipment and facilities. To define a production schedule, first select the Production Schedule branch

on the project tree. On the right-hand side production view, click on the clock button (under the Scheduler Settings header) to
specify the start of the schedule. On the dialog that pops up, set the Start Date and Time for the schedule at 3/26/2016 and 8am
(obviously you can set the schedule start at any date and time you wish; however, using the above values guarantees that the
results you will get if you follow the tutorial steps will be consistent with the ones shown in this tutorial.) To plan a campaign, click on

the Add New Campaign button ( ) in the Campaign Sequence pane of the Production Schedule view. That brings up the
Campaign Setup dialog (see figure below).

There are several tabs in the Campaign Setup dialog. In the ID/Amount tab you can set the campaign name, the associated recipe,
and the number of batches. If a reference batch size has been specified for the recipe, the number of batches and the scale factor
indirectly determine the order amount (i.e. amount of product produced by the entire campaign.) Alternatively, you can specify
directly the order amount and let SchedulePro calculate the required number of batches. Set the number of batches to 4 and click
on the Recalculate button to refresh the order amount.

In the Time/Sequencing tab (shown below) you can set the Campaign Start Mode. In other words, you can specify whether the
campaign is to start immediately on the specified release date, or after the start/end of another campaign, etc. This case is
scheduled with the Release Date option.
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In the Options tab (shown below) you can specify the Batch ( see page 287) Start Options ( see page 271). By default the batches
of a campaign are scheduled based on the minimum cycle time of the recipe (determined by the scheduling bottleneck equipment).
Alternatively, you have the option to specify another (larger) cycle time or a slack time (i.e., idle time between consecutive batches
for the time bottleneck equipment).

In this tab you can also specify the order by which pooled resources are used to resolve conflicts. The default “By Priority List”
option means that the alternatives are considered in the order they appear in the equipment pool and the first available is used; the
“By Earliest Availability” option means that the available resources are sorted in terms of time availability and the equipment unit in
the pool which becomes available earliest is given precedence; the “By Rotation” option selects the equipment that is next in the list
after the one which was used most recently. Accept the default specifications on this tab and click OK.
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With the campaign definition complete, you are now ready to generate a production schedule. Click on the Schedule Campaigns

button ( ) of the main toolbar. SchedulePro will use the provided information on the campaign and the recipes and attempt to
generate a schedule that will satisfy all constraints. When calculations are done, the Production Schedule window should look as
follows:
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The Production Schedule window displays the scheduled campaigns and batches, along with their start and end times and
information on possible conflicts encountered while creating the schedule. Under the Production Schedule branch of the project
tree, scheduling information for every campaign, batch, procedure and operation may be hierarchically displayed. Each batch is
identified by a unique name which is a combination of the associated campaign name and an integer ID.

Visualizing the Production Schedule

In addition to the project tree, scheduling results can also be visualized in graphs accessed through the main toolbar. Press the
button (or, from the main menu, select the menu option “View -> Equipment Occupancy Chart -> Equipment Occupancy

Profile...”) to display the equipment occupancy chart shown below. To view the full chart, you can click the Fit to Window
button. The legend on the right designates batches by distinct colors. This is the default color-coding option. The top line
corresponds to CIP-Skid-1. Notice how its use is displayed. The first yellow bar corresponds to the cleaning of the mixing tank
(MT-1). The second yellow bar corresponds to the simultaneous cleaning of the storage tank (ST-101) and the filler (Filler-1). The
storage tank (ST-101) is the overall bottleneck (has the longest cycle time). However, the utilization of the filler is pretty close to that
of the storage tank.

The style of the chart can be modified by right-clicking on it (in an open area) and selecting “Edit Style”. Details on style editing can
be found in Chapter 8 of this manual. Chapter 8 also explains how to print and copy the chart. In the Equipment Occupancy Chart
Style dialog, go to the Time Scale tab and set the Major Units (units of major axis) to “day” instead of “h”. After clicking OK on the
dialog, click “Yes” when prompted to propagate the time style changes to all charts. Your equipment occupancy chart should now
look as shown below. If you wish to change the color used for a batch, double click on the name of that batch in the chart Legend
and pick a different color from the palette that pops up.

Close the Equipment occupancy Chart and, from the main toolbar, click on (or, from the main menu, select the menu option
“View/Equipment ?Gantt Chart...”) SchedulePro generates an Operations Gantt chart (similar to the recipe Gantt chart that we saw
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earlier) where all scheduled activities are shown both in a hierarchical tree as well as in a bar graph. That chart also can be

exported to MS Project.

Again from the main toolbar, select the menu option “View?Equipment Time Utilization...” to visualize the percent time utilization of

each equipment item during the campaign (see figure below). The storage tank (ST-101) with the longest time utilization is identified
as the most likely bottleneck.

Tutorial-1b: Impact of Equipment Pools

In this version of the tutorial we will investigate the impact of equipment pools on cycle times. This example case is based on the

following equipment configuration. Three identical equipment items are available for each procedure as shown in the following
sketch:
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The extra equipment items can be quickly added through the Equipment view (see figure below) displayed when you select the
Equipment node on the tree. To add a new equipment which is identical to one of the existing, simply select the existing, click on

the Copy Equipment button ( ) and then click on the Paste Equipment button ( ). Then select the new equipment and click

on the Edit Equipment button ( ) to change its name and optionally other properties.

Next, reset the production schedule by clicking the Reset Schedule button ( ).When prompted, click Yes to clear all batches.
This allows you to make modifications to your recipes and subsequently schedule the new (modified) recipes. After your production
schedule is reset, make the new equipment items available to the appropriate procedures within your recipe. For instance, select
P-1 and click the Edit... button in the procedure view to bring up the Procedure ( see page 287) Details dialog shown below. Add
MT-2 and MT-3 to the equipment pool utilized by P-1. Next, assign ST-102 and ST-103 to P-2 and Filler-2 & Filler-3 to P-3. When a
pool of equipment items are available to a procedure, the procedure node in the tree displays the full name of the equipment at the
top followed by a comma and three dots that denote availability of multiple equipment items.
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Next, plan and schedule a campaign of six batches. To do this, you may edit the original campaign to increase the number of
batches to 6 (keep a Slack Time of 0.00 hours on the Options tab). Then schedule the campaign using the Schedule All Campaigns

button, and bring up the Equipment Occupancy chart by clicking its button on the main toolbar. The updated chart is shown
below. Notice that batches alternate between the various mix tanks, storage tanks, and fillers. This reduces the cycle time of the
process and increases the plant throughput. However, the added equipment cannot be fully utilized because now the bottleneck is
the CIP-Skid. Note that the order of the equipment has been modified in the Equipment Occupancy Chart below so that similar
equipment units are grouped together. This was done by right-clicking an open area of the chart, selecting Edit Contents/Ordering,
clicking the Equipment Ordering tab, and using the buttons at the top of the tab to re-order the items.
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Tutorial-1c: Scheduling with Flexible Shifts

The performance of the previous case can be improved (i.e., the total time or make-span of the campaign can be reduced) by
introducing some flexibility in the scheduling of the cleaning operations that utilize the single CIP skid (which is the current
bottleneck). Before you make changes to your recipe, be sure to reset the production schedule by clicking the Reset Schedule

button ( ).When prompted, click Yes to clear all batches.

Scheduling flexibility can be introduced through the Scheduling tab of an Operation ( see page 287)’s dialog (see figure below) by
making use of the flexible shift variable. Flexible Shifts are maximum permissible delays in the start of an operation’s execution;
used properly, they can help reduce idle times of key equipment units and/or eliminate scheduling conflicts.
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To bring up the dialog of “Clean Tank in P-1", select the node of P-1, select operation “Clean Tank”, and click on the Edit Operation

( see page 287) button ( ). Then, switch to the Scheduling tab of the operation’s dialog, check the Use Flexible Shift box,
specify a value of 8 h, and also check the Operation ( see page 287) Can Shift or Break for: Equipment Availability check box.
Click OK to close the dialog.

Specify a similar Flexible Shift for “Clean Tank” in P-2. There is no need for the specification of flexible shift in P-3, as the cleaning
operation of P-3 takes place simultaneously with the cleaning operation in P-2 and it is using the same CIP skid item.Next, plan and
schedule a campaign of six batches. Make sure that on the Campaign Setup dialog and the Options tab you select the Set Slack

Time option and specify a slack time of 0 h. Then bring up the Equipment Occupancy chart by clicking on on the main toolbar
(the chart is shown below).
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The use of flexible time shifts in cleaning operations has reduced the idle time between batches as well as the make-span of the
entire campaign (total make-span dropped from over 30 hrs in Tutorial case 1b to roughly 25 hrs in this case.)

Tutorial-2a: Multiple Recipes and Equipment Routing

In this version of the tutorial you will learn how to make a copy of a recipe, generate production schedules that involve multiple
recipes, and deal with equipment routing issues. Since we will be modifying our current recipe and then re-scheduling production,

be sure to reset the production schedule by clicking the Reset Schedule button ( ) now. When prompted, click Yes to clear all
batches.

This example case is based on the following equipment configuration. Filler-1 and Filler-2 handle the filling of 1-L bags, whereas
Filler-3 handles the filling of 0.5-L bags. The filling rates are different as well; filling the 0.5-L size takes twice as much time for the
same overall recipe batch size of 10,000 L. Fillers-1 and Filler-2 are fed by storage tanks ST-101 and ST-102, whereas Filler-3 is
fed by tank ST-103 only.
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A new recipe is required to represent the manufacturing of 0.5 L bags. Since the manufacturing of 0.5 L bags is quite similar to the
1 L bags, we can save time by copying and modifying the existing recipe. Switch to the Recipes view by selecting the Recipes

branch in the tree. Select the current recipe, click on the Copy Recipe button ( ) and then click on the Paste Recipe button

( ). Then select the new recipe and click the Edit Recipe button ( ) to change its name to “0.5L-Bag-Recipe”.

Next remove ST-103 and Filler-3 from the 1L recipe and assign ST-103 to P-2 and Filler-3 to P-3 of the 0.5L-Bag recipe. Please
note that ST-101 and ST-102 must be removed from P-2 of the 0.5L-Bag recipe since only ST-103 is available for storing batches
that are filled in 0.5 L bags. Similarly, Filler-1 and Filler-2 must be removed from P-3 of the 0.5L-Bag recipe. The duration of the
filling operation in the previous versions of the tutorial was specified by the user. The value of that variable, however, can also be
calculated based on the batch size and the processing rates of the fillers. To specify the processing rate of Filler-1, select the
Equipment node in the tree, then select “Filler-1” in the Equipment table (right side of Equipment view), click on the Edit Equipment

button ( ), and switch to the Size tab (see figure below). Check the box titled Imposes limit on processing rate and specify a
Nominal Rate of 30 entities/min, a Maximum Rate of 40 entities/min and a Minimum Rate of 10 entities/min. In other words, Filler-1
under normal conditions fills 30 1-L bags per min but that rate can vary from 10 to 40 entities/min. Specify the same information for
Filler-2 and Filler-3.

Next, visit the “Fill Bags” operation in P-3 of the 1L-Bag recipe, move to the Duration tab, zero the Constant component of the
Duration variable, check the Rate-based term box and click on the Setup... button to launch the Rate Parameters dialog shown
below.

On the Rate Parameters dialog, set the Rate Basis as “Entities Flow” (entities represent bags in this case) and specify the
appropriate amount. In this case enter 10,000 entities since the batch size is 10,000 L and we use 1 L bags. The processing rate is
either specified by the user or retrieved from the equipment utilized for this step. Select the latter option in this case. This way, if the
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main equipment pool for filling in P-3 contains more than one equipment items of different processing rates, the rate will be updated
automatically at run-time based on the selected main equipment item.

Repeat the same steps for “Fill Bags” in P-3 of “0.5L-Bag-Recipe”, but specify 20,000 entities for amount processed since we use
0.5 L bags to fill the same amount of bulk material (10,000 L).

Please note that one could use a similar approach for calculating the durations of the charge and transfer operations by specifying
appropriate amounts and processing (pumping) rates.

Next, plan two campaigns, 4 batches of the 0.5L-Bag recipe followed by 8 batches of the 1L-Bag recipe and schedule. The
Equipment Occupancy profile for this case is shown below. The legend on the right designates campaigns by distinct colors. You
can customize the appearance of the Equipment Occupancy chart by right-clicking on it (in an empty area, not on a procedure bar)
and selecting Edit Style from the popup menu. The dialog allows you to select the coloring scheme of your preference (Color by
campaign in this case).

Notice how CIP-Skid-1 is the main equipment bottleneck for the 1L-Bag campaign, whereas storage tank ST-3 is the bottleneck for
the 0.5L-Bag campaign. Also, notice the wait times (white spaces within procedure bars) that the scheduling algorithm has
generated using the flexible shift times of the cleaning operations in order to reduce the make-span of the two campaigns.
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Tutorial-2b: Considering Changeover Times

This tutorial demonstrates handling of equipment changeovers in SchedulePro. Delays due to changeover times are common in
multi-product manufacturing facilities and occur particularly often in packaging/filling processing steps. For instance, they may
account for the time required to adjust a filling machine for handling a container of a different size. Since we will be modifying our
current recipe and then re-scheduling production, be sure to reset the production schedule by clicking the Reset Schedule button

( ) now. When prompted, click Yes to clear all batches.

Copy the 1L-Bag recipe and create another recipe (called 2L-Bag-Recipe) to represent manufacturing of 2L bags. The previous
section of the tutorial explains how to create a new recipe by copying an existing one. Change the display color for the 2L-Bag
recipe to maroon. Also, assume that the 2L-Bag recipe utilizes exactly the same equipment as the 1L-Bag recipe. However, you will
still need to visit the Duration tab and Rate Parameters dialog (as shown in Tutorial-2a) of the “Fill Bags” operation in P-3 of the
2L-Bag recipe to change the batch amount to 5000 entities (corresponding to 10,000 L filled in 2-L bags). We are assuming that the
filling time is not a function of bag size. If that is not the case, a fraction of the nominal capacity can be specified (by changing the
“Use x % of the Nominal Rate” variable).

Changeover times can be specified at the campaign or equipment level. In this case we will make use of equipment-specific
changeover times for Filler-1 and Filler-2. To do so, first launch the Equipment Properties dialog of Filler-1 (see figure below) by

selecting Filler-1 in the table of the Equipment view and clicking on the Edit Equipment button ( ). Visit the
Cleanout/Changeover tab (shown below) and specify a 2-h changeover time in the Changeover Time field. The durations of
pre-processing or post-processing cleanings or changeovers can be specified in this tab either as fixed (nominal) values or through
changeover matrices; in this latter case, the changeover duration is variable and depends on the sequence of executed tasks. In
this example, we will use the simplest (nominal) option.

Repeat the same specification of 2 h changeover for Filler-2. There is no need to specify a changeover time for Filler-3 since it is
dedicated to 0.5L bags.
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Changeover times are applied at the campaign level. You can select any campaign and click on the Edit Campaign button to
bring up the Campaign Setup dialog.

On the Campaign Setup dialog of the 1L-Bag recipe, select the Advanced tab (see figure below) to view the Advanced Campaign
Sequencing options. Cleaning or changeover times can be specified either at the start (“Pre-production Options’) or the end
(“Post-production Options”) of a campaign. Here, you will have to define some post-production changeover time. Activate the
Include box for Equipment Changeover and select the Run at Last Equipment Use option. Then click the Setup button for the
Equipment Changeover section (see dialog below). If the Fixed Changeover Time option is selected, the same changeover time will
be applied to all equipment utilized by that campaign. Instead of using a fixed changeover time, select the Based on Equipment
Changeover option. With the above specifications, an equipment-dependent changeover time will be applied to all equipment as
soon as they are done executing the last task related to this campaign.
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Next, reset the production schedule by clicking the Reset Schedule button ( ).When prompted, click Yes to clear all batches.
Then plan and schedule a campaign of 4 batches of the 0.5L-Bag recipe, followed by a campaign of 8 batches of the 1L-Bag recipe,
followed by a campaign of 4 batches of the 2L-Bag recipe. Changeover times should be applied to the second campaign (8 batches
of the 1L-Bag recipe) because at the end of that campaign Filler-1 and Filler-2 must be adjusted to handle 2L bags. There is no
need to apply changeover times to the first campaign because Filler-3 is dedicated to 0.5L bags.

The results of the production schedule are shown below. The changeover times for Filler-1 and Filler-2 at the end of the second
campaign are represented by the light orange bars (circled in red for emphasis). Note that only Filler-1 and Filler-2 have
changeover bars, because the nominal changeover duration for all other equipment is zero.
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Tutorial-3a: Drag & Drop Schedule Adjustments

SchedulePro provides drag & drop functionality on the Equipment Occupancy charts. Operations, procedures, and even whole
batches can be dragged and dropped to facilitate manual schedule adjustments. The type of scheduled item to be moved manually
on the Equipment Occupancy chart can be specified on the Equipment Occupancy chart toolbar (see figure below). The drag-drop
type selection may also be made from the chart’s Edit Style dialog.

The following Equipment Occupancy chart corresponds to the case of Tutorial-2b but without Flexible Shift times in the 2L-Bag
recipe. Under these conditions, the scheduling algorithm delays the start of the second batch of the 2L-Bag recipe to avoid conflicts
with the use of the single CIP skid and that leads to an increased make-span of the campaign.

An improved solution can be found manually by dragging the second batch of the 2L-Bag-Recipe (blue bars) to the left. First, make
sure that you have selected the “Batch ( see page 287)” Drag/Drop mode (see figure above), then drag the batch to the left
approximately at the position indicated by the grey rectangle above.

When you drop the dragged batch at its new location, SchedulePro will display the new conflicts. The conflicts are with CIP-Skid-1.
The conflicts can be resolved manually be delaying the cleaning. Switch to drag-drop “Operation ( see page 287)" mode and move
the conflicted CIP operations to right to delay them as indicated by the red arrows below.
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The figure below displays the improved start time for the second batch of the 2L-Bag campaign. The start times of the other batches
in this campaign could be improved in a similar manner.

Tutorial-3b: Representing Process Delays

For this example, start with results from Tutorial 3a, and click on the Reset Schedule ( ) button in the main toolbar. Answer Yes
to allow SchedulePro to completely reset the schedule. At this point, all user modifications on the schedule (such as setting the start

of scheduled tasks through drag/drop) are lost. Then reschedule by pressing the Schedule Campaigns button ( ).

In manufacturing environments the execution of certain operations may be delayed due to equipment failures and other unexpected
events. Such delays may lead to scheduling conflicts with future activities. SchedulePro allows you to follow the schedule in real
time and modify scheduled activities to represent process delays and other deviations from the original production schedule. In this
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context, it is useful to use the concept of current time to distinguish between past and future activities. Scheduled activities can be
modified through the navigation tree (under the Production Schedule section and its associated views) as well as through the Gantt
and Equipment Occupancy Charts. In this tutorial the latter will be demonstrated. To track and update the schedule, first open the
Equipment Occupancy Chart and then click the Edit Schedule Timing button  on the Equipment Occupancy Chart’s toolbar. Then
check-on the Set Current Time flag in the Current Time tab. Set the current time to a specific day and time that is within your
production schedule (in this case, the Current Time was set to 3/27/16 at 8:00 am, which is 1 day after the Release Date for the
campaigns). Then click OK to exit the dialog. A red line representing the current time will appear on the equipment occupancy chart.
The slider bar on top of the line allows you to change the current time by dragging the slider.

The current time line results in the division of operation in three categories: completed (indicated by a crossed hatch pattern),
in-progress (diagonal hatch) and not-started (filled pattern). The classification of operations is automatically updated if the current
time is changed. The use of current time facilitates the monitoring of the production progress. Completed batches and campaigns
can be deleted from the schedule through the right-click context menu. In this way, only the relevant campaigns and batches are
part of the production schedule at all times.

For any scheduled operation but especially for those that have started and are in-progress, it makes sense to be able to change its
duration or end time if its actual execution diverted from planning. To view this feature, let's pick operation “Feed Filler” of the third
batch of the 0.5L-Bag campaign executed in ST-103. Under the above current time setting, this operation is classified as being
in-progress. Right click on the bar corresponding to this operation and select “Operation ( see page 287)?Properties...” The dialog
that pops up shows the identity of this scheduled operation (the recipe operation it corresponds to, its scheduling and duration links
etc.) as well as its scheduling information (start time, duration, end time, breaks etc.) This latter information can be changed to
represent scheduling diversions. To practice that, change the duration of this operation to 16 hrs (to represent a process delay) and
click OK.
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The delay in that operation obviously creates conflicts with future operations that were planned based on the nominal duration of
that operation. As indicated above, SchedulePro will display the conflicts but will not automatically attempt to resolve them. You
can either try to manually resolve the conflicts using the drag and drop functionality (demonstrated in Tutorial 3a) or you can
engage SchedulePro to do that. To do the latter you must right-click on the conflicting entity and use the context menu options or
use the Resolve Conflicts button on the chart toolbar. Note that when there is a conflict between two batches, it is in the latter in
hierarchy (and, in time) batch that the conflict is assigned to. Also note that conflict resolution can be performed in a stepwise
fashion with the user controlling the extent to which SchedulePro will resolve the scheduling conflicts. So, if you right-click on a
conflicting entity, the menu that pops-up shows options to resolve conflicts for the corresponding operation, procedure, batch,
campaign or for the entire schedule. For better control of the schedule and to avoid big changes, make sure that you resolve
conflicts at a local level (e.g. a single batch) and proceed gradually until all conflicts are resolved.
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In this example, we will use a non-conservative approach and try to resolve multiple conflicts simultaneously. To accomplish this,
click on the Resolve Conflicts button on the chart toolbar (circled in red on the chart above) and select “Resolve All Conflicts.” The
new schedule follows. As expected, subsequent batches had to be delayed to resolve the conflicts introduced by the longer
duration of the “Feed Filler” operation.

Tutorial-4a: Resource Tracking

Before modifying the recipes in this file, click on the Reset Schedule ( ) button in the main toolbar. Answer Yes to allow
SchedulePro to completely reset the schedule.

SchedulePro keeps track of the demand for materials (consumption and generation) as well as the demand for heating/cooling
utilities, electrical power, and labor.

Materials whose consumption (or generation) is to be tracked by SchedulePro must first be registered with the project. SuperPro
recipes exported to SchedulePro carry over the registered component and stock mixture information within SchedulePro. In our
example, we will need to declare the following materials with their corresponding types:

Material

WFI

Sodium Chloride

Type

Pure component

Pure component

API-A Pure component
1L-Bag Discrete
2L-Bag Discrete
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0.5L-Bag Discrete

To enter the first material, select the Materials node in the tree. Click the Add New Material button ( ) to launch the Material
Properties dialog (see figure below).

Type the material name “WFI” and select the default material type (Bulk / Pure Component). Repeat the above process for “Sodium
Chloride”, “API-A”, “1L-Bag”, “2L-Bag”, and “0.5L-Bag”. Please note that the bags must be specified as discrete materials (objects).
If a material is specified as a Stock Mixture (e.g., 10% w/w Sodium Chloride solution in WFI), you must also specify its composition
(by clicking on the Composition button) so that SchedulePro can track the demand of its constituents. Raw material consumption is
linked to recipes via input streams. Input streams are specified at the Operation ( see page 287) level. Now select the “Charge

Water” operation in P-1 of the 1L-Bag recipe, launch its properties by clicking on the Edit Operation ( see page 287) button,
and switch to the Material Inputs tab.

Click on the Add ( ) button to launch the Stream Information dialog (shown below.) Specify the name of the stream (e.g.,
“Water Charge”), its amount (10,000 L), and its composition (WFI 100%). These specifications simply mean that a batch of this
recipe requires 10,000 L of WFI to be supplied during the “Charge Water” operation of P-1. Instead of specifying an amount, one
could specify the flowrate by which the material in this stream gets consumed. In this case, the total amount used by the operation
will be calculated by the product of the flowrate times the operation duration. In either case (Specify Amount or Specify Flowrate)
the corresponding quantity can be declared as scaleable with batch size using the relevant flag in the dialog. Also note that since
the amount in this case has been defined in volumetric terms, the stream density in the bottom of the dialog should be specified so
that SchedulePro can convert volume to mass (if needed). Click OK (twice) to return to the Operation ( see page 287) Sequence
table.
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Next associate input streams with the “Charge Sodium Chloride” and “Charge API” operations to represent supply of 90 kg of
Sodium Chloride and 1 kg of API-A per batch, respectively. Repeat the above for the other two recipes (2L-Bag and 0.5L-Bag).

If you also wish to track the generation of 1L-Bags, you may associate an output stream with the “Fill Bags” operation of P-3
(1L-Bag recipe) and specify a production of 10,000 entities (i.e., bags) per batch. The type of this stream must be “Discrete”
because it represents flow of discrete entities (1L bags).

Please note that SchedulePro does not attempt to close material balances the way SuperPro Designer does. It simply keeps track
of input and output flows without balancing them.

Now schedule a campaign with 8 batches of the 1L-bag recipe.

SchedulePro generates graphs that display the consumption of raw (input) materials and the generation of products and wastes. To
visualize the profile of a material resource, select from the main menu “View?Resource Profiles?Raw Materials...” if you wish to see
input material consumption; similar options exist for products or wastes generated by the scheduled processes. The dialog that
pops-up (see figure below) allows you to select the material resource to be plotted.
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The following graph shows the raw material profile for WFI. The red line denotes instantaneous demand in mass flow units (kg/hr).
The blue line denotes time-averaged demand (kg/hr) for sequential 8-hour periods. The time averaging period can be modified by
right-clicking on the chart and selecting “Edit Style” from the popup menu. Finally, the green line (that corresponds to the y-axis on
the right side) denotes cumulative demand in mass units (kg) over the entire period. Also notice that the x-axis now displays
calendar time and not relative time as before. You can make this change by opening the dialog that comes up if you select “Edit
Style” from the pop-up menu, visiting the Time Scale tab and selecting the Absolute (Calendar-based) option.
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SchedulePro keeps tracks of the demand for heating/cooling utilities and electrical power in a similar way. Those resources must be
first declared under a facility before they can be utilized by operations of recipes. For utilities and electrical power the user may also
specify a limit on the supply rate, which can be used to visualize violations of supply. The user may also associate a “Material” with
a heating/cooling utility to capture the contribution of that utility to material consumption. For instance, you may specify that 1 kg of
clean steam requires 1.1 kg of WFI for its generation. Then, the demand for WFI may (optionally) also include the amount of WFI
utilized for Clean steam generation (this is activated by checking the Include utilities that contain material(s) in their composition box
on the Select Raw Material Resource dialog shown above). Labor resources can also be declared at the facility level and used by

recipes. To insert a new labor type, select the Labor node under the facility branch and click on the Add New Labor ( ) button.
In the dialog that comes up (shown below), enter the name of the new labor type (“Operator”), uncheck the Unlimited box and enter
“5"in the persons box to denote that the facility has a limit of 5 operators. This is the base availability of this labor resource in the
corresponding facility. Deviations from the base availability (e.g., 5 operators during the morning and afternoon shifts but only 2
operators during the night shift) can be specified through the Availability Calendar of the labor properties dialog.

Demand for labor in an operation is specified through the Labor tab of that operation’s dialog. You may do this quickly (for all
operations in a recipe) by selecting “Edit Labor Requirements...” from the recipe context menu. The dialog that comes up (shown
below) allows you to enter the number of labor-hrs/hr for each recipe operation and each labor type defined in the facility.
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After completing the labor specifications as shown above, reschedule the 12-batch 1L bag campaign. The figure below displays the
labor demand chart for this case. The blue lines represent the instantaneous demand expressed in persons (un-rounded). The red
line represents the availability limit (5 persons). For short periods of time the demand exceeds the availability limit.
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If the above labor constraint violation cannot be accommodated (e.g.. with floating operators from another facility), then the
execution of some operations must be delayed so that the demand never exceeds the limit. Such a solution can actually be
generated automatically by SchedulePro by visiting the Scheduling Mode Options dialog (accessed through the menu
“Schedule?Scheduling Options... “ and then selecting the Constraints tab). In this tab (see below), specify “Labor” as an optional
constraint, close the dialog and reschedule the 1L-Bag recipe.
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After unscheduling and rescheduling the 1L-Bag Recipe, view the Labor demand chart again (see below). Notice that the labor
violations are eliminated, but the make-span of the entire campaign increases from 36 hours to almost 38 hours.

Conflict resolution can also be performed manually by the user through the Equipment Occupancy Chart (EOC) as shown earlier. In
that case, it would be useful to be able to see both the EOC chart and the labor chart simultaneously so that changes in the
schedule can be reflected immediately on the labor demand chart. It is possible to do that by generating the labor chart (or any
other resource chart) through the EOC and link them together. To do this, open the EOC, click on the Open Resource Chart menu

button ( ), and select the option “Labor”. The steps to generate the labor chart are the same as indicated before through the

main toolbar. On the labor chart that gets displayed when you select the resource to plot, click on the Link to EOC button (). The
labor chart will be anchored at the bottom of the EOC chart and its time axis will follow the time axis of the EOC. When changes are
made in the EOC, the labor chart will be automatically updated. If you wish to unlink the charts, click on the Manage Linked Charts

button () of the EOC and select “Unlink Charts”. Through this mechanism you can link all the resource consumption and
inventory charts you wish to observe while modifying the schedule.

Tutorial-4b: Inventory Tracking

SchedulePro keeps track of inventories of input, output, and intermediate materials in storage units. Storage units can supply input
streams, or receive material from output streams. They can also function as intermediate containers that both receive and supply
materials. Inventories of single raw material ingredients can also be tracked through Material Supply Systems whose definition and
functionality parallels that of the storage units.A storage unit can be added to a project by selecting the Storage node under

Facilities and clicking the Add New Storage Unit button ( ) in the Storage Units view. On the dialog that pops-up, type the name
of the storage unit (e.g., “Aqueous Storage Tank”) and click OK. The Storage Units view should look as follows. Then select the
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new storage unit and click on the Edit Storage ( ) button to launch the Storage Unit Properties dialog (shown below). Classify its
type as “Receiving Unit\Waste\Aqueous”.

Select the new storage unit and click on the Edit Storage button to launch the Storage Unit Properties dialog (shown below).
Classify its type as “Receiving Unit\Waste\Aqueous”.

Now, switch to the Inventory Data tab. Check the Track Inventory box and specify its capacity to 20,000 kg as shown below. The
material that accumulates in output storage units such as waste tanks must be discharged from time-to-time. SchedulePro offers
two options for handling discharge of materials from output units:

1. If you select the Continuous Receipt/Discharge option and click on the ON/OFF button (which looks like a full tank), SchedulePro
launches the dialog below which allows you to specify the “Discharge Rate” and the “On/Off” level. The specifications below simply
mean that when the level of material in the storage unit reaches 80% of the unit's capacity, the system will start pumping out
material at a rate of 20,000 kg/h until the Off level is reached (0% in this case). Note that if you set both levels to 100%, material will
be discharged from the storage unit at a constant rate with no consideration to the on-off levels.
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If you select the Continuous Receipt/Discharge option and click on the ON/OFF button (that looks like a full tank), SchedulePro
launches the following dialog that allows you to specify the “Discharge Rate” and the “On/Off” level. This simply means that when
the level of material in the output storage reaches 80% of the unit's capacity, the system will start pumping out material at a rate of
20,000 kg/h until the Off level is reached (0 % in this case). Note that if you set both levels to 100%, material will be discharged
from the storage unit at a constant rate with no consideration to the on-off levels.

2. Alternatively, if you select the Periodic Receipts/Discharges option in the dialog above, you can specify removal of certain
amounts on specific dates and times.

With the specifications in the dialogs shown above, the Storage Units view should look as follows:
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To calculate inventories in storage units, SchedulePro requires a link between the output streams of operations and their relevant
storage units. This link must be specified on the Stream Information dialog through the Material Outputs tab of an Operation ( see
page 287)’'s dialog. The figure below, for instance, shows a waste stream generated during the cleaning of a mixing tank in the
1L-Bag recipe. To complete this dialog, it is necessary to name the stream, specify the amount, specify the composition, click on
the “Is Deposited to Storage Unit” box, select Waste and Aqueous for the Stream Classification (since those specifications were
made for the storage unit which was just created), and select the “Aqueous Storage Tank” from the list to indicate that this stream is
deposited to the new storage unit. Since no specific composition was assigned to the storage unit when it was first created, you
may overwrite this unit’'s composition with the stream’s composition (100% WFI).

Tutorial-5: Debottlenecking Production Lines

The figure below displays the Equipment Occupancy chart for a campaign of 8 batches of the 2L-Bag recipe without Flexible Shift
times in the cleaning operations (this corresponds to Tutorial-5a.scp). Each of the batches was assigned a different color by
SchedulePro.

The figure below corresponds to the same 8 batches of the 2L-Bag recipe but with flexible shift times in the cleaning operations (file
Tutorial-5b.scp).
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The use of flexible shift times reduces the make-span of the campaign. To reduce the make-span further and increase the number
of batches that can be processed within a certain period of time, we must eliminate the current bottleneck, which is the single CIP
skid (CIP-Skid-1). The bottleneck can be eliminated by installing another CIP skid. To add a new CIP skid, select the Equipment

node on the tree. Then, select the existing skid, copy it (by clicking on the Copy Equipment button), paste it (by clicking on the

Paste Equipment button) and rename it to “CIP-Skid-2". The equipment view should look as follows.

Next, CIP-Skid-2 should be made available to the cleaning operations in procedures P-1 and P-2 of the 2L-Bag recipe through the
Auxiliary Equipment tab of their Operation ( see page 287) Properties dialogs (see figure below).
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Now reset the current production schedule by clicking on the Reset Schedule button of the main toolbar or by selecting
“Schedule?Reset Schedule” from the main menu bar. Then re-schedule the campaigns by selecting the Schedule All Campaigns
button or by selecting “Schedule?Schedule All Campaigns” from the main menu bar. The figure below displays the Equipment
Occupancy chart for the new production plan (which corresponds to file Tutorial-5c.scp). The use of the second skid removes the
bottleneck and reduces the campaign make-span so that the campaign now finishes on March 27th at 7:30.

Using SchedulePro one can readily perform this type of analysis for multi-product facilities. Bottlenecks imposed by resource
constraints can be evaluated as well.

Tutorial-6a: Scheduling with Facility Downtimes

This case demonstrates the use of SchedulePro’s calendar capabilities for representing downtime of facilities. You can specify
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facility downtimes (outages) by selecting the Facilities node on the tree to display the existing facilities in the Facilities view (see
figure below).

Select the facility of interest (“Medical Solutions Plant” in this case) and click on the Facility Outages ( see page 183) button ( )
to launch the calendar window (see figure below).

Right-click on the box that corresponds to the first Saturday after the schedule start (March 26th, in this case) and select “Add New
Entry...” to launch the Resource Calendar Entry dialog. On this dialog, you can specify a start date and duration, or a start date and
end-date during which the facility remains down. You can also set the repeat pattern (‘Weekly” in this case) for this down period
until a specified end date is reached (see below).

In this tutorial example, we set weekend breaks starting at midnight on Fridays and completing at midnight on Sundays (48 h
downtime). After setting this downtime and closing the Resource Calendar Entry dialog, you will see the downtimes displayed
graphically on the calendar window by grey bars.
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Now schedule a campaign of 5 batches of the 0.5L-Bag recipe. The figure below shows the equipment occupancy chart for such a
campaign (it corresponds to Tutorial-6a.scp). The gray column corresponds to a weekend break.

Notice that MT-2 is never utilized during this campaign since MT-1 (the first equipment item on the equipment pool list) can
accommodate the needs of this campaign by itself. If you wish to utilize MT-2 in a specific batch of the above campaign (e.g., the
fourth batch that is represented by the magenta bars), right click on the bar of that procedure and select “Procedure ( see page
287)?Properties” to launch the Edit Scheduled Procedure ( see page 287) dialog (see figure below). The equipment can be
selected via the Resources tab.
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Similarly, if you wish to change an auxiliary equipment item associated with a scheduled operation (e.g., a CIP skid associated with
a cleaning operation), visit its dialog by right-clicking on it and selecting Operation ( see page 287) and select an alternative
equipment item that is on its Auxiliary Equipment list.

Downtimes can also be specified for particular equipment items to account for scheduled maintenance, periodic cleaning, etc.
Equipment downtimes are specified through the Equipment view by selecting a specific equipment item and clicking on the
Equipment Outages ( see page 158) button. The interface is identical to that of facility downtimes. We do not make use of
equipment-specific downtimes in this tutorial case.

For labor resources the user can specify deviations from a base availability. For instance, the user may specify that a facility
employs 10 operators during the night shift whereas the base availability (for the morning and afternoon shifts) is 20 people. Under
such conditions fewer tasks can be performed during the night shift. For more information on the impact of labor constraints on
scheduling, please revisit Tutorial-4a.

Tutorial 6b: Interruptible Operations

Notice that in the previous scenario, the equipment is underutilized on Friday. The start of the next batch is delayed until the
following Monday morning because there is not enough time to complete it by midnight on Friday (which is the start of the weekend
break). However, if the product is stable and can remain in the storage tank during a weekend break without any deterioration in its
quality, one could initiate another batch on Friday and simply interrupt it for the weekend break at midnight on Friday. Such a
solution is shown below (this corresponds to Tutorial-6b.scp). The second (blue) batch is interrupted for the weekend and
completed on Monday morning.
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For this solution to be generated automatically, the user must specify that the “Fill Bags” operation in P-3 of the 0.5L-Bag recipe is
interruptible. This is done through the Scheduling tab of that operation’s dialog (see figure below). “Fill Bags” in this case can be
interrupted for up to 4 days due to Facility Closure (notice the checkmark for Facility Closure under the “Operation (  see page 287)
Can Shift or Break for” section). Note that the duration of the “Feed Filler” operation in P-2 has been declared as a ‘slave’ to “Fill
Bags”. In other words, its duration is set by the duration of “Fill Bags”. For this reason, the “Feed Filler” operation also breaks during
the weekend (as shown in the chart above) without having to define it as interruptible. The use of interruptibility in this case allows
the campaign to be completed significantly earlier than in the previous case

Note that in order to avoid frequent interruptions in an operation (which may be undesirable), a limit on the number of breaks can be
declared and/or a maximum operation duration between breaks can be set. Also note that the production schedule was reset and
then re-scheduled in order to produce the chart above.
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The use of flexible shift times and “Interruptible” operations greatly facilitates generation of flexible solutions in multi-product
facilities with downtimes.

Tutorial-7: Scaling Recipes and Campaigns

Batches in SchedulePro can be scaled at the campaign and at the recipe level. To scale the batches of an unscheduled campaign
(please note that the batches of scheduled campaigns cannot be scaled) start with the file from tutorial 6a. Reset the schedule by

clicking the Reset Schedule button ( ).When prompted, click Yes to clear all batches. Then delete the 0.5L Bag Recipe (by

selecting it and pressing the Delete Campaign button ( ). Next, modify the default schedule start time by clicking the Edit
Scheduler Timing button () and changing the start time to 00:00 on 3/21/2016. Then add the following campaigns:

« A 4-batch campaign of the “standard” 10,000L 1-L-Bag recipe (i.e., simply schedule a 4-batch campaign of this recipe without
making any modifications to the batch sizes).

* A 4-batch campaign of a non-standard (15,000 L) batch size for the 1-L-Bag recipe, as shown in the dialog below.

To edit the batch size for this campaign, click the Specify Campaign Batch ( see page 287) Size button ( ) in the lower right
corner of this dialog and set the Scale Factor of the campaign to 1.5. The scale factor is defined with respect to the nominal batch
size defined at the recipe level. In this case, the nominal size is 10,000L so with a scale factor of 1.5 the batch size of this campaign
is 15,000L. That, in turn, means that all procedure and operation-related amounts or rates that were specified to be “scaleable with
the batch size” will also be scaled by the same factor. Also change the recipe color for this campaign to dark green, in order to
differentiate it from the “standard” 1-L-Bag recipe campaign. Click OK to exit this dialog.

The batch size of a procedure is specified through the Scaling tab of the Procedure ( see page 287) Details dialog (see figure
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below). This is optional information that only plays a role in equipment selection (see later). For instance, it may represent the liquid
volume in a mixing vessel. Please note that during batch scale up/down the batch size of a procedure will be adjusted only if the
Scales (linearly) with batch size box is checked.

At this point, edit the scaling for procedures P-1 and P-2. Check the box entitled Consider Equipment Size Limits, select “Volume”
as the Size Basis and set the size to 10,000L.

Similar variables are available at the operation level to estimate, for instance, the duration of an operation based on the amount of
material processed per batch (see figure below). Please note that the batch size of an operation is not necessarily equal to the
batch size of its procedure or recipe. For instance, the batch size of a charge operation is simply the amount of material charged by
that specific operation. The same procedure may include several other charge operations and therefore the procedure batch size
can be quite different from that of one of its operations. The figure below applies to the “Charge Water” operation in P-1.

Scaling recipes during campaign planning is a convenient way of modifying the recipe batch size temporarily without making any
permanent changes in the nominal (master) recipe. This method may be preferred when it is required to schedule a large number of
campaigns with variable batch sizes.You can also scale batch sizes at the recipe level in which case this is equivalent to changing
the nominal size of that recipe. To do this, it is recommended that you make a copy of the recipe first (otherwise you will lose
information on your original recipe). The easiest way to copy a recipe is by selecting it (on the Recipes view) and clicking on the
Copy Recipe
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and Paste Recipe buttons (see figure below). Name the new recipe “1L-Bag-15kL". Visit the Procedure ( see page 287)
Detail dialog for its P-1 and P-3 procedures, specify a batch size of 10000L and check the Scales (linearly) with batch size check
box.

Next, scale the new recipe by a factor of 1.5 so that its batch size becomes 15,000 L. This is done by selecting the node of the new

recipe on the tree to bring up its view, and then clicking on the Scale Recipe Batch ( see page 287) Size button ( ) to bring up
the Scale Recipe dialog (shown below). Here, type 1.5 for Scale Factor or 15,000 L for Target Batch ( see page 287) Size and
click OK. Click Yes when the recipe scaling confirmation dialog appears.

Creating multiple recipes differing in batch size only is generally a good idea when working with a few predefined batch sizes.

Now navigate to the Medical Solutions Plant within the Facilities node of the explorer tree. Select the Equipment node within this
facility. Then select vessel MT-1 in the table and click the Edit Equipment button. Next visit the Size tab of the Equipment
Properties dialog (see figure below) of MT-1and specify that it can handle batch sizes between 3000 and 12000 L. Do the same for
vessel MT-2 and storage tanks ST-101 & ST-102.

Also, edit the sizes of mixing tank (MT-3) and storage tank (ST-103) that both can handle batches of sizes between 5000 and
20000 L. Finally, make all the tanks available to all the recipes.
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If you visit the Main Equipment Pool tab of the Procedure ( see page 287) Details dialog of P-1 in the new 15kL recipe, the dialog
should look as shown below. Tanks MT-1 and MT-2 are grayed out because they are too small to handle the batch size of the new
recipe. When a batch is scaled at the campaign level, these types of decisions (for equipment screening) are made during the
scheduling of the batches of that campaign.

The Equipment Occupancy chart below (corresponding to Tutorial-7.scp) shows a campaign of four batches of the original (10,000
L) 1-L-Bag recipe (light green color) followed by four batches of the same recipe that has been scaled up at the campaign level
(dark green color), followed by four batches of the 1-L-Bag 15KL recipe which was scaled up at the recipe level (orange color). Note
that the Style of this chart was modified (by right-clicking an open area and selecting Edit Style) so that the bars were colored based
on campaign identity rather than batch identity. Also notice the following:

« The batches of the original recipe can be processed using any of the mix tanks and storage tanks. MT-3 is unused in this
campaign simply because there is sufficient time to process all four batches in MT-1 and MT-2 without negatively impacting the
schedule.

« The second and third campaigns (which have been scaled up to 15,000 L in different ways) can only be processed using MT-3
and ST-103; the other tanks are too small to process these large batches. In addition, notice that the Fill Bags operation in
these scaled-up recipes takes 50% longer than it does in the first campaign because the duration of the Fill Bags operation is
calculated based on the 50% larger batch size.
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Tutorial-8: Creating and Using Stock Keeping Units
(SKU)

Stock Keeping Units (SKUs) may be created to represent different raw materials, intermediates, and products associated with a
facility. The use of SKUs has a number of potential benefits compared to using simple Materials in SchedulePro, including:

< Multiple final products can be generated using the same recipe (if the products have a similar recipe structure).
» Use of SKUs can allow automated determination of inter-batch cleaning/changeover times based on “changeover matrices”.

e A particular product may be associated with one or more intermediates and raw materials, and their relative ratios can be
specified. This facilitates tracking of material production/consumption without having to define material input/output streams at
the operation level.

* SKUs can be assigned to Order Templates, which can be used to quickly schedule groups of campaigns (called Campaign
Projects) for many different products.

This case is based off of tutorial case 7, except that instead of using separate recipes for each of the three final products, a single
recipe will be defined and the product-related differences (in filling durations, for instance) will be implemented within that recipe.

To begin from case 7, reset the production schedule by clicking the Reset Schedule button ( ). When prompted, click Yes to
clear all batches. Then delete the campaigns in the Production Schedule’s Campaign Sequence table by selecting them and

clicking the Delete button ( ). Delete the 2-L-Bag, 0.5-L-Bag, and 1-L-Bag-15kL recipes as well, by right-clicking them in the

tree on the left and selecting Delete. Next, select the remaining 1-L-Bag Recipe and click the Edit button ( ). Change this
recipe’s name to the more-generic name of “Filled Bags” in order to highlight the fact that it can be used to produce multiple
(similar) filled bag products.

Next, SKUs for the different types of products must be created. To do this, click the Add New SKU button ( ) in the table on the

SKUs pane, which is visible when the SKUs node in the explorer tree on the left is selected. Give it a Code Name of “Filled
1-L-Bag” and specify that it is a Product SKU that is measured in Discrete entities (see below).

Next, click the BOM tab to assign a Bill of Materials which defines the type and amount of each chemical component in this SKU.
Specify that each Filled 1-L-Bag entity requires the following Materials: 0.99 kg of WFI, 0.01 kg of Sodium Chloride, 0.1 g of API-A

124



4 Tutorial SchedulePro The Tutorials

and 1 entity of 1-L-Bag (see below).

Define SKUs for the Filled 0.5-L-Bag and Filled 2-L-Bag products in a similar manner, with the following modifications to the BOMs:

SKU Name WEFI (kg) Sodium Chloride (kg) API-A Bag
Filled 0.5-L-Bag 0.495 0.005 0.05 One 0.5-L-Bag entity
Filled 2-L-Bag 1.98 0.02 0.20 One 2-L-Bag entity

After the product SKUs are defined, each of them must be assigned to a recipe. To do this, select the Filled 1-L-Bag SKU in the

SKU table and click the Assign SKU Production Recipe button ( ). In the dialog that appears, check-on “Associate SKU

Production With Recipe”, select the Filled Bags recipe and change the Producing Operation ( see page 287) to “Fill Bags”. Then
specify a batch size of 10,000 entities (see dialog below).

By default, the Receiving operation for each material listed in an SKU's BOM is set to be the same as the Producing operation
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specified on the Production tab above. If it is important to accurately track the consumption of materials specified in an SKU's BOM,
click the Feed tab of the dialog above, select a given input material (such as WFI), and click the Edit button to select a different
Feed Procedure ( see page 287) and Operation ( see page 287). In the case of WFI, procedure P-1 and operation Charge Water
should be chosen (see below).

Once the SKU specifications are complete for the Filled 1-L-Bags, make similar modifications to the Filled 0.5L-Bag and Filled
2-L-Bag SKUs, except specify a batch size of 20,000 entities for the Filled 0.5L-Bag SKU and 5,000 entities for the Filled 2-L-Bag
SKU on the Production tab of their “Associate SKU Production With Recipe” dialogs.

After the SKU specifications are completed, the Fill Bags operation in the P-3/Fill procedure must be modified so its duration varies
based on the type of product being produced by a given campaign. The simplest way to do this is to select procedure P-3/Fill in the
Filled Bags recipe, select the Fill Bags operation, click the Edit button, and click the Duration tab. Then check-off the Rate-Based
Term box, check-on the Constant box, and specify a default duration of 333.33 minutes. This corresponds to the typical duration for
a 10,000 L batch of 1-L Bags. To account for duration changes due to non-nominal batch sizes, check-on the Scales with Batch (

see page 287) Size box. This will allow the operation’s duration to be automatically scaled if the batch size of a given campaign is
increased/reduced relative to its nominal size. Furthermore, to account for duration differences between different types of products,
check-on the Use SKU-Specific Duration box and then click the SKU-Specific Duration button. Then add the Filled 0.5-L-Bag and

Filled 2-L-Bag SKUs to the table by clicking the button , and specify operation durations of 666.67 and 166.67 minutes,
respectively, for these two SKUs (see screen below). Click OK twice to return to the Operation ( see page 287) Sequence table.
Note that although the Operation ( see page 287) sequence table shows a duration of 333.33 minutes for the Fill Bags operation,
if this recipe is used to produce the 0.5-L or 2-L Bag SKUSs, the alternate duration specifications of 666.67 or 166.67 minutes will be
used (for nominally-size batches).
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The next step is to specify new campaigns for each of the SKUs. To specify a 4-batch campaign of the Filled 1-L-Bag SKU, select

the Production Schedule node in the tree and click the Add New Campaign button ( ) in the Campaign Sequence table. In the

dialog that appears, choose the Associate with SKU option and select Filled 1-L-Bag from the drop-down menu. Change the
Number of Batches to 4 as well (see screen below).

127



The Tutorials SchedulePro 4 Tutorial

Follow the same basic steps to create 4-batch campaigns of the Filled 0.5-L-Bag and Filled 2-L-Bag campaigns. Then create a
2-batch Filled 1-L-Bag campaign that is scaled up to 15,000L/batch by setting the number of batches to 2 and clicking on the

Specify Campaign Batch ( see page 287) Size button ( ). Set the Scale Factor to 1.5 and click OK. Notice that the campaign
batch size has been scaled up by 50%. Click OK again to return to the main SchedulePro interface. Then schedule all campaigns

by clicking the button and re-generate the Equipment Occupancy Chart by clicking the button. The new EOC is shown
below. Note that all four campaigns were produced from the same recipe, and the durations of the Fill Bags operations (and their
associated transfers from the Storage Tanks) vary depending on which product is produced in a given campaign. As a result, the
Fill Bags operation in the 0.5-L-Bag campaign (in blue) takes twice as long as the Fill Bags operation in the first 1-L-Bag campaign.
In addition, the Fill Bags operation in the second 1-L-Bag campaign takes 1.5 times as long as the Fill Bags operation in the first
1-L-Bag campaign because the second 1-L-Bag campaign was scaled up by 50%. Also notice that the second 1-L-Bag campaign
doesn't utilize MT-1, MT-2, ST-101, or ST-102 because those vessels are too small for its scaled-up batches.
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Creating Recipes

Creating Recipes in SchedulePro

Introduction to Recipes

A recipe in SchedulePro is a description of a batch process to be scheduled. A SchedulePro project may contain any number of
recipes. A recipe defines how to execute a series of procedures that utilize various resources (equipment, labor, materials etc.). A
batch is a single execution of the procedures defined by a recipe at a specific time with specific resources.

Creating recipes can be performed by either importing existing recipes from SuperPro, or by building them directly in SchedulePro

Recipe/SKU Types

Recipe classification is used for calculating the duration of sequence-dependent operations. Recipes may be classified according to
any number of user-defined categories. There are two built-in categories: product-type and packing size.

To create recipe classifications, select “Options->Recipe/SKU Types...” from the main menu.

Select the desired classification category in the list on the left side of this dialog or select the “create-new” tool (wand) to create a
new category. Then select the create-new tool above the Types list (on the right side of the dialog) to create a new type of recipe or
SKU. Enter a new type-name and optional description.
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Operation Types

Operation ( see page 287) types are used for controlling display and reporting of activities by type. There are five built-in types:
“Setup,” “SIP,” “Process,” “CIP” and “Changeover.” (“SIP” and “CIP” are common abbreviations for steam-in-place and
clean-in-place, respectively). Users may delete or rename these built-in types, as well as define additional types.

To add new types, select Options->Operation ( see page 287) Types...” from the main menu.

Use the create-new (wand) button to add a new type. Use the properties button to change the color or name of a type.

Operation Report Text

Certain reports, such as the Daily Activity Report, can contain customizable text. The text is a descriptive string with keywords for
variables, e.g. the batch ID.

The procedure/operation report text may be customized for each operation (on its General tab), or it may be set or modified globally
by selecting "Options->Operations Report Text..." from the main menu.

Select Replace OIld Value with New Value to do a search-and-replace in all operations for a specific text string (e.g., replace the
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default text of “<batch>: <operation> in <procedure>" in the Old Value field with “<batch>: <operation> in <procedure> within <main
equip>." in the New Value field).

Or select Use New Value Everywhere to set the new value for the customizable text in all operations within the SchedulePro project
to a specific text string.

See the Operations Section ( see page 146) in Building Recipes for keyword descriptions.

Importing Recipes from SuperPro

A process in SuperPro corresponds to a recipe in SchedulePro.

The simplest way to enter a recipe in SchedulePro is to import one from SuperPro. This is done in the following two-step process.

Export from SuperPro ( see page 133)
Import in SchedulePro ( see page 134)

SuperPro Recipe Export

In SuperPro Designer, open the file containing the recipe to be exported. Be sure that the flowsheet is solved and that the
scheduling is correct. Select “FileExport to SchedulePro Recipe DB...”

On the Recipe Export dialog, the following options are available:

Recipe Name

This is the name that will be assigned to the exported recipe in the Recipe DB.
Facility Name (Default site for skids and unallocated equipment)

SchedulePro always places equipment items under a facility (site). If none of the equipment items in the SuperPro project are
allocated to a site from a user database, SchedulePro will use the supplied site name to generate a default site for this equipment.
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For equipment items already allocated to a site in SuperPro, the export function will use their existing site name(s). Equipment
allocation in SuperPro will not be changed.

Omit Unscheduled Items

Check this option to omit unscheduled SuperPro items from exporting. Unscheduled SuperPro equipment is marked with the Omit
from Scheduling option, which may be modified by right clicking on the desired equipment item in SuperPro and by selecting the
“Equipment Data...” item from the popup menu.

Export Each CIP Step as a Separate Operation ( see page 287)

Checking this option on will transfer each individual sub-step of a CIP operation’s Cleaning Step Sequence (e.g., Pre-Rinse,
Caustic Wash, Water Rinse, Acid Wash, and Final Rinse) to SchedulePro as a separate operation. If this option is not checked on,
the whole Cleaning Step Sequence will be transferred as a single operation, with all of that CIP operation’s material inputs and
outputs assigned to a single CIP operation in SchedulePro.

User Name

This is the name of the recipe’s author/maintainer (optional). This may be changed by selecting menu item “File \ Application
Settings...” in SuperPro.

SuperPro File

This is the location of the file being exported from SuperPro.
Modified by

This is the name of the last user to save the recipe.

On

This is the date of the last recipe modification.

Main Product

If a specific Main Product has been defined in the SuperPro model (on the Tasks \ Stream Classification menu’s dialog box or the
Tasks \ Rate Reference Flows dialog box), that Main Product will be shown here.

Batch ( see page 287) Size

This is the amount of Main Product (defined on the Tasks \ Stream Classification menu’s dialog box) produced per batch. This value
is calculated by SuperPro.

Description
This field may hold a brief description of the process (optional).
Keywords

This is a set of keywords for searching the recipe DB for this recipe. Keywords may be added and deleted on the interface.

SchedulePro Recipe Import

Open SchedulePro and select “Recipe/Import from Database...” from the menu. Alternatively, select the Recipes node in the tree

and click the Import ( ) button in the recipe list toolbar.

In the dialog that comes up (shown below), select the desired recipe from the list. If there are many recipes, use the search features
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to narrow the selection.

Multiple selections are allowed. Select OK to complete the import.

The recipe will appear in the SchedulePro Navigation ( see page 17) Tree on the left hand side of the screen. Selecting the recipe
will update the Recipe view on the right pane.

Managing the Recipe Database

The Recipe database is invoked by selecting “Connectivity->Recipe Data->DB Search...” from the main SchedulePro menu. The
database can be searched with a variety of options.

Name is Any of

Search for one or more recipe names.
Modified by Any of

Search for one or more maintainer names.
Main Product is Any of

Search for one or more main product names.
Has Any of the Selected Keywords

Search for one or more keywords.
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Unused or obsolete recipes can be deleted from the database by selecting them in the table and clicking on the Delete Selected
Records from Database button.

Building Recipes in SchedulePro

Recipes may be created directly in SchedulePro. The sections below outline the basics of creating and editing a recipe manually in
SchedulePro.

Adding a Recipe

Recipes may be added in one of the following ways:
* Right-click on the Recipes node in the tree and select “Create New Recipe...” from the context menu.
* Select “Recipe \ Create New...” from the main menu.

* Click the Add New () button in the Recipe view toolbar.

The following dialog will appear:

The following may be entered:

Name: The name of the recipe. Each recipe name should be unique.
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Description : An optional description of the recipe.
Type: A recipe may have types in the type categories ( see page 131) defined (using the Options -> Recipe/SKU Types menu).
Batch ( see page 287) / Continuous: A recipe may be defined as batch (default) or continuous.

This selection affects how campaign order amounts are calculated. If the the recipe is batch, the order amount is achieved by
adjusting the number of batches. Partial batch amounts are rounded up to the next highest integer. If the recipe is continuous, the
recipe will be scaled to achieve the order amount.

Recipe Size

On this tab, a Reference Material (e.g., the intermediate or product which is being produced by the recipe) and a Nominal Size for a
typical batch may be specified. The fields on this tab are optional. Additional batch size information may also be displayed, if sizes
have been specified for the relevant equipment and procedure.

Recipe Main Input/Output

This tab is used to display SKU bill of material data. See SKU scheduling ( see page 251).
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Editing Recipe Properties

To access recipe properties select the recipe and choose “Properties...” from the right-click menu. If you select the recipe from the

recipe list window, click the Edit Properties ( ) button. The dialog that opens is the same as the one used for declaring a new
recipe (as described above ( see page 196).)

Deleting a Recipe

To delete a recipe: Select the Delete ( ) button from the Recipe List toolbar.

Select “Delete” from the recipe context (right-click) menu.

Recipe Cut, Copy and Paste

Use the Edit menu or the editing tools from the Recipe List toolbar ( ) to cut or copy a recipe. Recipes may be pasted into
the same SchedulePro document or into a separate document.
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Recipe Sorting

Use the arrow buttons in the Recipe List toolbar ( )to move recipes up or down in the list. Recipe order does not affect
scheduling and is provided for convenience.

The recipes may also be automatically sorted alphabetically (or reverse-alphabetically) using the Sort By Name buttons ( ).
Note that the order of recipes within the Recipes list does not affect scheduling and is merely provided for convenience in
organizing and finding recipes.

Recipe Folders

Recipes may optionally be organized into folders. Recipe folders do not affect scheduling and are merely provided for organization.

To create a folder, select the Recipes node in the navigation tree and right-click. Select “Add Folder” and enter a folder name. Move
recipes to the folder by dragging and dropping the recipe to the desired folder. Right-click on the folder to move it or delete it.

Recipe Branches

Branches are a level of recipe organization that is supported in SuperPro Designer. For this reason branches may be optionally
viewed in SchedulePro.

To view or hide recipe Branches, select “Edit->Preferences...” from the main menu and click the checkbox titled “Show Recipe
Branches in Tree” under the “Recipe Display” heading. Branches are a level of organization above sections, but branches do not
have any special functionality in SchedulePro.

Recipe Sections

Sections provide a way to organize a recipe into logical segments. Equipment suites are defined for the section level.

In order to work with sections, be sure that sections are displayed in SchedulePro. To do this, select “Edit->Preferences...” from the
main menu to toggle the display option for recipe sections (under the “Recipe Display” heading). Sections are required for recipes
that will use suites.

Adding Sections

To add a section at the end of the recipe, right-click on the recipe in the Navigation ( see page 17) Tree and select item “Add
Section...” from the popup menu.
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Enter a name for the section and click the OK button to finalize the operation. The new section will be added after the last section
and will appear under the SchedulePro Navigation Tree. Selecting the new section item will display the Section Window on the right
pane.

To insert a new section within the recipe, select an existing section, right-click it, and select “Insert New Section Before...”

Deleting a Section

Sections may only be deleted when the recipe has no scheduled batches. To delete a section, right-click on the section node ()
and select “Delete” from the menu. If the section contains procedures, a dialog will appear with the following options:

Delete Procedures
All the procedures in the section will be deleted along with the section.
Move Procedures

All the procedures in the section will be moved to the desired section.

Editing a Section

Select “Properties...” from the section’s context (right-click) menu.
The Identification tab has the following entries:

Name

The section name.

Recipe

The name of the recipe that contains the section.

Description

A brief description of the section.

The Suite Allocation tab has the following entries:

All Procedures Must Use Equipment from the Same Suite

If this box is checked, the whole section runs within a suite. Therefore, procedures in the section will only be assigned to equipment
that belongs to the same suite.

Selected Suite Must Be Compatible with Suite for Section

If this box is checked, the suite chosen for the section must be compatible with or connected to the suite that is used for the section
specified in the drop-down list. For instance, the dialog box below specifies that whichever suite is used for the “Buffer Preparation”
section of the process must be connected to the suite that is used for the “HIC Chrom” section of the process.
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Section Copy and Paste

The editing options in the main Edit menu and the section context menu allow for section copying and pasting. A section may be
copied and pasted into the same recipe or into a new recipe. When a section is pasted into a new recipe, the procedures in the
section are also copied.

Suites

Sections may optionally be assigned to run in a suite. A suite in SchedulePro is a group of equipment items which are used
together. Suites are defined for facilities (see resources chapter). When a section is set to run in a suite, all the main equipment for
all the section’s procedures will be selected from a single suite. If no single suite can be found with all the necessary equipment,
scheduling will fail.

A section may also be set to run in a suite that is connected to or compatible with the suite from some other section. If this option is
chosen, SchedulePro narrows the list of possible suites to those that are connected.

The suites ( see page 182), associated equipment, and suite compatibility are defined at the facility level.

Procedures

Procedures represent a major step in a process, e.g. a reaction. Each procedure requires at least one choice for main equipment.

Adding a Procedure

A procedure may be added in a selected recipe in one of the following ways:

¢ Click the Add New Procedure ( see page 287) button ( ) or the Insert Procedure ( see page 287) button ( ) in the
Procedure ( see page 287) List view shown on the right-hand side after a recipe is selected from the Navigation ( see page
17) Tree.

» Select “Add Procedure ( see page 287)” from the recipe context (right-click) menu (option available only if recipe has a single
section and sections are not shown on the recipe tree).

« Select “Insert New Procedure ( see page 287) Before Selected...” from the procedure context (right-click) menu accessed by
right-clicking on a procedure in the navigation tree.
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Enter a name for the procedure and click on OK to finalize the addition. Procedure ( see page 287) names must be unique for the
entire recipe.

The new procedure will appear in the tree. Selecting the new procedure item from the navigation tree will display the Procedure (
see page 287) view on the right.

While a procedure’s scheduling is dependent on its operations, it is usually convenient to arrange procedures roughly in
chronological order.

In the procedure list that appears when you click a recipe or section node in the navigation tree, you may move procedures with the

sorting buttons:Move Up ( ), Move Down ( ), Move to Top ( ), Move to Bottom ( ).

Editing Procedures

To edit a procedure, do one of the following:

« Right-click on the procedure and select “Properties” from the context menu.

« Double-click on the procedure in the procedure list.

« Click the Edit Procedure ( see page 287) ( ) button in the procedure list.

The procedure dialog has the following tabs: Properties, Main Equipment, Work Area and Scaling.

Properties Tab

Name

The name of the procedure may be edited here, if desired.

Description

A longer text description for the procedure may be (optionally) entered.
Number of Cycles

This checkbox provides an easy way to perform multiple sets of each operation within the procedure. If a sequence of operations
has already been defined for the procedure, the Number of Cycles can be increased to automatically perform that sequence
multiple times.

Estimated Duration

This field is automatically calculated by SchedulePro, based on the durations and timing links of the operations within the
procedure. Note that the actual duration of the procedure may differ from this estimate when the recipe is scheduled, due to the
potential for operation durations to vary (for rate-based or SKU-dependent operations), as well as the potential for operations to be
shifted or interrupted (based on their Scheduling tab specifications), etc.

Include (or Highlight) in Activity Report
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These selections determine whether or not the procedure should be included or highlighted in the Activity Report (available under
the Reports menu).

Report Text

The text entered in this field will appear in the Daily Activity and/or Scheduling Report.

The following substitution tags are allowed in this field:

<batch> Batch ( see page 287) ID

<batch tag> Batch ( see page 287) sequence number

<procedure> Procedure ( see page 287) name

<main equip> Main equipment

<description> Procedure ( see page 287) description

<comments> Procedure ( see page 287) comments

<recipe> Recipe name

<start> Procedure ( see page 287) Start

<end> Procedure ( see page 287) End

Main Equipment Pool Tab

SchedulePro requires every unit procedure to have an equipment pool of at least one main equipment item that can be utilized for
the execution of the procedure. If multiple equipment items are assigned, they are treated as alternative units. Equipment is defined
within a facility. See Chapter 6 (Resources) for details.

This tab has the following entries:

Facility

Select the facility from which to assign equipment.

Match Type Check box

If checked, only equipment of the selected type will be shown in the available equipment list.
Shares Equipment Pool with  Procedure (  see page 287)

If checked, the main equipment pool is set to be equivalent to that of the procedure selected in the pull-down menu to the right. The
procedure selection box will be enabled, and the equipment selection tools are disabled.

Must Use the Same Equipment as Procedure ( see page 287)

If checked, this procedure is always executed with the same equipment as the procedure selected in the pull-down menu to the
right. The selection tools are disabled.

Do not Share Equipment with Other Procedures

If checked, SchedulePro will not assign the main equipment that is selected for this procedure to any other procedure in the batch.
A vessel used for a reaction, for example, would not be used for a later separation procedure.

Require Staggered Use of All Equipment
If checked, SchedulePro will use all the assigned equipment units in turn (staggered mode). In other words, if Tanks 1, 2, and 3 are

in the procedure’s equipment pool, the first batch will use Tank 1, the second batch will use Tank 2, the third batch will use Tank 3,
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the fourth batch will use Tank 1 again, etc.
Require Same Equipment for Entire Campaign

If checked, the equipment assigned to the procedure in the first batch will be kept for that procedure in the entire campaign.

Available Equipment List

This lists the available equipment in the selected facility. If Match Type is checked, only equipment of the selected type will
appear.Add Button ( )

Adds the equipment selected in the available list to the equipment pool.Add All Button ( )
Add all the equipment to the pool.

Sorting Buttons
Move Up ( ),
Move Down ( ),
Move to Top ( ),

Move to Bottom ( ).

These buttons change the order of the items in the Equipment Pool. The order of equipment in this list is important because the
equipment list is priority ordered, with the first equipment (at the top of the list) used first (if it is available) when the campaign is
scheduled. Furthermore, if the campaign is scheduled based on a “Priority List” (on the Campaign’s Resources tab), the item at the
top of the procedure’s Equipment Pool list will always be used (unless it is unavailable).

Delete ( ) Button

The selected equipment is removed from the equipment pool.

Work Area Pool Tab

A work area in SchedulePro represents a building, room, or area where a limited number of unit procedures might take place. Like
equipment, work areas are defined within a facility. See Chapter 6 (Resources) for details. Unlike equipment, the declaration of a
work area for a procedure is optional.

The work area tab has the following entries:

Facility

Select the facility from which to assign a work area.
Available Work Area List

The list of available work areas in the selected facility

Add ( ) Button

Adds the work area selected in the available list to the pool.
Add All ( ) Button

Add all the available work areas to the pool.
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Delete ( ) Button

Remove the selected work area from the pool.

Delete All ( ) Button

Removes all work areas from the pool.

Sorting Buttons

Move Up ( ), Move Down ( ), Move to Top ( ), Move to Bottom ( ).

The work area list is priority ordered with the first work area (at the top of the list) used first when the campaign is scheduled with
priority ordering.

Scaling Tab

SchedulePro can select main equipment based on procedure batch size. The following options are available:
Consider Equipment Size Limits

If checked, SchedulePro will use the procedure batch size to filter the available equipment.

Procedure ( see page 287) Size Basis

Select the basis for measuring the procedure batch size (mass, volume or discrete entities).

Procedure ( see page 287) Batch ( see page 287) Size and Units

Enter the batch size and units.

Set to Recipe Batch ( see page 287) Size

The procedure batch size is updated and set automatically to the recipe batch size.

Scales Linearly with Batch ( see page 287) Size

If checked, the procedure batch size is set to be proportional to the overall batch size.

Operations

Operations represent processing activities within a procedure. All time, duration, and scheduling relationships for a recipe are
defined in the operations. Resources including materials (in and out), labor, utilities, staff, and auxiliary equipment are also specified
at the operation level.
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Adding an Operation

An operation may be added in any of the following ways:
e Select a procedure to update the Procedure ( see page 287) Window on the right. Click the Add New Operation ( see page
287) button ( ).

¢ Select “Add Operation ( see page 287)..."” from the procedure’s context (right-click) menu.

Enter a name for the new operation and click OK to accept it.
Editing an Operation

To edit an operation do one of the following:

« In the procedure view, select the desired operation from the operation list and click the Edit Operation ( see page 287) ( )
button.

» Double-click on the desired operation.
* Right-click on the desired operation and select “Properties...”

The operation properties dialog has multiple tabs for scheduling and resource assignment.
The following buttons navigate among the operations within a procedure:

Confirm the current operation and move to the next

Confirm the current operation and move to the next, staying on the same tab if possibl
Confirm the current operation and move to the previous

Confirm the current operation and move to the previous, staying on the same tab if possible

The OK button saves the data and dismisses the entire dialog. The Cancel button dismisses the dialog and discards unsaved
changes.

General Tab

On the General tab, the following options are available.

Operation ( see page 287)

Name of the operation. This should be unique in the procedure.

Procedure (  see page 287)/Section/Branch/Recipe

These fields are automatically filled in by SchedulePro, and they are for information only.

Operation ( see page 287) Type
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Optionally select one of the pre-defined or user-defined operation types. See Operation Types ( see page 132).
Conditional Scheduling

Clicking this button brings up the conditional scheduling dialog.
Description

General operation description (optional).

Include in Activity Report

Check to include the operation in the Daily Activity Report.

Highlight in Activity Report

Displays the entry as emphasized in the activity report.

Report Text

The following substitution tags are allowed:

<batch> - Batch ( see page 287) Id

<procedure> Procedure ( see page 287) name

<operation> Operation ( see page 287) name

<main equip> Main Equipment

<aux equip> Auxiliary Equipment name (if any)

<description> Operation ( see page 287) Description

<comments> User entered comments.

<recipe> Recipe Name

<start> Operation ( see page 287) start (long date and time format)

<end> Operation ( see page 287) end (long date and time format)

Drag / Drop Mode

Items on the equipment occupancy chart may be dragged and dropped to manually adjust the schedule. Select the type of item to
move (batch, procedure, or operation). Deselect all the drag/drop options to exit drag/drop mode.

Conditional Scheduling

On this dialog, it is possible to specify that the operation will only occur if certain conditions are met. For instance, it is possible to
specify that an operation should be performed if the main equipment unit associated with the procedure has been used a certain
number of times (i.e., “Execute Based on Main Equipment Use Count”), An example of this would be cleaning a vessel every third
batch. It is also possible to specify that an operation should be performed “Based on Equipment Usage Time Since Last Operation
( see page 287)" or “Based on Equipment Idle Time Since Last Use”. Examples of these situations would be: cleaning a tank once
every 7 days or cleaning a tank if it has been idle for more than 24 hours.

Conditional operations will have their durations and resource usages set to zero normally. When the condition is met the duration is
calculated according to the normal duration parameters.
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Main/Auxiliary Selection
Base the calculations on either main or auxiliary equipment.
Execute Based on Equipment Count

The operation will be executed every nth usage, where n is the number entered. This entry might be used for service operations
that must be done after a given number of operations.

Execute Based on Equipment Usage Time Since Last  Operation (  see page 287) of Type

The operation will be execute after the specified amount of time since the last operation of the specified type. This might be used to
ensure that certain maintenance operations are done after a certain number of operating hours.

Execute Based on Equipment Idle Time Since Last Use

The operation will be executed if the equipment has been idle for the specified time. This might be used to ensure a cleaning or
sterilization is done if the equipment has been idle.

Duration Tab

The duration of the operation is defined through this tab (shown below). It includes the following options:
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Duration Calculated

The operation has a fixed or variable duration that does not depend on the duration of other operations.
Constant

The operation duration includes a fixed term in the specified time units.

Scales with Batch ( see page 287) Size

The operation has a duration which is proportional to the recipe batch size.

Use SKU-Specific Duration

If there defines SKUs, it is possible to set the duration according to SKU. Check the box, and fill out a duration for each SKU that
might be associated with the recipe.
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Rate-based Term
The operation duration includes a variable term based on a processing rate.

The Setup... Button displays the rate based options.

If the Rate-based Term checkbox is selected, the duration term is calculated as the ratio of the amount processed by the operation
and the processing rate. You should click the Setup... button to open the Rate Parameters dialog and enter the following data
related to the duration expression:

« Rate Basis - This is the basis on which the rate is measured (mass flow, volume flow, discrete entity rate)

* Amount and Units- The amount processed by the operation (numerator in the duration expression). Click on Set to Recipe
Amount to set it equal to the recipe batch size.

« Get Amount from Stream- If checked, the operation amount will be determined based on the amount of material in one of the
operation’s input or output streams (chosen in the drop-down field).

« Fixed- The rate will be determined based purely on the Amount Processed and the Rate (in the Duration rate expression).

* Amount Scales with Batch ( see page 287) Size-If checked the operation amount will be scaled up or down with the batch
size.

« Rate and Units- The processing rate (denominator in the duration expression)

« Rate is Equipment Dependent- If checked, the processing rate is not fixed but determined by the equipment used (provided
that the equipment has a rate defined). This allows an operation’s duration to depend on the selected equipment.

* Main/Auxiliary Equipment- This entry specifies whether it is the main or the auxiliary equipment that sets the rate.
« Rate Percentage- Allows an operation’s actual rate to be less than (or more than) the base equipment rate.

« Maximum/Minimum/Nominal Rate- Equipment may have up to three different rate values, so different operations may choose
different values.

« Labor-Dependent On- This setting allows the processing rate to depend on the number of people of a certain labor type (e.g.,
operators) who are assigned to do the work. For example, the dialog box below is for an operation which has two operators
assigned to it (this assignment was specified on the operation’s Labor tab). Since there are two operators, the Rate (in the
Duration denominator at the top of the dialog box below) has been calculated by SchedulePro to be: 1 + 2 x 5 MT/h, which is
equivalent to 11 MT/h. Note that for recipes which may be scheduled to produce a certain SKU, it is possible to specify that the
operation’s labor requirement is SKU-specific (when assigning the labor to the operation on its Labor tab). If this is done, the
amount of labor will be determined based on which SKU is produced by a given campaign, and the processing rate will be
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determined automatically based on the amount of labor which that SKU requires.

Duration Equal to Another Operation or Sequence of Operations

The duration of the operation is equal to that of another operation or series of operations.

Single Operation (  see page 287)

Duration is set equal to that of another ‘master’ operation.

Sequence of Operations

Duration is calculated from the start of the first operation to the end of the last (defined in the corresponding lists).
Duration Includes Breaks in Master  Operation ( see page 287) (s)

If selected, the operation duration matches the entire duration of the master operation(s) including any possible processing breaks.

Duration Based on Inventory in Storage Unit

This option allows the operation’s duration to depend on the inventory level in a specified storage unit. You should click the Setup...
() button to open the Inventory Rate Setup dialog (shown below) and enter the following data.

Storage Unit

Select the storage unit on which the duration should depend.
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Hold Until Inventory

Select the comparison operator (= or =) and the inventory level expressed either as a percentage or as an absolute amount with the
corresponding units. When the specified inventory level is reached, the operation ends.

Expiration Period and time units

This value corresponds to the maximum duration of the operation regardless of inventory.

Duration Based on Equipment Cleaning/Changeover

Duration equal to equipment's Setup/Precleaning Time If this option is selected, a fixed cleaning or changeover time will be
assigned to the operation, based on the Setup/Precleaning Time specified on the Cleanout/Changeover tab of the main equipment
unit(s) assigned to the procedure.

Duration equal to equipment's Cleanout Time

If this option is selected, a fixed cleaning or changeover time will be assigned to the operation, based on the Cleanout Time
specified on the Cleanout/Changeover tab of the main equipment unit(s) assigned to the procedure.

Duration equal to equipment's Changeover Time

If this option is selected, a fixed cleaning or changeover time will be assigned to the operation, based on the Changeover Time
specified on the Cleanout/Changeover tab of the main equipment unit(s) assigned to the procedure.

Duration equal to equipment's Changeover Matrix

Sometimes cleanout/changeover durations will vary depending on the previous (or next) usage of the equipment. For example, a
cleaning step may take longer if the equipment was previously used to make a different product. In these cases, SchedulePro can
use “changeover matrices” to automatically determine the duration of an operation based on the sequence of batches processed
within a Main Equipment unit.

Changeover matrices are defined at the equipment level (see Chapter 6 -Resources). Changeover times are defined for changes
from one recipe-type to another. Equipment may have multiple changeover matrices. The following data should be entered for this
option:

Changeover Matrix drop-down list

Select the relevant changeover matrix here. To be able to use this option, the main equipment pool for the procedure should have
already been assigned and all the equipment in the pool should have at least one matrix name in common.

State Transition with Respect to Task Before/Task After

This selection defines whether the operation’s duration should be set based on what was processed during the previous batch
within the equipment unit or based upon what will be processed during the subsequent batch within that unit. For example, if the
previous batch in the equipment unit used the same recipe “type”, there may be a relatively brief cleaning required, whereas if the
previous batch in that unit used a different recipe type, a more-thorough (and longer-duration) cleaning may be required. This is an
example of the “state transition with respect to task before” option. The actual duration of the operation will be determined based
upon the entries for the various recipe type combinations defined in the changeover matrix for the equipment

Scheduling Tab

An operation’s scheduling options specify when the operation takes place with respect to other operations in the recipe.
The scheduling options are:

« With respect to batch start ( see page 153)

152



5 Creating Recipes SchedulePro Building Recipes in SchedulePro

« With respect to another operation in this procedure ( see page 153)
« With respect to another operation in another procedure ( see page 154)

< Sync with Duration Master: If the duration is linked to the duration of another operation, selecting "Sync with Duration Master"
will set the operation scheduling to start with the start of first operation to which the duration is linked.

In addition there are several special options that provide additional control

< Time shifting options ( see page 154)
« Advanced scheduling ( see page 155), provide extra links to operations, including operations in other batches

¢ Special handling for outages ( see page 158)

Relative to Batch Start
Batch ( see page 287) Start

The operation starts when the batch starts (plus or minus any time shift). This is the default for the first operation in any procedure.

Note that this setting refers to the nominal batch start. The batch-start does not necessarily correspond to the earliest operation in
the batch because other operations may be backward-shifted from the batch-start.

As a best-practice, only one operation should be scheduled with respect to the batch start.

Operation Starts with Respect to Another Operation in This Procedure

153



Building Recipes in SchedulePro SchedulePro 5 Creating Recipes
This option requires a selection of an operation from within the same procedure as well as the selection of relationship link. The
possible links are:

(SS) The operation starts at the start of the selected operation, i.e. start-to-start.

(FS) The operation starts at the end of the selected operation, i.e. finish-to-start or sequential. This is the default for operations after
the first operation.

(FS) The operation finishes at the start of the selected operation, i.e. start-to-finish or backward scheduling.

(FF) The operation finishes at the end of the selected operation, i.e. finish-to-finish.

Operation Starts with Respect to Another Operation in Anoter Procedure.

This option requires the selection of an operation in any procedure except the current procedure. Selecting the Reference
Operation ( see page 287) pull-down list under this heading allows selection of operations in other procedures. The current
procedure is shown in bold and is not selectable. The relationship links are the same as those listed above.

Time Shifting/Interruptibility

Time shifts allow the operation to be scheduled at a time that differs from the scheduling link.

Fixed Time Shift
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This sets a time delay from the link. A positive shift is a delay and a negative shift is a lead regardless of link type.
Flexible Time Shift

A flexible time shift is a delay or lead that is applied only if a resource is unavailable. The value specified in this field represents the
maximum shift that may be applied. At least one resource category must be selected under the “Operation ( see page 287) Can
Shift or Break for” heading.

Is Interruptible

If checked, breaks could be introduced within an operation’s duration when any of the required resources is not available. The
provided duration and units define the maximum allowable duration of all breaks. Options to also limit the number of breaks and the
minimum operation duration between breaks are also provided.

Can Delay/Break for Facility Closure or Equipment Availability or ...

When a flexible shift is allowed or an operation is declared as interruptible, these options control the reasons (unavailability of what
resources) for which a flexible shift or break may be applied. Al least one of these options must be checked if flexible shift or
interruptibility is allowed.

Advanced Scheduling Options

Aside from the above four basic scheduling options, SchedulePro allows for multiple scheduling links within the same batch or
between two different batches. When SchedulePro calculates the batch timing, the latest scheduling link is applied (i.e., if one link
would start the operation at hour 45 of the batch, and another link would start the operation at hour 48 of the batch, the second link
would be used to define the operation’s start time). There are two parts to an advanced scheduling link: the “usual” operation links
and information about the reference batch.

To add advanced scheduling links, click on the Advanced... button to open the Additional Scheduling Constraints dialog which
displays the additional link list will. If there are existing additional scheduling links, the number of links is displayed. Click the Add

New ( ) button to add a new link through the Additional Scheduling Reference dialog (shown below). The following data should
be declared in this dialog.
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Within this Batch ( see page 287)
This option indicates that the scheduling link should reference an operation within the same batch.
Last Batch ( see page 287) in Prior Campaign with Recipe

This option indicates that the scheduling link should reference an operation in the last batch of a previous campaign of the recipe
specified in the drop-down list.

Previous Batch ( see page 287) with Recipe
This option creates a link to the previously scheduled batch of the recipe specified in the drop-down list.
Previous Batch ( see page 287) with Recipe and ID

This option creates a link to the batch with the specified batch ID of the recipe specified in the drop-down list. The additional
specifications related to this selection include:

Append Sequence Number/Increment Every/Increment By/Start At

These options together allow the timing of batches in a campaign to depend on the timing of various other batches in another
campaign. The reference campaign should be typed into the box (e.g., “Main-1" could be typed in this box to create a link to the first
campaign of the recipe named “Main”.) To determine when this timing link should occur, SchedulePro calculates a counter, N,
based on the formula below:

N = start-at + (increment-by)*(Batch ( see page 287) Index / Increment Every)

Only the whole number quotient of (Batch ( see page 287) Index/ Increment Every) is considered. Batch ( see page 287) Index is
a zero-based batch count.
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Example

In this case, the Dependent Campaign (i.e., the campaign based on the recipe which contains this Additional Scheduling
Reference) begins a new batch each time a batch of the Independent Campaign (i.e., the “Main-1" campaign associated with a
different recipe) is completed. To specify this, the following settings were used:

Previous Batch ( see page 287) with Recipe and ID = Main-1 , to set the link based on the first campaign of the “Main” recipe.
Append Sequence Number-Increment Every =1 , to increase the counter (N) for each batch of the Dependent Campaign.
Increment By = 1 , to increase the counter (N) by 1 each time.

Batch ( see page 287) 1 of this recipe’'s campaign = Batch ( see page 287) # = 1, to ensure the first batch of the Dependent
campaign is linked with the first batch of the Independent campaign (Main-1).

These settings result in the following counter (N) values for each batch of the Dependent campaign:

Counter (N) Dependent Batch (  see page 287) Index
1 1
2 2
3 3
4 4
5 5
Example 2:
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In this case, the Dependent campaign should be allowed to run twice every time a batch of the Independent campaign (“Main-1" in
this example) is completed.

To specify this, the same settings as before are used, except:

Append Sequence Number-Increment Every = 2, to increase the counter (N) once for every two batches of the Dependent
campaign.

Example 3:

In this case, the Dependent campaign should be allowed to run only once for every two times a batch of the Independent campaign
(“Main-1") is completed, starting after the first batch of the Independent campaign.

To specify this, the same settings as before are used, except the Increment Every field has been reset to 1 and:

Increment By = 2 , to increase the counter (N) by two for each batch of the Dependent Campaign.

Outages

There are several options that control the scheduling of an operation within periods of facility or equipment outages. As a rule, no
processing task can be scheduled while the relevant facility or equipment are not available. The following options are exceptions to
this rule to accommodate tasks such as equipment cleaning that could happen after normal operating hours.
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Operation ( see page 287) Can Be Scheduled within Periods of Facility/Equipment Outages
If checked, the operation can still be executed even when the facility or equipment are unavailable.
Ignore Outages Only If Operation ( see page 287) Is Started During Normal Operating Hours

This option becomes active only when the previous option is selected. If checked, it allows the operation to be executed during
outages but only if it has already started during non-outage times. In other words, the operation cannot be executed entirely within
an outage period.

Auxiliary Equipment Tab

An operation may be assigned an auxiliary equipment unit that is used only for the duration of that operation, e.g. a cleaning skid.
SchedulePro allows a pool of auxiliary equipment to be declared. In SchedulePro, any equipment may be assigned as auxiliary
equipment (even while being used as main equipment by some other procedure). An operation, however, cannot claim some
equipment for auxiliary use while the same equipment is used by its own procedure.

The following data are set within this tab.
Any Equipment/Specify Type

Select the “Any Equipment” option to see all the equipment in the selected facility. Select the “Specify Type” option to view only
equipment of the type selected from the list.

Available Equipment
Select from the list a facility to see all its equipment in the available equipment list.
Add ( ) button

Once one or more equipment are selected in the available list, click on this button to add them to the pool of candidate
equipment.Add All ( ) button

Click on this button to add all the available equipment to the pool.

Included Equipment

This is the pool of candidate equipment. Use the buttons in the list toolbar to delete equipment from the pool or reorder the list.
SchedulePro assigns auxiliary equipment to operations based on their priority in the equipment list so the order is important.

Use All Compatible

If checked, all the auxiliary equipment in the pool will have to be assigned to the operation so they all have to be available during
the operation duration. In this case, the ordering of the pool is immaterial.

Material Inputs Tab

Material inputs may be used to track materials that enter the process. SchedulePro does not attempt to balance material inputs and
outputs. A material input is represented by a stream. Materials should be defined before adding a material input stream. See
Chapter 6 for more information about materials.

Each operation may have multiple material input streams, and each stream may bring into the process a single material or a
mixture of materials.Material input streams may be added, deleted, copied, pasted and edited through the Material Inputs tab. To

add a material input, click the Add New ( ) button. The stream dialog shown below will appear.

159



Building Recipes in SchedulePro SchedulePro 5 Creating Recipes

The following options are available:

Name

Enter the name of the process input stream.

Type of Material

Specify the stream contents as bulk or discrete.

Amount

Specify the exact amount in the specified units.

Flowrate

Instead of an absolute amount, enter a rate. The amount is calculated as (duration x Flowrate).
Scales with Batch ( see page 287) Size

If checked, the provided amount or flowrate will be scaled based on the size of a scheduled batch (relative to the nominal recipe
batch size).

Is Drawn from Storage Unit

Specify whether the stream source is a storage unit. If a storage unit is chosen the stream composition will be set to that of the
storage unit. See Chapter 6 for more information about storage units ( see page 201).

Storage Unit

An input or intermediate storage unit must be specified if the Is Drawn from Storage Unit box is checked. Storage units allow
SchedulePro to track the amount of material over time. See Chapter 6 for more information about storage units ( see page 201).

Specify Final Storage Amount — (Available only if a storage unit with inventory tracking is defined for the stream.)

This is a third option for defining the stream amount; in this case, the amount is the difference between the volume of the specified
storage unit and the specified final amount.
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Composition

Material streams require a composition. To specify the composition, select a component and click the Add ( ) button. The first
component is added at 100 mass %. Subsequent components will be added at 0 mass%. Fill out the values in the percentage
column to change the percentages. The user must ensure that they sum to 100%. Composition is not editable if the input stream is
drawn from a storage unit.

Density

The stream density in the specified units.

Material Outputs Tab

Material outputs in SchedulePro are only used for materials that exit the process. Materials should be defined before adding a
material output stream. See Chapter 6 ( see page 178) for more information about materials. A material output may be classified
as a waste, a product or an intermediate. The classification affects the type of storage unit that may be used with the stream. An
operation may have several output streams and each stream may contain multiple materials or components.Material output streams
may be added, deleted, copied, pasted and edited through the Material Outputs tab. To add a material output to an operation, click

on the Add New ( ) button. The following options are available in the output stream dialog that comes up:

Name

The name of the output stream

Type of Material

Specify the stream contents as bulk or discrete.

Amount

Specify the exact amount in the specified units.

Flowrate

Specify the Flowrate instead of the amount. The amount is calculated as (Flowrate x duration).
Scales with Batch ( see page 287) Size

If checked, the provided amount or flowrate will be scaled with the implemented recipe batch size.
Is Deposited to Storage Unit

If checked, the stream destination is a storage unit.

Storage Unit

A storage unit must be specified if the Is Deposited to Storage Unit box is checked. Storage units are listed by facility. Only storage
unit whose type is consistent with the stream class (see below) will be listed.

Stream Classification

This must be one of the following: Product, Intermediate, Waste, or Unspecified. If Waste is selected, available classification options
are Emission, Aqueous, Organic, Solid, and Unspecified.

Specify Final Storage Amount — (Available only if a storage unit with inventory tracking is defined for the stream.)

The amount is the difference between the volume of the specified storage unit and the specified final amount.
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Composition

Streams require a composition. To specify the composition, select a component and click the Add ( ) button. The first
component is added with at 100 mass %. Subsequent components will be added at 0 mass%. Fill out the values in the percentage
column to change the percentages. The user must ensure that they sum to 100%.

Density

The stream density in the specified units

Labor Tab

Labor resources in SchedulePro represent pools of a specific labor type. Labor resources are defined for a facility. See Chapter 6
for details. To assign labor resources to an operation, select the Labor tab from the operation resources dialog.

Available Labor
Select a facility. The labor in the Available list is limited to the labor types in that facility.
Add ( ) Button

Use this button to assign the labor resource selected in the Available list. The Resource Amount dialog (shown below) will pop up
so that the desired labor rate (labor-hrs/operation-hr or number of persons) can be specified. This rate can be declared as scalable
with the batch size using the corresponding check box. Also note that fractional labor amounts may be specified (e.g., an operation
which takes 10 hours, but which only requires an operator’s attention half the time can be assigned 0.5 operators).

If SKUs may be associated with the recipe, it is possible to set different labor amounts based on which SKU is being produced by
the recipe during a particular campaign (e.g., the operation might require 2 operators if one product is made, but it might require 3
operators if a different product is made). To set SKU-specific amounts, the corresponding check box should be checked and the
SKU-Specific Amounts button should be clicked. The following dialog will then appear:
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Here it is possible to specify different labor amounts for specific SKUs, or for different types of SKUs. SKUs may be added to the list
individually or in groups. Alternatively, they may be deleted individually or all at once. See Chapter 8 for a thorough explanation of
the purpose and use of SKUs in SchedulePro.

Included LaborOnce a labor resource is selected in the Included list, use the Remove Labor ( ) button to delete that labor

resource. Use the Edit Amount ( ) button to edit the labor use rate.

Staff Tab

Staff Labor resources refer to specific individuals who may be assigned to an operation. Staff resources must be defined within a
facility. See Chapter 6 ( see page 187) for details.

The staff tab contains the following elements:

Available Staff

Select a facility. The staff members in the Available list are limited to those in that facility.
Add ( ) Button

Use this button to assign the staff resource selected in the Available list.

Add All ( ) Button

Use this button to assign all the staff resources shown in the Available list.

Included Staff

This is the list of staff members who may perform the operation. The list is in order of scheduling priority. The toolbar allows deletion
and re-ordering.

Number Required (“Use __ Persons")

This is the number of individuals required to perform the operation. The number must be less than or equal to the number of
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individuals available.
Use All

If this is checked, all the staff members in the Included Staff list will be assigned to the operation.

Heating /Cooling Tab

Heating and cooling utilities are specified in terms of a flow rate of a heating or cooling agent. If multiple heating or cooling entries
are specified, SchedulePro assumes that all of them are used each time the operation is executed. Heating or cooling utilities must
first be defined in a facility before they can be added to an operation. See Chapter 6 ( see page 188) for details.

The follow entries appear on the tab:

Available Utilities

Select a facility. The utilities in the Available list are limited to the heating and cooling agents in that facility.
Add ( ) Button

Use this button to assign the utility selected in the Available list. The Resource Amount dialog will pop up so that the desired utility
rate can be specified. This rate can be declared as scalable with the batch size using the corresponding check box.

Included Utilities

Once a utility is selected in the Included list, use the Remove Utility ( ) button to delete that utility resource. Use the Edit

Amount ( ) button to edit the utility rate.

Power Tab

Multiple types of electrical power draws may be specified for an operation. SchedulePro assumes that all of them are used each
time the operation is executed. In order to add a power utility usage to an operation, the power utility must first be defined in a
facility. See Chapter 6 ( see page 188) for details.

The following entries appear on the tab:

Available Power

Select a facility. The power resources in the Available list is limited to the power types in that facility.
Add ( ) Button

Use this button to assign the power resource selected in the Available list. The Resource Amount dialog will pop up so that the
desired power rate can be specified. This rate can be declared as scalable with the batch size using the corresponding check box.

Included Power

Once a power resource is selected in the Included list, use the Remove Power ( ) button to delete that power resource. Use the

Edit Amount ( ) button to edit the power rate.
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Transfer Panels Tab

Transfer Panels are specialized devices used in certain plants (see Chapter 6 ( see page 198) for details). They work like material
“switchboards” to allow material to be transferred from one equipment unit to another. Each such transfer may involve one or more
transfer panels.

The execution of a material transfer through a transfer panel involves two ports (physically, these are fittings to which pipes or tubes
are connected) and a bridge (the piping between the ports). Additional secondary ports and bridges may also be specified.

The definition of the transfer panel usage by an operation involves the specification of both the transfer panels that will be used as
well as the alternative ‘paths’ (i.e. combinations of ports and bridges) that this operation could use. SchedulePro will schedule one
path for each panel used by the operation.

The following options are available in the Transfer Panels Tab (shown below):

Available Transfer Panels
Select a facility. The transfer panels in the Available list are limited to those declared in that facility.Add ( ) Button
Use this button to assign the transfer panel selected in the Available list.

Utilized In Sequence Transfer Panels

This box displays the list of all transfer panels to be scheduled. Use the Remove Transfer Panel ( ) button to delete that transfer
panel.

Alternative Pathways List

This table displays the allowed transfer paths (combination of ports and bridges) for the selected transfer panel. SchedulePro will
schedule one of the pathways for each execution of the operation. SchedulePro considers pathways in the order they appear in the
dialog, i.e. priority is given to the paths that appear at the top.

New Path ( ) Button

Add a new transfer path for the selected panel. A default path (consistent with the transfer panel’'s connectivity) will be inserted in
the table. Every declared path can include up to two components from each topological group (Portl, Port2 and Bridges). To edit a
path, first select the primary bridge to be used and then the connected ports. Note that only the ports that can be connected to the
selected bridge will show up in the ports list so that the path is consistent with the transfer panel's declared connectivity. With the
exception of the primary bridge column, all other columns can be left blank in a path. The secondary bridge selection does not pose
any constraint on the admissible ports list. These are defined by the primary bridge.

Add All Valid Paths ( ) Button

This Introduces all possible paths for the selected transfer panel based on its connectivity.

Delete ( ) Button

Delete the selected pathway from the alternative pathways list.

Delete All ( ) Button

Delete all the alternative pathways.
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Move up and Move down ( , ) Buttons

Change the priority order of the selected path.

Operation Links

Right-click an Operation ( see page 287) and select “Links” to view a diagram showing all the operations that have scheduling
links that depend on the selected operation.

Validating a Recipe

Before a recipe can be successfully scheduled, it must be complete. In particular, the following items should be checked:
All procedures must be assigned at least one piece of primary equipment

Each procedure must have at least one operation

The duration and start time specifications for all operations must have been defined

All scheduling links should be traceable to the start of the batch — no circular references.

Recipe Check Function

Select “Check Recipe...” from the recipe context menu. If the recipe has problems, the Recipe Incomplete button will appear in the
recipe view. Click on this button to get an explanation of the problem.

166



5 Creating Recipes SchedulePro Building Recipes in SchedulePro

Note that SchedulePro can not estimate the cycle time for incomplete recipes. Any problems should be fixed before a recipe can be
scheduled.

Recipe Gantt Chart

SchedulePro can display a Gantt chart for a recipe before it is actually scheduled. This provides a useful way to double-check the
duration and timing of the recipe’s operations to ensure they are correct. To view this chart, select “Recipe Gantt Chart...” from the

recipe context menu or select the Gantt chart button () from the recipe view. The Gantt chart displays even if some procedures
are missing equipment assignments. However, it will not show if there are missing scheduling specifications or there are circular
references in operation timing (i.e., Operation ( see page 287) 2 scheduled relative to Operation ( see page 287) 1, but
Operation ( see page 287) 1 scheduled relative to Operation (  see page 287) 2).

Recipe Flow Chart

SchedulePro can also display a flow chart for a recipe by either selecting “Recipe Block Diagram” from the recipe context menu or
clicking the View Recipe Block Diagram button () from the recipe view. The block diagram is a visual representation of the recipe,
providing a high level overview of the most important recipe features such as the main structure (procedures and operations), the
input and output streams, as well as internal (intra-procedural) and external (extra-procedural) scheduling links.
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Each table (or “block”) in this diagram represents a procedure, with its operation names listed as the table rows. The header of each
table consists of the procedure name and default equipment in parentheses, as well as the procedure description (if specified).
Incoming arrows on the left side of the chart represent material input streams, while outgoing arrows on the right side represent
material output streams. The arrow labels include the stream name and, in parentheses, the stream amount. In case of multiple
streams (input or output) associated with a particular operation, only the details of the first stream are shown, followed by three dots
in parentheses. Arrows between operations within a procedure represent internal scheduling links, while arrows between operations
across different procedures represent external scheduling links.

The chart also allows easy access to the procedure dialog by double-clicking on a table header (i.e. procedure name/description)
and to the operation dialog by double clicking on a table row (i.e. operation name).

The recipe block diagram contains a toolbar providing the following functions: Print, Print Preview, Copy, Toggle Fit-To-Window,
Zoom Level Selection, and Options. The Options button brings up the Options dialog shown in the figure below. Through this dialog
the contents of the chart can be customized. The lines representing input/output streams and internal/external scheduling links can
be individually included or excluded. The weight and color of each included line can also be selected. Additionally, displaying the
type of the link (SF: Start-To-Finish, SS: Start-To-Start, etc) for the scheduling link lines can be enabled or disabled. At the bottom
of the options dialog, the diagram width, the procedure table width, and the operation row height can be adjusted, while the
background grid can be displayed or hidden. Finally, a Back to Defaults button brings back the size values to a reasonable default
in case selected values cause the diagram to be displayed incorrectly.
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Editing Data For the Entire Recipe

As documented in the previous sections, all processing specifications are done at the procedure and the operation level. However,
for the user’s convenience, SchedulePro offers functionality that allows certain types of data to be defined or edited globally at the
recipe level. The following subsections present the related functionality.

To access the presented dialogs, first select a recipe in the Navigation Tree and either right-click on it to invoke the recipe pop-up
(context) menu or, (for some of the options) use the toolbar buttons shown on the right-hand side recipe view that corresponds to
the selected recipe.

Operation Overview

Operation (  see page 287) types can be used to group operations for viewing or reporting purposes. Types can be assigned to
operations for the entire recipe through the Operation ( see page 287) Types for Recipe dialog (shown below). To access this

dialog, select item “Assign Operation ( see page 287) Types...” from the recipe popup menu or click the relevant button ( )in
the recipe view.

169



Editing Data For the Entire Recipe SchedulePro 5 Creating Recipes

The recipe operation types dialog lists all operations of the recipe (by procedure) and allows the specification of the type for each
operation separately through a list of predefined types shown under the Type column. Multiple simultaneous assignments can also
be done using the toolbar buttons at the top of the table. You can make multiple selections by checking the buttons in the Select
column and clicking the Tag Selected Operations button to specify a common type for all. Alternatively, you can click on the Tag
Multiple Operations button and globally set the type for recipe operations that use the same equipment or have a common string in
their names (both criteria are indications that the relevant operations are of the same type).

Recipe-wide Flex Shifts

For recipes with potential flexible shifts on many or all operations, it may be more convenient to schedule the flexible shifts for the
entire recipe.

To assign flexible shifts for a recipe, right-click the recipe and select “Set Flex-shifts (Breaks) for Recipe” from the popup menu.
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The recipe flex-shift dialog has the following options:

Max Duration

This is the maximum duration of the flexible shift in specified units. The value must be greater than zero.
Delay for Facilities

If checked, operations will be able to shift for facility down time.

Delay for Equipment

If checked, operations will be able to shift for equipment availability.

Selected Procedures

Select the procedures whose operations will be assigned the flexible shift. The buttons at the top of the list allow quick selection and
de-selection of all displayed procedures.

Operations Criteria

Select whether the flexible shift will be assigned to all operations in the selected procedures or only to operations that use a certain
type of auxiliary equipment (such as “CIP-skid”).

Recipe Stream Overiew

Even though material inputs and outputs are specified at the operation level, it can sometimes be advantageous to manage them at
the recipe or the project level. The stream manager through the Recipe Input/Output Material Streams dialog provides such an
overall view of all streams.

To access this dialog, select “Recipe?Streams...” from the main menu or “Edit Streams...” () from the recipe context menu.

The amounts in blue may be edited directly in the table view. The units must be valid SchedulePro units ( see page 66) for stream
amounts.

Use the edit properties button to add a new stream.
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The following options are available in the stream manager dialog:
Input/Output/Intermediate

The stream manager will display only streams of the type(s) checked.
Edit/Delete Button

Select a stream from the table to either edit its data or delete it from the owner operation.

Recipe Labor Overview

Labor assignments for the entire recipe can be displayed in a single table in the Labor Assignments for Recipe dialog.

Select “Edit Labor Requirements...” from the recipe context (right-click) menu or click on the relevant button () in the recipe view.
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The recipe labor table displays a row for every operation and a column for every labor type defined in the facilities. The amount of
each labor type required per operation may be entered directly in the table.

Procedure Overview

The Recipes Procedures Overview ( see page 336) dialog allows the display and editing of the data for all procedures in a recipe.

To access this dialog, select “Procedures Overview (  see page 336)...” from the recipe context (right-click) menu or click on the
relevant button () in the recipe view.

The dialog (shown below) displays all recipe procedures along with some key data (e.g. the “Equipment Pool” column shows all
equipment assigned in each procedure’s pool).

To view or modify the properties of a procedure, select a table row corresponding to that procedure and click on the Edit button .

173



Editing Data For the Entire Recipe SchedulePro 5 Creating Recipes

Recipe Staff Editing

To view or edit the staff assigned to operations in a recipe, select the recipe and then select the staff ( ) button in the recipe pane
on the right to display the staff overview window. This table displays all the operations, the total staff requirement for each, and the
assigned staff.
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Recipe Scaling

A recipe may be scaled up or down. Scaling affects the following items in a recipe:

« Stream amounts that have the "Scales with Batch ( see page 287) Size" box checked
« Durations for rate-based operations if the amount is scalable

« Equipment selection for procedures with a scalable procedure batch size

To scale a recipe select “Scale Recipe...” from the recipe context (right-click) menu or click on the relevant button ( )in the recipe
view.

The following options are available:

Scale Factor

If selected, the recipe will be scaled by the specified factor.
Target Batch ( see page 287) Size

If selected, the scaling factor is the ratio of the specified new batch size to the previous batch size. This option is only available if
the recipe has a main product and batch size already defined.

Create an SKU from a Recipe

When a recipe represents a product-specific process, it may be convenient to create an SKU directly from the recipe. The recipe
input and output streams will be used to create a BOM. To create an SKU from a recipe, click the Create SKU from Recipe button
(). Then enter the SKU name as the Code Name. For more information on the purpose and use of SKUs, see Chapter 8 ( see
page 251).
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Recipe Report Text

Procedures and operations have standard report text, but this text may be modified for an entire recipe.
Select "Edit Operation ( see page 287) Report Text..." from the right-click menu.

Select whether the edit should apply to procedures or operations.

Use Replace Old Value with New Value to do a search and replace.

Otherwise select Use New Value Everywhere

The keywords are describe in Operation Report Text (  see page 132).
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SchedulePro Resources

Declaring Resources in SchedulePro

Introduction to Resources

Scheduling tasks in SchedulePro make use of resources. Procedures use equipment (and possibly work areas), whereas
operations may use material, labor, utility, equipment, and storage resources.

All resources except materials and stock keeping units (SKUs) are organized into facilities. A SchedulePro project may contain any
number of facilities. Facilities contain labor, utilities (heating, cooling, and power), equipment, work areas, transfer panels, and
storage units.

Procedures must use equipment resources for their execution. The use of all other resources for the execution of recipes is
optional. SchedulePro tracks occupancy, consumption, and/or inventory for all declared resources used in the schedule. Limits on
the availability of selected resources can optionally be used as constraints in scheduling the tasks that use them.

Resources exist independently of the recipes that use them, so it is advantageous to declare them before creating recipes in a
scheduling project.

Used-By Feature for Resources

Resources assigned to procedures or operations in recipes cannot be deleted, and some of their data may also be non-editable. If
you would like to delete a resource, it must first be disengaged from all its uses. It is therefore useful to be able to see all recipe
tasks that use a resource. This is possible by using the “Used-By” feature. In all resource list views shown in the remainder of this

chapter, there is a Used By ( ) button; when clicked, it will display a dialog (like the one shown below) listing all users of a
selected resource. The same dialog can also be accessed through the context (right-click) menu using the “Used By...” menu item.

The list of operations which use a resource may be narrowed by selecting a specific recipe, section, and procedure in the columns
shown in the dialog below.

177



Material Resources SchedulePro 6 SchedulePro Resources

Currency Options

The currency displayed within the project (for material costs, labor rates, etc.) may be set within SchedulePro by selecting the
Options menu and choosing Set Currency. The dialog (shown below) allows the base currency and a display currency to be
defined. If different currencies are specified for these two fields, a non-unity conversion factor may also be specified. This will
convert costs/prices that are defined in the base currency to costs/prices in the other currency (which will be displayed in dialog
boxes and reports.) The display prices are calculated by multiplying the base price by the conversion factor.

Material Resources

In SchedulePro, materials are used for the definition of streams consumed or generated by operations. Material resources may be
used to represent the following:

e Bulk materials consumed or generated
« Discrete items, e.g. bottles, consumed or generated
* Materials consumed to generate utilities, e.g. water for steam

To view or edit materials defined within a project, click on the Materials node in the left-hand side Navigation ( see page 17) Tree.
The Materials list view will show on the right-hand side window allowing you to add, edit, or delete materials.

Adding a Material ( see page 179)

Editing a Material ( see page 180)
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Adding a Material

Materials are added from the main SchedulePro menu using the item “ResourcesAdd Material...”, from the material context menu

by right-clicking on the Materials node, or by clicking the Add New Material ( ) button from the toolbar in the Materials list view.

The Material Properties dialog has the following options:

Material Name

Material names must be unique. A material may be renamed at any time.

Trade Name

This field is optional and is not used in scheduling.

Local Code

This field is optional and is not used in scheduling.

Supplier

This field is optional and is not used in scheduling.

Bulk/Discrete

Indicates whether the material is bulk material (measured in mass or volume) or discrete (measured in number of items.)
Pure Component/Stock Mixture

Applies to bulk materials only; specifies whether the material is a pure substance or a mixture of other materials.
Mixture Composition Button

Applies only to stock mixtures; allows the user to set the composition for the mixture.

Density

Sets the density of bulk materials. This is used for converting between mass and volume.

Purchase Cost

The price of the material if used in an input stream.

Sales Price

The selling price of the material if it appears in a product stream.
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Basis

Sets the measurement basis by which the material is purchased or sold. The basis is consistent with the material type specification
(bulk or discrete).

Unit

Sets the reference unit (appropriate for the basis) for the pricing.

Editing a Material

To edit a material, select the Materials node in the Navigation Tree to enable the Materials list view and select the material from the

list (the whole row should show selected on the table). Click the Edit Material ( ) button to bring up the Material Properties
dialog. (See “Adding a Material ( see page 179)".)

Alternatively, double-click on the table row for the desired material.

The toolbar on the Materials view also has buttons for deleting, copying, and pasting a material resource. Some of these options
(and a “cut” option) can also be accessed in the material context (right-click) menu.

Materials may be cut, copied, and pasted between projects. A material can be deleted only if it is not used in any streams.

Material Resources and SKUs

In SchedulePro 6.0 and later the stock keeping unit (SKU ( see page 251)) is available. An SKU may be used with or without
materials. The SKU feature is helpful in the following situations:

< Many different products are made with the same process.
« Different intermediates need to be scheduled to make a final product.

More details may be found in the chapter on SKU scheduling.

Facility Resources

All resources other than materials are organized in facilities. The sections below outline the basics of creating and editing a facility
and its resources.

Selecting any facility resource in the navigation tree will display the list of the resources in the left-view.

The toolbar buttons and context (right-click) menu allow for the following actions:

Add new... ( ): Add a new resource.
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Delete... ( ): Deletes the resource.
Edit... ( ): Edit the selected the resource.

Used by... ( ): Shows where the resource is used.
Edit Outages ( see page 158)... (): Shows a calendar for entering and editing resource downtime.

Cut/Copy/Paste...( ): Allows a resource to be cut, copied, and pasted within the same project, or into other projects.

The context (right-click) menu has the following additional options:
Paste Outage Calendar Only -- applies the outage calendar of the last copied resource to the selected resource.
Apply Outage Calendar to All - applies the outage calendar of the last copied resource to all resources in the list.

Move To... - Moves the resource to a different facility (if other facilities already exist in the project).

Adding a Facility

Facilities are added from the “Resources/Add Facility...” item in the SchedulePro main menu or by clicking the Add New Facility

( ) button in the toolbar on the Facilities list view.

The following options are available on the dialog that pops up:
Name

Facility names must be unique in a project.

Description

(Optional) Descriptive text.

Location

(Optional) The physical location, e.g. city. This is only used for reporting purposes.

Editing a Facility

To edit a facility, select the Facilities node in the Navigation Tree to enable the Facilities list view. Then select the facility from the

list (the whole row should show selected on the table). Click on the Edit Facility button ( ) to bring up the Facility Properties
dialog (the same dialog used for adding a facility). Alternatively, double-click on the table row for the desired facility.

The toolbar on the Facilities view has also buttons for deleting, cutting, copying and pasting a facility. Note that a facility can be
deleted only if its resources are not used in any recipes. Some of these options can also be accessed in the context menu that
pops-up if you right-click on the desired facility. The facilities toolbar and context menu also contain options for editing facility
calendar outages and specifying facility suites. These options are explained in the following sections.
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Facility Suites

Suites ( see page 141) are defined within facilities. Suites ( see page 141) represent sets of equipment that may be used
together to execute a part of a recipe (identified in SchedulePro as a recipe section.) If a section is set to run in a suite, all unit
procedures in the section will be assigned to equipment from the same suite. Suite assignment restrictions apply only to main
equipment and not to any other resource.

Equipment may belong to only one suite. Equipment that does not belong to any suite may be assigned to procedures in
unassigned sections.

Suites ( see page 141) may also be connected to one-another. If two sections are set to run in suites and the two sections are
also set to require compatible suites, the unit procedures will be assigned to equipment from compatible suites. If no appropriate set
of equipment can be found, scheduling will fail.

To edit the list of suites in a facility, navigate to the desired facility in the navigation tree, select it to activate the Facility view on the

right-hand side and click the Edit Facility Suites ( see page 141) button (), or right-click the facility in the Facilities list and
selection Suites ( see page 141).... The dialog that appears lists all declared suites in that facility. To add a suite, click the Add

New Suite ( ) button and enter a unique name for the new suite. Note that although the toolbar on the Suites ( see page 141)
dialog offers options to delete a suite and reorder the suite list, suite order has no bearing on scheduling.

To edit a suite, select it from the list and click the Edit Suite ( ) button. The Suite Properties dialog that comes up has the
following options:

Identification Tab
Edit the name of the suite and optionally provide a short description. Suite names should be unique within a facility.
Equipment Tab

Select the equipment that belongs to this suite. Equipment may belong to only one suite. When equipment is assigned to a suite, it
is removed from any other suite.
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Compatibility Tab
Select the suites that are compatible with the suite being edited.

The toolbar on the Suites (  see page 141) dialog offers options to delete a suite and reorder the suite list; however, suite order has
no bearing on scheduling.

Facility Resource Calendar

In SchedulePro, facilities and all resources (except utilities) may be declared to be unavailable at certain times. Each of these
resources has an availability calendar.

By default, Labor resources are assumed to always be available at the amount specified in the Base Availability field on the
Properties tab of each labor type. However, the calendar can be used to declare deviations from this standard availability (to
declare, for example, a reduced number of operators during the night shift, or no Quality Assurance personnel on week-ends, etc.)

The calendar for storage units can be used to declare external (i.e. non-related to scheduled tasks) receipts or discharges of
material to or from these units. Facility downtimes prevail over all other resource downtimes, i.e. if a facility is declared unavailable
for a period, all its resources are also assumed unavailable so no tasks using this facility or any of its resources can be scheduled
during this period (unless an operation is declared as being able to be executed over periods of outages — see Chapter 5 ( see
page 152).)

Accessing the Calendar

To access the calendar of a facility or resource, first enable the relevant window where the resource is listed (e.g. the Labor
Window), select the resource of interest from the table (the entire table row should show selected) and then click on the calendar

button ( ). Alternatively, click on the calendar button that typically shows on the first tab of each resource’s property dialog (see
relevant section for each resource in this chapter).

The dialog that comes up contains a real-time calendar displaying one month at a time. Use the << and >> buttons at the top of the
calendar to navigate forward or backward in time.
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Declaring Calendar Events

To declare an event (e.g. outage, receipt of material) that is scheduled to occur on a specific day, right-click on that day on the
calendar dialog and select the option “Add a new entry...” from the pop-up menu. Note that calendar events can be declared only at
dates after the schedule’s start time.

The following options are available at the Resource Calendar Entry dialog:
Description

A name for the type of entry. A default is provided.

Start Date and Time

The start time of the event.

Duration

The duration of the event.

End-Time of First Occurrence

Alternative way to enter the duration.

Repeat Pattern

If a calendar event should be repeated, the base repeat units for the event may be specified here.. Use “One Time” for one-time
events; otherwise the event will be repeated at the specified frequency (daily, weekly, monthly or annually.)

Every
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